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IMPORTANT-READ CAREFULLY:

This End-User License Agreement is a legal agreement between you (either an individual or a single entity)
and Greenwald Intellicard., Division of the Eastern Company, Chester, CT.

The SOFTWARE PRODUCT includes computer software, the associated media, any printed materials,
and any "online" or electronic documentation.  By installing, copying or otherwise using the SOFTWARE
PRODUCT, you agree to be bound by the terms of this agreement.  If you do not agree to these terms,
Greenwald Intellicard, Division of the Eastern Company, is unwilling to license the SOFTWARE
PRODUCT to you.  In such event, you may not use or copy the SOFTWARE PRODUCT.

SOFTWARE PRODUCT LICENSE

The SOFTWARE PRODUCT is protected by copyright laws and international copyright treaties, as well as
other intellectual property laws and treaties.  The SOFTWARE PRODUCT is licensed, not sold.

1. GRANT OF LICENSE.  This agreement grants you the following rights:

! Software.  You may install and use one copy of the SOFTWARE PRODUCT on the COMPUTER.
! Network Services. If the SOFTWARE PRODUCT includes functionality that enables the

COMPUTER to act as a network server, any number of computers or workstations may access or
otherwise utilize the basic network services of that server.

! Storage/Network Use.  You may also store or install a copy of the computer software portion of the
SOFTWARE PRODUCT on the COMPUTER to allow your other computers to use the
SOFTWARE PRODUCT over an internal network, and distribute the SOFTWARE PRODUCT to
your other computers over an internal network. However, you must acquire and dedicate a license for
the SOFTWARE PRODUCT for each computer on which the SOFTWARE PRODUCT is used or to
which it is distributed.  A license for the SOFTWARE PRODUCT may not be shared or used
concurrently on different computers.

2. DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS.

! Limitations on Reverse Engineering, Decompilation and Disassembly- You may not reverse engineer,
decompile, or disassemble the SOFTWARE PRODUCT, except and only to the extent that such
activity is expressly permitted by applicable law notwithstanding this limitation.

! Separation of Components.  The SOFTWARE PRODUCT is licensed as a single product.  Its
component parts may not be separated for  use on more than one computer.

! Single COMPUTER.  The SOFTWARE PRODUCT is licensed with the COMPUTER as a single
integrated product.  The SOFTWARE PRODUCT may only be used with the COMPUTER Rental.
You may not rent or lease the SOFTWARE PRODUCT.

! Software Transfer.  You may permanently transfer all of your rights under this agreement only as part
of a sale or transfer of the COMPUTER, provided you retain no copies, you transfer all of the
SOFTWARE PRODUCT (including all component parts, the media and printed materials, any
upgrades, this agreement and, if applicable, the Certificate(s) of Authenticity), AND the recipient
agrees to the terms of this agreement. If the SOFTWARE PRODUCT is an upgrade, any transfer must
include all prior versions of the SOFTWARE PRODUCT.

! Termination. You must comply with all applicable laws regarding the use of the Software. Without
prejudice to any other rights, Greenwald Intellicard, Division of the Eastern Company, may terminate
this agreement if you fail to comply with the terms and conditions of this agreement.  In such event,
you must destroy all copies of the SOFTWARE PRODUCT and all of its component parts.

3. UPGRADES.  If the SOFTWARE PRODUCT is an upgrade from another product, you may
use or transfer the SOFTWARE PRODUCT only in conjunction with that upgraded product,
unless you destroy the upgraded product.  If the SOFTWARE PRODUCT is an upgrade of a
Greenwald Intellicard, Division of the Eastern Company product, you now may use that
upgraded product only in accordance with this agreement.  If the SOFTWARE PRODUCT is an
upgrade of a component of a package of software programs which you licensed as a single
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product, the SOFTWARE PRODUCT may be used and transferred only as part of that single
product package and may not be separated for use on more than one computer.

4. OEM COPYRIGHT.  All title and copyrights in and to the SOFTWARE PRODUCT (including
but not limited to any images, photographs, animations, video, audio, music, text and "applets,"
incorporated into the SOFTWARE PRODUCT), the accompanying printed materials, and any
copies of the SOFTWARE PRODUCT, are owned by Greenwald Intellicard, Division of the
Eastern Company or its suppliers.  The SOFTWARE PRODUCT is protected by copyright laws
and international treaty provisions. You may not copy the printed materials accompanying the
SOFTWARE PRODUCT.

5. DUAL-MEDIA SOFTWARE.  You may receive the SOFTWARE PRODUCT in more than
one medium. Regardless of the type or size of medium you receive, you may use only one
medium that is appropriate for your single computer.  You may not use or install the other
medium on another computer.  You may not loan, rent, lease, or otherwise transfer the other
medium to another user, except as part of the permanent transfer (as provided above) of the
SOFTWARE PRODUCT.

6. OEM PRODUCT SUPPORT. Product support for the SOFTWARE PRODUCT is NOT provided by
Greenwald Intellicard, Division of the Eastern Company or its subsidiaries. Should you have any questions
concerning this agreement, or if you desire to contact Greenwald Intellicard, Division of the Eastern
Company for any other reason, please refer to the address provided in the documentation.

7. OEM U.S. GOVERNMENT RESTRICTED RIGHTS.  The SOFTWARE PRODUCT and
documentation are provided with RESTRICTED RIGHTS.  Use, duplication, or disclosure by the
Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data
and Computer Software clause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of the Commercial
Computer Software-Restricted Rights at 48 CFR 52.227-19, as applicable. Manufacturer is Greenwald
Intellicard, Division of the Eastern Company, 212 Middlesex Ave., Chester, CT 06412-1254. Any other use
of the SOFTWARE PRODUCT is prohibited.
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1 . 1 . 1 .  W e l c om e

Welcome! With the purchase of the Greenwald Intellicard Smart Card
Management System 2 (SMS2), you have opened the door to the world of
integrated computer managed smart card systems. Using the Greenwald
Intellicard System, you will have the power to effectively manage
numerous laundry machines, Card Transaction Stations and Door Access
Readers, all with the convenience of an easy-to-use windows-based
software package – SMS2.

Previous users of SMS or other smart-card management software
packages will find SMS2 packed with new features and innovative
administration tools, making it the ideal system for addressing multiple
commercial laundry and access control solutions.

New users of the Smart Card Management System will find SMS2 to be
both intuitive and easy to learn.

Experienced and new SMS users alike will quickly benefit from the
Greenwald Intellicard system, and will soon enjoy:

! Reduced operating expenses.

! Increased profits.

! Reduced vandalism.

! Financial accountability.

! Controlled building access.

1INTRODUCTION
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1.2. Overview

The Smart Card Management System is a flexible and powerful
management tool that creates an electronic cash environment where the
need for handling and accounting for coins is eliminated. In addition,
smart card technology enables greater flexibility in controlling pricing
functions.

SMS2 effectively integrates not only a diverse line of Laundry Machine
Readers and Card Transaction Stations, but also an advanced electronic
Door Access system.

Before we can understand how SMS2 integrates these components, we
will review the Greenwald Intellicard system components.

1 . 2 . 1 .  S ys t e m Com p on en ts

1.2.1.1 Smart Cards
An obvious component to any smart card system is the Smart Card itself.
Greenwald Intellicard Smart Cards are a durable, high security
microprocessor-controlled storage medium. The smart card has the ability
to store large amounts of data in a completely secured environment,
preventing unauthorized duplication or alteration. These features
combined with a long life span make the Greenwald Intellicard smart card
an ideal medium for commercial laundry and door access applications.

Two card types are used in the Greenwald Intellicard System:

! User Cards are used to purchase commercial laundry services
or are used for door access applications. Typically, they will
be distributed by the building manager or purchased from a
Card Transaction Station.

! Management cards are used to initialize and set-up laundry,
transaction and Door Access Readers. They are also used to
collect audit information from the different Laundry Machine
Readers, Card Transaction Stations and Door Access Readers,
set pricing and time functions and run diagnostics on field
equipment.
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1.2.1.2. Machine Card Readers
The Machine Card Reader validates monetary values placed on smart
cards by customers and deducts the appropriate vend price before
initiating a cycle.  Machine Card Readers are equipped with displays,
which provide pricing, and operation instructions to the consumer as well
as to system administrators and service personnel. Machine readers also
store all machine activity, allowing this data to be retrieved and analyzed
with the SMS2 reporting function.

1.2.1.3. Card Transaction Stations
Card Transaction Stations allow for unattended smart card purchase and
recharge (adding value to an existing card). Customers insert cash into a
bill acceptor or swipe a credit/debit card, and the transaction station either
dispenses a smart card or adds value to a previously purchased card.
System Administrators and/or service personnel to account for currency
or credit/debit card transactions can periodically audit card Transaction
Stations.

1.2.1.4. Door Access Readers
Door Access Readers are sophisticated access control systems that are
installed with an electronic locking device such as an electric strike or
magnetic lock. These units can be programmed to allow access to
specified cardholders, and can also be used to deny entry into a building
or room at any time.

            1.2.1.5. Smart Card Management System
The focus of this manual will be the operation of the Smart Card
Management System. Once properly installed and set up, functions of
SMS2 enable the operator to:

! Set up laundry Machine Card Readers and Card Transaction
Stations with pricing and functions defined according to your
needs.

! Set up and maintain an “electronic” key system with the Door
Access Manager.

! Retrieve and view audit reports from all equipment including
usage reports, money collected and access reports.

! Set up PC stations to issue and sell user cards.

! Maintain and update all pricing and setup information.
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1 . 2 . 2 .  T he  B i g  P i c t u r e

So how does it all work?  The System Administrator enters the necessary
data into the software: locations, machines, pricing and other information
SMS2 will need to manage a system.

When data entry is complete, the System Administrator can create
different types of Smart Cards to perform various functions.  Each Smart
Card can be used to perform one or several of the functions listed below.

1.2.2.1. Management Cards

Login Cards – Smart Cards that allow or restrict the operation of
SMS2.  Additional login cards allow other users to become
System Administrators.

Setup Cards – Smart Cards that utilize data entered into SMS2 to
program each individual unit - laundry machines, card transaction
machines and Door Access Readers.

Data Collection Cards – Smart Cards used to collect data stored
on individual machine readers, transaction machines and Door
Access Readers and transfer this data to SMS2. The collected data
from these cards create reports for later analysis.

Utility Cards – Smart Cards used to allow laundry machines to
operate in service mode for necessary maintenance. Utility cards
also allow the set up of time/date information for the machines.
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1.2.2.2. User Cards

Cash Cards – Smart Cards purchased from a Card Transaction Station or
issued through SMS2. These cards are used to purchase vends, and can be
revalued at a Card Transaction Station or by the software.

User Cards – Smart Cards issued to users that have been assigned a
unique User Identification. This enables system administrators to track
individuals’ usage of Laundry Machine Readers, Card Transaction
Stations and Door Access Readers.

Once the data is entered, and the appropriate cards have been created for
setup and distribution to users, the system is ready to be used. Users will
be able to purchase cards from Card Transaction Stations (if available),
add value to cards, and use laundry machines equipped with the
Greenwald Intellicard Laundry Machine Readers.
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1.3. Understanding SMS2

1 . 3 . 1  W ha t  i s  SM S2 ?

Smart Card Management System 2 (SMS2) is the managing component
of the Greenwald Intellicard Smart Card System. This versatile, easy to
use software package can manage an unlimited number of laundry
facilities as well as control door access functions. The primary tasks of
the SMS2 software are to manage data, create cards and generate reports.

1.3.1.1. Data Management
The software sorts, tracks and displays all data relating to:

! Laundry machines.

! Card Transaction stations.

! Door Access Readers.

! System users.

1.3.1.2. Card Creation
Along with the PC Smart Card Reader, SMS2 creates and reads all the
cards necessary to manage the Greenwald Intellicard Smart Card system
including:

! Machine setup cards.

! Utility Cards.

! Data Collection Cards.

! User Cards.

           1.3.1.3. Report Generation
A comprehensive selection of pre-designed reports has been included
with the SMS2. Reports are easily viewed or printed and include:

! Cash collected.

! Machine usage.

! Door Access usage.

! Location information

Additionally, custom report generation is possible with SMS2.
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1 . 3 . 2 .  Ho w d oe s  S MS 2  W ork  f o r  Yo u?

SMS2 is the central management tool used to control your entire
Greenwald Intellicard Smart Card System. From one PC, you can quickly
and easily customize the functions and operations of each machine used
in the system.

Customization includes pricing, time and cycle function specifications for
laundry machines, as well as location restrictions. This means that
changing the vend cost for a washer or deciding to run specials at certain
times of the day is now just a few key strokes away. Specific location
pricing and restricting the use of cards to only certain locations is also
accomplished in the SMS2 software.

The features of the Greenwald Intellicard Smart Card System combined
with the ease of use of the SMS2 software offers greater accountability
and the ability to save both time and money.

1.3.2.1. Accountability
All transaction information in SMS2, Laundry Machine Readers, Card
Transaction Stations and Door Access Readers can be recorded. SMS2
has the ability to gather and manage the transaction information. This
means that:

! When service personal use a service card, the date and time of the
action can be recorded.

! Collectors are accountable for cash collected in the transaction
stations.

! Machine usage by individual customers can be tracked.

1.3.2.2. Save Time
The Smart Card System does away with the great expense and time
resources needed to handle and account for coins. SMS2 also has other
valuable time saving features:

! The SMS2’s easy to learn and use interface allows you to be up
and running in just a short period of time.

! The cloning feature in SMS2 allows for quick setup of similar
machines and users.

! Quick and easy generation of reports that let you keep track of
your entire operation—at a glance!
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! Remote programming is currently available for the Credit Card
and Multi Transaction Systems.

Now that you know more about the Greenwald Intellicard Smart Card
Management System 2 and how it can help you better operate and
administrate you system, let’s get started…
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2 . 1 . 1 .  O ve r v i e w

This chapter will cover the basic steps for getting started with SMS2:

! System requirements for installation.

! Installing SMS2 software and hardware.

! Starting SMS2 once it is installed.

! A review of the SMS2 Interface

! Working with Smart Cards

A section covering the overall architecture of SMS2 including navigation
has been included as well.

2GETTING STARTED WITH SMS2
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2.2. Installation

This section reviews the PC hardware requirements for running SMS2
and describes both the software and hardware installation. Users
upgrading from SMS1 should consult with Greenwald Intellicard
Technical Support Department for further details at 1-800-221-0982.

2 . 2 . 1 .  S ys t e m R eq u i re m en t s

Following are the minimum system requirements necessary for SMS2 to
be installed and used on your PC:

! Pentium or equivalent processor.

! Windows 95 or Windows 98 Operating System.

! 32 Megabytes of RAM (Random Access Memory).

! Available serial port.

! 40 Megabytes disk space (Hard Drive).

! PS2 Keyboard or Mouse Port
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2 . 2 . 2 .  S o f t wa r e  I ns t a l l a t i o n

1. Insert the SMS2 CD-ROM into your computer’s CD-ROM drive
and the Auto-Run program will begin. If Auto-Run starts proceed
to Step 2 (Page 25). If Auto-Run does not start proceed to Step a.
(below).

a. Click the Start button located on the Windows Task Bar
(Figure 2.1).

b. Click Settings (Figure 2.1).

c. Click Control Panel (Figure 2.1).

Figure 2.1 Starting Alternate SMS2 Installation

d. In the Control Panel folder, double click the add/remove
icon (Figure 2.2).

�������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�������������������������������������������������������������������������������������������������������������������������������������������������������������������������Note:�������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�������������������������������������������������������������������������������������������������������������������������������������������������������������������������SMS2 is designed to run on a local hard drive. Network drives are not�������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�������������������������������������������������������������������������������������������������������������������������������������������������������������������������supported at this time.
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�������������������������������������������������������������������������������������������������������������������������������������������������������������������������be enabled in the Windows operating system. If it is not, consult your�������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�������������������������������������������������������������������������������������������������������������������������������������������������������������������������Windows documentation to enable it, or follow these steps:
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Figure 2.2 Opening the Add/Remove Program Window

e. Click the Install button located at the top of the window
(Figure 2.3).

Figure 2.3 Add/Remove Programs Properties Window

Click here to
open the
Add/Remove
Program
window

Click here
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f. Click Next (Figure 2.4).

Figure 2.4 Insert CD-ROM Window

g. Click Finish (Figure 2.5).

Figure 2.5 To Complete Alternate Installation

2. A license agreement will appear. Please read this carefully and
click the Yes button to accept the license conditions (Figure 2.6).

Figure 2.6 Licensing Agreement
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3. In the Choose Destination Location window, click Next to accept
the default folder location, or click the Browse button to install
SMS2 elsewhere.  If you choose to install the software elsewhere,
make note of where you have installed it (Figure 2.7).

Figure 2.7 Choose Destination Location Window

4. When the Select Program Folder window appears, click Next to
complete the installation, or click Browse to select a different
folder for custom settings. Now click Next to complete the
installation (Figure 2.8).

Figure 2.8 Select Program Folder Window
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5. A window may appear prompting you to restart your computer. If
so, restart your computer at this time.  If you are not prompted to
restart your computer, you are ready to run SMS2.

Installation of SMS2 onto your system is now complete. An SMS icon
has been placed both on your desktop and in the programs menu of the
Windows Task Bar (Figure 2.9).

Figure 2.9 SMS Icon

Caution:
It may take several minutes for the install to complete. Do Not Reboot
Until Installation is Completed!
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2 . 2 . 3 .  Ha r d wa r e  I ns t a l l a t i o n

In order to operate SMS2, a Tritheim Smart Port Smart Card
Reader/Writer (PC Card Reader) must be installed. This reader must be
purchased with your other system components. Follow these steps for the
PC Reader installation:

1. Close all programs using the serial port connection you have
designated for use with the SMS2 PC Reader.

2. Plug the PC Reader’s 9-pin serial connector into the PC’s serial
connection.

3. Plug the PC Reader’s adapter between the PC’s PS2 keyboard or
mouse port and the PC.

Since the PC Reader driver installation has been completed during the
software installation process and SMS2 automatically searches all serial
and parallel ports for the reader, the installation process is now complete.

You are ready to begin using SMS2!
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2 . 2 . 4 .  S t a r t i n g  S MS 2  f o r  t he  F i r s t  T i m e

Once the software and hardware installation have been completed, follow
these steps to start the software:

2. Double click the SMS icon located on the desktop of your PC
(Figure 2.9). The Login window will appear.

3. Insert either a Greenwald Intellicard User or Management Smart
Card (Sections 2.4.1) into the PC reader. Be sure that the smart
chip is facing up and leading into the reader (Section 2.4.2).

4. Enter the 4-digit default PIN (Personal Identification Number), 1-
2-3-4, and click the Ok button to begin SMS2 (Figure 2.10).

Figure 2.10 Login Window

Tech Tip
If you find that SMS2 will not start or that the software does not recognize the PC
Reader, reboot your computer.

Enter the default
login PIN – 1-2-3-4

Click here to continue
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5. Label this card as your login card.

6. Once a user has successfully logged into SMS2 the Login Card
can be removed from the PC Reader at anytime.

2 . 2 . 5 .  No r ma l  SM S 2  L og in

1. Double click the SMS2 icon located on the desktop of your PC
(Figure 2.9). The Login window will appear.

2. Insert a Login Card (Section 2.4.2)

3. Enter the correct Personal Identification Number (Figure 2.10).

4. Click OK to start the software (Figure 2.10).

Warning!
The Greenwald Intellicard Smart Card used for this process is now the
default system administrator card.  Unless other system administrator
cards are created this is the only means to access the software. It is
recommended that at least one other administrator card be created at
this time (See Chapter 4).

Caution:
In addition to the Smart Card you created to be the system
administrator card, you will need your PIN to access the software.
Together they are the only means of accessing the SMS software. It is
recommended that the PIN be changed immediately to prevent any
security compromises (the Login window states that 1-2-3-4 is the
default PIN). Be sure to keep the System Administrator card in a safe
place so that you do not inadvertently get locked out of the software.
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2 . 2 . 6 .  T he  SM S 2  In t e r f ac e

SMS2 is a modular software package that can be purchased in different
configurations. The modules that make up SMS2 are called managers.
Each manager has been developed to function with specific components
of the Greenwald Intellicard System. The following is a description of
each manager.

2.2.6.1. Login Controls Manager (Figure 2.11)
Security has been a major consideration in the development of the SMS2
software. Although the software’s ability to manage an entire
organization’s laundry and door access equipment makes it convenient, it
can also make it vulnerable. For this reason, the Login Controls Manager
can control access and administrative privileges in SMS2.

In the Login Manager you will be able to enter information about each
SMS2 user, assign their Personal Identification Numbers (PIN), define
their SMS2 privileges and restrictions, and issue them Login Cards.

Figure 2.11 Login Controls Manager
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2.2.6.2. Locations Manager (Figure 2.12)
The Locations Manager is included with all SMS2 software packages.
Every machine and user that is entered into SMS2 is assigned to a
Location. Utilizing multiple locations allows you to restrict machine
usage by location, control door access, and also gives you the ability to
produce meaningful reports. To use SMS2 it is necessary to set up at least
one location. All the other managers utilize information from the
Locations Manager.

Figure 2.12 Locations Manager

2.2.6.3. Machines Manager (Figure 2.13)
The Machines Manager tracks all Laundry Machine Readers, Card
Transaction Stations and Door Access Readers being managed by the
SMS2 software.  In the Machine Manager you will be able to assign each
machine an individual identification, location, and make and model
number.  As with the Locations Manager, the information stored in this
manager is utilized by other managers in the SMS2 software.
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Figure 2.13 Machines Manager

2.2.6.4. User Cards Manager (Figure 2.14)
The User Cards Manager is an advanced feature of the SMS2 software
package.  In the User Cards Manager, specific identities can be assigned
to a particular Smart Card.  This allows for individual programming of
cards for both the Door Access Readers (i.e. limiting usage to one
particular location) as well as data collection based on individual usage of
Laundry Machines and Card Transaction Stations.

Figure 2.14 User Cards Manager

2.2.6.5. Laundry Machines Manager (Figure 2.15)
The Laundry Machines Manager is the module that manages all
information relating to washers, dryers and stack laundry machines. In
addition to being able to access the Locations Manager and Machines
Manger directly from within the Laundry Machines Manager, other
functions include:
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! The management of laundry machine readers including pricing,
cycle and display information.

! The collection and reading of laundry machine transaction data.

! Printing of laundry machine reports.

! Administration of special pricing based on peak usage

Figure 2.15 Laundry Machines Manager

2.2.6.6. CTS Cards Manager (Figure 2.16)
The CTS Cards Manager is used for operating and maintaining Cash
Transaction Machines.  All functions of the Cash Transaction Machines
are set up within this manager. These functions include card deposit
charge, maximum card values, display messages, bills to be accepted and
data collection cards. There are also several reports available here for the
Cash Transaction Machine transactions.
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Figure 2.16 CTS Card Manager
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2.2.6.7. Credit CTS Manager (Figure 2.17)
The Credit CTS Manager programs the Credit Card Transaction Station
and the Multi Card Transaction to allow cashless recharge and value of
Smart Cards.  The SMS2 software allows both dial-up modem access and
direct access via PC to set up and data collect the Credit and Combo CTS.
Once set up, the Credit CTS is now able to accept debit and credit cards
for transactions.

Figure 2.17 Credit CTS Manager
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�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������The Credit CTS is password protected to prevent unauthorized outside�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������access. This adds additional security to the sensitive data being�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������collected and stored in the Credit Card Transaction Station.
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2.2.6.8. Cash Cards Manager (Figure 2.18)
The Cash Cards Manager allows SMS2 software users to create Cash
Cards from their computer when a transaction station is not being used at
a location.

Creating Cash Cards using this manager also allows for individual Cash
Cards to be created with specific monetary values preset on each card.

The Cash Cards Manager can also be used as the SMS2 “cash register.”
It tracks every debit and credit made in the software, accounting for all
funds added, subtracted and by whom.

Figure 2.18 Cash Cards Manager

2.2.6.9. Utility Cards Manager (Figure 2.19)
The Utility Cards Manager is used to create Smart Cards that set the
internal clocks of Laundry Machine Readers and Door Access Readers.
Other Utility Cards can initiate a service mode operation in Laundry
Machine Readers and Card Transaction Stations.
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Figure 2.19 Utility Cards Manager

2.2.6.10. Door Access Manager (Figure 2.20)
The Door Access Manager allows you to determine access to buildings
and rooms.  This can limit access to the laundry room as well as provide
added security to sensitive areas of a business or building.  The Door
Access Manager allows you to program the relay delay, as well as run
reports containing such information as who uses a location and when.

Figure 2.20 Door Access Manager
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2.3. SMS2 Functions

As stated earlier, SMS2 is designed to be intuitive and easy to use. It puts
at your fingertips the tools you need to manage your laundry facilities. All
SMS2 features and commands are easy to use and are just a mouse click
away.

In this section the SMS2 feature and command navigation will be
explained.

2.3.1. Tabs
The managers are divided into tabs. To open a manager, simply click on
the corresponding tab (Figure 2.21).

Figure 2.21 Tabs

2.3.2. Menus
Menus, a common Windows element, are widely used in the SMS2
software. SMS2 displays menus in a Menu Bar at the top of the screen
(Figure 2.22). You can choose commands from the menus in two ways:

! Click the menu name to access the menu. When applicable,
click the name of the submenu, and then click the command
you need.

Click Tab to open
corresponding manager
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! Press the ALT button on your keyboard to activate the Menu
bar, and use the cursor keys to navigate through the menus and
submenus. Once a desired command is highlighted, press the
enter key.

Figure 2.22 Menus

2.3.3. Buttons
SMS2 is equipped with both command and database access buttons
(Figure 2.23). These allow for easy navigation and shortcuts to commonly
used commands. To activate a button, simply point to it with your mouse
and click. Using the Tab key to highlight the desired command and then
pressing the Enter key can also activate command buttons.

Figure 2.23 SMS2 Buttons

Database
Buttons

Command
Buttons

Menu Name

Menu Bar

Drop-
Down
Menu

Submenu
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2.3.4. Keyboard Navigation
This manual will provide instructions for SMS2 using a mouse or another
PC pointing device. Since SMS2 uses standard Windows navigation
elements, keyboard navigation can also be used.

When working with the records in SMS2 the tab key is used to navigate
through the fields, options and command buttons within the record. The
space bar is used to enable or disable options and the Enter key is used to
activate a command button.

2.4. Working with Smart Cards

There are three different types of smart cards used in the Greenwald
Intellicard system. The primary difference between each one of these
cards is their memory capacity. The card types are as follows:

! User Card (256 Byte memory capacity)

! Management Card (1K memory capacity)

! 8K Management Card (8K memory capacity)

For certain card applications (Section 1.2.2), it is necessary to use a
specific card type to insure that there is enough memory for its assigned
functions. In other cases, more than one card can be used. When possible,
it is most cost-effective to use the lowest memory card.



CHAPTER 2: GETTING STARTED WITH SMS2 SMART CARD MANAGEMENT SYSTEM 2

42 Rev. B

2 . 4 . 1 .  V i s ua l l y  I d en t i f y i n g  a  Ca r d

The Smart Chip for each card has a unique appearance. Figure 2.24
shows the different types of smart-chips.

Figure 2.24 Visually Identifying Smart Cards
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2 . 4 . 2 .  Re a d i ng  a n d  W r i t i n g  t o  t he  S m ar t  Ca rd

When using SMS2, you will need to write (or create) new smart cards or
read the data from existing smart cards. This is accomplished through the
use of the PC Smart Card Reader. When using the PC Card Reader, insert
the card with the chip side facing up and toward the reader.

Figure 2.25 Inserting the Smart Card into the PC Reader
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2 . 4 . 3 .  I de n t i f y i ng  Ca r d  Co n t e n t s

Each card created in the SMS2 software can be audited to identify the
card type (Service Card, User Card, etc.). Once the card type is
determined, it can be examined from the manager in which it was created
and further details can be viewed.

2.4.3.1. Identifying a Card
1. Insert the Card into the PC Reader (Section 2.4.2).

2. Select Identify Card from the Help drop-down menu on the main
screen (Figure 2.26).

Figure 2.26 Identifying a Card

3. A window containing the card information will appear (Figure
2.27).

Figure 2.27 Card Identification Window

4. Click the Exit button when finished, or insert a different card into
the PC Reader and click the Read Again button (Figure 2.27).
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3 . 1 . 1 .  O ve r v i e w

In this chapter, a guided tour will introduce the steps involved in the software
setup of a laundry facility. This section is recommended only for previous SMS
users and seasoned PC users who want to get a feel for the new SMS2 interface
structure. Only brief explanations of different screens and functions will be
provided. Please refer to the appropriate chapters for further details.

3 . 1 . 2 .   T he  Sc ena r i o

For this exercise, we will set up two separate laundry facilities. Both
facilities have identical equipment. Each laundry room is equipped with:

! 1 Cash Transaction Station

! 5 Whirlpool EMS2000 Washers

! 5 Maytag PD Dryers

Although the equipment is identical, the vend cost for each location
differs as shown in Table 3.1.

Table 3.1 Pricing by Property Name

Huntington Woods Lake View

CTS Card Deposit $3.00 $4.50

Washer $1.30 $1.75

Dryer $1.00 $1.15

Because of the difference in price and the close vicinity of these two
properties, we will restrict tenants to using only the equipment in their
building.

3GUIDED TOUR
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3.2. Setting Up the Databases

The first step in setting-up the system is to configure the different
databases necessary to run the equipment in our scenario. The databases
that need to be set up are associated with the following managers (or
software modules):

! Locations Manager

! Machines Manager

! CTS Cards Manager

! Laundry Machines Manager

The following sections will cover the setup process in each one of these
SMS2 Managers.
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3 . 2 . 1 .  Loc a t i on s

1. After logging on to SMS2 (Section 2.2.5), click Locations in the
main dialog box (Figure 3.1).

Figure 3.1 Locations

2. The Location Data dialog box will open. Select Add New
Location from the Edit drop-down menu (Figure 3.2).

Figure 3.2 Add Location

Click
here
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3. A blank Location record will appear. Enter the information from
Table 3.2 into the appropriate fields.

Table 3.2 Huntington Woods Location Setup

Field Name Information to Enter

Location ID Huntington

Location Name Huntington Woods

Address 1 32 Huntington Lane

Address 2

City Chester

State/Prov CT

Zip 06412

Name Fred Ferone

Phone (860) 555-1212

Fax (860) 555-1122

E-Mail fferone@Hwoods.com

4. Once all information has been entered correctly, click Update to
save the information into the database (Figure 3.3).

Figure 3.3 Saving New Location

Click here to
save new
location
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5. Repeat steps 2 through 4 to enter the data for Lake View. Use the
information in Table 3.3 to enter the correct data for each field in
the Location Data dialog box

Table 3.3 Lake View Location Setup

Field Name Information to Enter

Location ID Lake View

Location Name Lake View

Address 1 1050 Buena Vista Drive

Address 2 P.O. Box 2400

City Middletown

State/Prov CT

Zip 06400

Name Janice Jones

Phone (860) 555-1212

Fax (860) 555-1122

E-Mail jjones@lakeview.com

6. When completed, the Location List Window in the Location Data
dialog box should include the two properties (Figure 3.4).

Figure 3.4 Completed Location Setup

7. Close the Location Data window by clicking the Exit button.

Location
List
Window
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3 . 2 . 2 .  Mac h in e s

After the Locations have been entered, the next step is to set up the
Machine Database.

1. Click Machine in the main dialog box (Figure 3.5).

Figure 3.5 Opening the Machine Manager

2. In the Machine Manager dialog box, select Add New Machine from
the Edit drop-down menu (Figure 3.6).

Figure 3.6 Adding a New Machine

Click Machine
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3. A blank Machine record will appear. Enter the information in Table
3.4 into the appropriate fields to set up the Cash CTS for Huntington
Woods.

Table 3.4 Huntington Woods Cash CTS Machine Setup

Field Name Information to Enter

Location ID Huntington

Machine ID CTS001

Type CTS

Make Intellicard CTS Cash

Position in Room Front

Firmware Version 2.15

Model Number 5101-AVSD-F

Serial Number 01234560001

4. Once all information has been entered correctly, click Update to store
the information into the database (Figure 3.7).

Figure 3.7 Saving Machine Information
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Click here to
save the
machine
information
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5. Repeat steps 2 through 4 to set up the Cash CTS for the Lake View
property. Use Table 3.5 to enter the correct data for each field in the
Machine Manager (List of Machines) dialog box.

Table 3.5 Lakeview Cash CTS Machine Setup

Field Name Information to Enter

Location ID Lake View

Machine ID CTS002

Type CTS

Make Intellicard CTS Cash

Position in Room Front

Firmware Version 2.15

Model Number 5101-AVSD-F

Serial Number 01234560002

6. Next, add two more records to set up the dryers and washers for
Huntington Woods. Repeat steps 2 through 4 using the information in
Table 3.6 to enter the correct data.

Table 3.6 Huntington Woods Machine Setup

Field Name Washer Setup Dryer Setup

Location ID Huntington Huntington

Machine ID WPL-W 001 MPD-D 001

Type Washer Dryer

Make Whirlpool EMS 2000 Maytag Retrofit

Position in Room Multiple Multiple

Firmware Version 2.36 3.15

Model Number EMS 2000 Maytag PD

Serial Number N/A N/A
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7. Finally, set up the washer and dryer for the Lake View property.
Repeat steps 2 through 4 using the information in Table 3.7 to enter
the correct data.

Table 3.7 Lake View Machine Setup

Field Name Washer Setup Dryer Setup

Location ID Lakeview Lakeview

Machine ID WPL-W 002 MPD-D 002

Type Washer Dryer

Make Whirlpool EMS 2000 Maytag Retrofit

Position in Room Multiple Multiple

Firmware Version 2.36 3.15

Model Number EMS 2000 Maytag PD

Serial Number N/A N/A

8. When completed, check to verify that the Machine List Window in
the Machine Manager (List of Machines) dialog box includes the 6
machines entered in this section (Figure 3.8).

Figure 3.8 Completed Machine Setup

Machine
List
Window
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3 . 2 . 3 .  P r o f i l e s

Once Locations have been established and all Machine types have been
entered, profiles need to be defined before the machines can be
programmed. In the profile section of the database, information defining
pricing and other functions of the different machines is entered.

3.2.3.1. CTS Profile
Begin by defining the profile for the CTS. Notice that the profiles for the
two locations will be similar except for the deposit cost for the card and
the CTS cutoff value.

Set up the Huntington Woods CTS Profile with the following steps:

1. Click the CTS Cards tab in the main screen (Figure 3.9).

2. Click CTS Profile button (Figure 3.9).

Figure 3.9 Opening the CTS Profile Manager

Click
here

Then
click
here
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3. The CTS Profile Manager will open. Select Add New Profile from
the Edit drop-down menu (Figure 3.10).

Figure 3.10 Adding a New Profile

4. A blank Profile record will open. Enter the information from Table
3.8 into the appropriate fields.

Table 3.8 Huntington Woods Cash CTS Profile Setup

Field Name Information to Enter

Profile Name Huntington CTS

Idle Message Welcome Tenants

Problem Message Call 800-555-1212

Max Value on Card $99.00

CTS Cutoff Value $4000.00

Check User Card Location Click on box to enable this feature

Location Clustering Do not enable this feature

Manual Data Collection
Card

Do not enable this feature

Dispenser Click on box to enable this feature

Display Deposit Message Click on box to enable this feature

Card Deposit $3.00

Denomination
Accept/Awarded

Click on all boxes other than
$2.00 to accept all other bill
denominations. Awarded column
values should match the Accept
column values (see Figure 3.11).
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5. Once all information has been entered correctly, click Update to store
the information into the database (Figure 3.11).

Figure 3.11 Updating the Database
Click Update
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6. Repeat steps 3 through 5 to set up the Cash CTS Profile for the Lake
View property. Use Table 3.9 to enter the correct data for each field in
the CTS Profile Manager dialog box.

Table 3.9 Huntington Woods Cash CTS Profile Setup

Field Name Information to Enter

Profile Name Lake View CTS

Idle Message Welcome Tenants

Problem Message Contact Management

Max Value on Card $99.00

CTS Cutoff Value $6000.00

Check User Card
Location

Click on box to enable this feature

Location Clustering Do not enable this feature

Manual Data Collection
Card

Do not enable this feature

Dispenser Click on box to enable this feature

Display Deposit Message Click on box to enable this feature

Card Deposit $4.50

Denomination
Accept/Awarded

Click on all boxes other than
$2.00 to accept all bill
denominations other than two-
dollar bills. Awarded column
values should match the Accept
column values (see figure 3.11
above).

7. When completed, check to verify that the CTS Profile List Window in
the CTS Profile Manager dialog box includes both profile setups
covered in this section.

8. Close the CTS Profile Manager by clicking the Exit button.
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3.2.3.2. Washer and Dryer Profiles
Set up the washer profile for Huntington Woods as follows:

1. Click the Laundry Machines tab in the main screen (Figure 3.12).

2. Click the Laundry Profile button (Figure 3.12).

Figure 3.12 Opening the Laundry Profile Manager

3. The Laundry Profile Manager will open. Select Add New Profile
from the Edit drop-down menu (Figure 3.13)

Figure 3.13 Adding a New Laundry Profile

Click
here

Then
click
here
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4. A blank profile record will open. Enter the information from Table
3.10 into the appropriate fields.

Table 3.10 Huntington Woods Washer Setup

Field Name Information to Enter

Profile Name Huntington Washer

Profile Type Select “EMS 2000”

Vend Price $1.30

Top Off Price Not Applicable

Dryer Options Not Applicable

Clear Counters After
Collection

Click on box to enable this feature

Check Location Click on box to enable this feature

User Transaction
Collection

Do not enable this feature

5. Once all information has been entered correctly, click Update to store
information into the database (Figure 3.14).

Figure 3.14 Updating the Database

Click here
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6. Repeat steps 3 through 5 to set up the Washer profile for the Lake
View property. Use Table 3.11to enter the correct data for each field
in the Laundry Machine manager.

Table 3.11 Lake View Washer Setup

Field Name Information to Enter

Profile Name Lake View Washer

Profile Type Select “EMS 2000”

Vend Price $1.75

Top Off Price Not Applicable

Dryer Options Not Applicable

Clear Counters After
Collection

Click on box to enable this feature

Check Location Click on box to enable this feature

User Transaction
Collection

Do not enable this feature
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7. To set up the dryers for the two properties, repeat steps 3 through 5
two more times to set up two profiles with the information from Table
3.12.

Table 3.12 Dryer Setup

Field Name Huntington Lakeview

Profile Name Huntington Dryer Lake View Dryer

Profile Type Select “Retrofit” Select “Retrofit”

Vend Price $1.00 $1.15

Top Off Price $.25 $.25

Idle Message MACHINE READY MACHINE READY

Busy Message MACHINE IN USE MACHINE IN USE

Scroll Speed
Value

80 80

Number of
Pulses

4* 4*

Display Idle
Message

Click on box to enable
this feature

Click on box to enable
this feature

Display Price
When Idle

Click on box to enable
this feature

Click on box to enable
this feature

Cash Deduction Select “Immediate” Select “Immediate”

Clear Counters
After Collection

Click on box to enable
this feature

Click on box to enable
this feature

Check Location Click on box to enable
this feature

Click on box to enable
this feature

User
Transaction
Collection

Do not enable this feature Do not enable this
feature
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8. When completed, check to verify that the Laundry Profile List
Window includes all four laundry profiles created (Figure 3.15).

Figure 3.15 Completing the Laundry Profiles

9. Close the Laundry Profile Manager window by clicking the Exit
button.

Profile
List
WiNdow
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3.3. Creating Setup Cards

Now that the database has been set up with all the necessary information
about our locations, the machines that will be used in them, and the
profiles of how these machines are to operate, the only step remaining to
begin operation is to program the machines.

To program the machines setup cards must be created.

3 . 3 . 1 .  C r e a t i ng  a  CTS  S e tu p  Ca rd

1. Click the CTS Cards tab in the main screen (Figure 3.16).

2. Click the Create Setup Card button.

Figure 3.16 Creating a CTS Setup Card

Click
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Then
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here
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3. In the Create CTS Setup Card window click on machine to setup
(Figure 3.17).

Figure 3.17 Select CTS to Program

4. Click the Select Profile button (Figure 3.17). Select the profile for
the CTS that is being programmed, and click the Select button
(Figure 3.18).

Figure 3.18 Select Profile

Select
CTS to
Program

Then
click
here

Select
a
Profile

Then
click
here
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5. Insert a Management Card into the PC Card Reader (Figure 3.19).

Figure 3.19 Inserting a Management Card into the PC Reader

Management
Card
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6. Click the Create CTS Setup Card button (Figure 3.20).

Figure 3.20 Creating the CTS Setup Card

7. The CTS Setup Card has now been created and can be used to
program your Card Transaction Station.

8. Close the Create CTS Setup Card window by clicking the Cancel
button.

Click
here
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3 . 3 . 2 .  C r e a t i ng  a  La un d r y  S e t up  Ca rd

1. Click the Laundry Machines tab in the main screen (Figure
3.21).

2. Click the Create Setup Card button (Figure 3.21).

 

Figure 3.21 Creating a Laundry Setup Card
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3. In the Create Laundry Setup Card window click on the machine to
set up (Figure 3.22).

 

Figure 3.22 Selecting a Laundry Machine to Program

4. Click the Select Profile button (Figure 3.22). Select the profile for
the Laundry Machine that is being programmed, and click the
Select button (Figure 3.23).

 

Figure 3.23 Selecting a Profile
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5. Insert a Management Card into the PC Card Reader (Figure 3.24).

Figure 3.24 Inserting a Management Card into the PC Reader

Management
Card
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6. Click the Create Laundry Setup Card button (Figure 3.25).

Figure 3.25 Creating the Laundry Setup Card

7. The Laundry Setup Card has now been created and can be used to
program your laundry machine.

Click
here
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4 . 1 . 1 .  O ve r v i e w

SMS2 has been designed to support a multi-user environment. The Login
Controls Manager allows the system administrator to control access to
SMS2.

4 . 1 . 2 .  De sc r i p t i o n

Access privilege to SMS2 carries great responsibility. Depending upon
the managers installed, users can have access to:

! All financial records and usage reports stored in the software.

! All data collected from the various laundry machines, Card
Transaction Stations and Door Access Units including collection
records, usage and service reports.

! Creating valued cash cards.

! Complete control of the Door Access system.

With this understanding, it becomes very clear that an advanced
systematic method to control and restrict access to the software is
necessary.

4LOGIN CONTROLS
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4 . 1 . 3 .  Ho w  Do es  i t  W ork ?

All software access and security functions are handled in the Login
Controls Manager. There are two Login categories defined by SMS2,
they are System Administrator and System User.

! A System Administrator is a user of SMS2 that has unrestricted
privileges to the entire SMS2 software package, including the
ability to create additional System Users and System
Administrators.

! A System User is a user of SMS2 that has privileges and
restrictions as set by the System Administrator. System Users
cannot create other System Users.

SMS2 requires two credentials for identification verification:

! A Login Card is issued, usually at the time of user creation,
and is required upon login to the system.

! A PIN (Personal Identification Number) is also assigned to
each system user and administrator for increased security.
Should the card be lost or misplaced, it would be useless
without the correct PIN.

�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������Note:�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������

Each user and administrator must have their own card and Personal
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������Identification Number.
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4 . 1 . 4 .  Lo g i n  Con t ro l  I n t e r f ace

The Login Control Interface is comprised of five sections (Figure 4.1):

1. The User List Window is a listing of all system users in the
database, including system administrators. The User Record
Window lists and sorts by the following user information:

! Last Name

! First Name

! Apartment Number

! Building Number

2. The User Information section holds the personal information
relating to each user.

3. The Privileges section is a series of tabs and check boxes that
define each user’s software privileges and restrictions.

4. The Card Information section shows the serial number of the
smart card that is associated with each user in the database.

5. The command buttons located on the bottom right of the
Login Controls interface allow for quick and easy use of
common functions used in the Login Control Manager.

Figure 4.1 Login Controls Manager Main Interface

Command Buttons

Software Privileges

User Information

User List Window

Card Information
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4.1.4.1. User Information
The User Information identifies each user who will have access to the
database. The only required field is the Account field, which must be a
unique alphanumeric identification that allows the software to
differentiate between each user. Optional fields have been added to
incorporate additional information for each user. This is especially
helpful for system administrators managing large numbers of system
users.

Table 4.1 describes each field in the User Information section of the
Login Manager, explains its significance and identifies field restrictions
such as maximum character information.

Table 4.1 User Information Fields

Field Name Description Restrictions

Account Required field for creating a unique user
identity. This identification will be used
by the software in reports, card creation,
etc.

Any alphanumeric
combination up to
ten characters in
length

Last Name Last Name of user Up to 32 characters

First Name First name of user Up to 32 characters

Address1 Address of user Up to 32 characters

Address2 Address of user Up to 32 characters

Apartment Apartment number of user Up to 16 characters

Bldg Building number of user Up to 16 characters

City City of user Up to 32 characters

State/Prov State or Province of user Up to 16 characters

Zip Postal code of user Up to 16 characters

Phone Phone number for user Up to 16 characters

Fax Fax number for user Up to 16 characters

Email Email address for user Up to 32 characters

Once again, SMS2 uses only the Account field to identify system users.
All other fields are kept in the database only for convenience in managing
large numbers of users.
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4.1.4.2. Privileges
The system administrator sets privileges for each user during the Login
User Setup process by checking the box for those areas or functions of the
software to which the new user will have access. Areas to which the user
is restricted are simply not checked. A user’s privileges can always be
edited or access can be denied at any time.

Table 4.2 describes each privilege controlled by the Login Controls
Manager:

Table 4.2 Privilege Description

Privilege Description

Location Manager

Add/Edit
Location

Allows users to add new locations and edit or delete existing locations.
This privilege allows access to the location database, which can affect all
other parts of the software. Only top-level administrators should have
access to this privilege. Locations are typically predetermined by the top-
level administrators and affect other SMS2 managers so caution should
be used when assigning this privilege.

continued on next page

Tech Tip:
A system administrator can decide to store other information than what is currently
listed in the User Information section. For example, if the Email field is not being used,
an employee’s badge number can be entered instead.

Warning!
Even though access privileges can be modified at any time, it is very
important to understand the implication of each SMS2 privilege before
assigning it to a user. Certain privileges obtained by the wrong person
can create irreversible consequences or security issues that are difficult
to correct. Table 4.2 explains each privilege in greater detail.
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Table 4.2 continued

Machines Manager

Add/Edit Machine The machine database manages information of Laundry Machine Readers
and Card Transaction Stations. This privilege allows a user to add, delete
and edit machines in the system. The information controlled by this
manager allows the machines to function properly. Altering machine
information will have a direct effect on report generation. Adding new
machines is done during the setup process of a property, or when adding
additional equipment to a site.

Login Manager

Change PIN Caution should be used when assigning any of the Login Control
privileges.

 The Change PIN function allows a user to change either their own or a
different user’s Personal Identification Number. This could potentially
allow someone to get “locked out” of the system. However, in order to
change a PIN, it is required to know the current PIN for a user and have
their login card.

Create Login
Card

This feature allows a user to create a new login card, or recreate a login
card if one is lost. Caution should be taken because a user can purposely
or inadvertently recreate a user card, potentially locking another user out
of the system.

Modify Login
Privileges

Modifying login privileges should be left only to top-level administrators
since a user would be able to assign themselves any privileges they desire
if they have access to this privilege.

Utility Card Manager

Create Service
Card

Service cards are used to initiate a service routine in the different
machines supported by the software. In some cases, cycles can be stopped
and free cycles can be started. The software keeps track of the different
service cards that are issued; therefore it is advisable that managers
overseeing service personnel create service cards.

Create Time Card A time card is used to set the date and time on a machine. Date and time
entries affect report generation and price specials (see Chapter 13).

Create Manual
Clock Card

A Manual Time card is used to set the date and time on a machine. Date
and time entries affect report generation and price specials (see Chapter
13).

continued on next page
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Table 4.2 continued

User Card Manager

Create
Transaction DC

Allows users to create a data collection card used to collect the user
transactions from each machine. Once the information is transferred to
the card it is no longer stored in the machine.

Read Transaction
DC

Allows users to transfer data from the data collection card to a PC and
view reports generated from that data.

Edit User Profile Allows modification of user records, and door access privileges.

Create User Card Allows the creation of a card for a user that is already in the system.

Read User Card Allows the reading of user cards and viewing the user information
associated with that card.

Door Access Manager

Create Setup
Card

Allows creation of a Door Access Reader setup card. All access
privileges are based on the reader identification and setup.

Create User Card Allows user to create a card for a user that is already in the system.

Create Master
Key

Allows user to create a card that will have access to all door access
readers in the system.

Edit User List Allows editing of user’s lists that have privileges to a specified Door
Access Unit.

Create User List
Setup Card

Allows creation of cards used to program/reprogram door access unit
with a new list of access privileges.

Create Data
Collection Card

Allows user to create a card for collecting transaction data from the door
access reader. Once data is collected, it needs to be transferred to the
software.

Read Data
Collection Card

Allows user to transfer transaction information from data collection card
into the software and to view transaction reports.

Read User Card Allows the reading of user cards and viewing the user information
associated with that card.

Laundry Card Manager

Create Setup
Card

Allows user to create a setup card that programs Laundry Machine
Readers with the data from the software. The user has the ability to select
any profile in the database to use when creating the setup card.

Edit Profile Allows editing of Laundry Profiles that contain pricing information as
well as location restrictions, display specifications and other machine
function information. Users who are not allowed to change machine
pricing and cycle durations should not be assigned this privilege.

Read Data
Collection Card

Grants user the ability to transfer data from a data collection card. Once
the information is downloaded, it can be viewed in various reports.

Create Data
Collection Card

This privilege allows a user to create a data collection card. Once the data
is collected from a Laundry Machine Reader, it should be transferred to
SMS2

continued on next page
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Table 4.2 continued

Cash Value Card Manager

Create Cash Card Allows a system user to create a card to be used for storing monetary
value.

Add Value Allows the system user to add value to a cash card. The value added is
deducted from the PC balance, an “electronic cash register,” and the
transaction is recorded in an audit report.

Subtract Value Subtracting value from a card is also tracked, and the value deducted is
added to the PC balance.

Read Cash Card The Read Cash Card feature enables a user to determine the cash value of
a Cash Card.

Edit PC Balance The PC Balance is an “electronic cash register” where the PC cash is
stored. This limits the amount of cash that a user can put on a card
without the PC being recharged. This feature allows a user to recharge the
PC.

Edit Maximum
Value

This privilege allows a user to define the maximum monetary value that a
cash card can hold.

CTS Card Manager

Create Setup
Card

Allows user to create a setup card that programs the Card Transaction
Station with the data from the software. The user has the ability to select
any profile in the database to use when creating the setup card.

Edit Profile Allows editing of Cash Transaction Station profiles containing location
restrictions, display specifications, bills accepted and card deposit cost.
Users who are not allowed to change the Cash Transaction Station
options should not be assigned this privilege

Create Data
Collection Card

This privilege allows a user to create a data collection card. Once the data
is collected from a Card Transaction Station, it should be transferred to a
PC.

Read Data
Collection Card

Allows user the ability to transfer the stored data from a data collection
card into the software. Once the information is transferred, it can be
viewed in various reports.

Credit CTS Manager

Modify Database Allows editing of the Credit CTS database. Allows user to create or edit
the Credit CTS profiles and setups.

Setup Via Modem Allows user to set up the Credit CTS utilizing a PC modem and phone
line.

Setup Via Direct
Connection

Allows user to set up the Credit CTS utilizing a direct serial connection.

Collect Via
Modem

Allows user to collect data from the Credit CTS utilizing a PC modem
and phone line.

Collect Via Direct
Connection

Allows user to collect from the Credit CTS utilizing a direct serial
connection
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4 . 1 . 5 .  W ork i n g  w i t h  L o g i n  Co n t ro l  R e c o rds

4.1.5.1. Adding a User
1. Click the Login Controls tab (Figure 4.2).

2. Click the Create Login Card button (Figure 4.2).

 

Figure 4.2 Opening a Login Create Card Window

3. Click the Add New User button (Figure 4.3).

 

Figure 4.3 Adding a New User

Click here to
open Create
Login Card
Window

Click here to
add new user

Click here
to begin
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4. Enter all needed user information.

5. Check all software privileges to be associated with this user (see
table 4.2 for further details).

6. After verifying that all user information and software privileges
have been entered correctly, click the Update button (Figure 4.4).

 

Figure 4.4 Saving Login User into the Database

7. Follow the steps in Section 4.1.5.2 to create a Login Card.

�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������Note:�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������While most fields in the User Information record are optional, the�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������Account field is a required field. A unique alphanumeric account number�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������or name up to 10 characters in length must be entered.

Click here to update
the record
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4.1.5.2. Creating a Login Card with a PIN (Personal
Identification Number)

1. Once a user is in the system, a login card can be created. In the
Login Controls tab, click the Create Login Card button (Figure
4.2).

2. In the User List Window, select the user to create a card for
(Figure 4.5).

3. Insert a Smart Card into the PC smart card reader and click the
Create Card button (Section 2.4.2).

 

Figure 4.5 Creating a Login Card

4. A PIN Entry dialog box will appear. Enter a 4-digit numeric PIN
to be associated with that card, and reenter the numbers in the
Confirm PIN Number field. Click Ok (Figure 4.6).

�������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�������������������������������������������������������������������������������������������������������������������������������������������������������������������������Note:�������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�������������������������������������������������������������������������������������������������������������������������������������������������������������������������If a card has been previously issued to the user you must first reset the�������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�������������������������������������������������������������������������������������������������������������������������������������������������������������������������user’s card serial number (Section 4.1.5.8)

Select user to
create card for

Click here
after inserting
smart card into
the PC Reader
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Figure 4.6 PIN Entry Window

5. A Login Card Created message appears, click Ok to complete card
creation (Figure 4.7).

Figure 4.7 Login Card Created

Enter a new Personal
Identification Number

Click here to
continue

Click here to complete
process

Re-enter Personal
Identification Number
to confirm
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4.1.5.3. Changing the PIN for an Existing Login Card
1. In the Login Controls tab, click the Change Card PIN # button

(Figure 4.8).

 

Figure 4.8 Opening the Change Card PIN # Window

2. In the first field enter the current PIN (Figure 4.9).

3. In the middle and bottom fields, enter and confirm the new PIN
(Figure 4.9).

4. Click the Change PIN Button (Figure 4.9).

Figure 4.9 Changing a PIN Number

5. A Login Card PIN Changed message will appear, click Ok.

Click here to
open
Change
Card PIN #
window

Enter Current PIN#

Enter new PIN #

Re-enter new PIN# to confirm

Click here to save changes
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4.1.5.4. Editing a User Record

1. In the Login Controls tab, click the Create Login Card button
(Figure 4.2).

2. Select the user to be edited by clicking on their name in the User
List Window (Figure 4.10).

3. Click the Edit button (Figure 4.10).

 

Figure 4.10 Editing Login Users

�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������

Note:�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������Once an account is assigned to a user, it is permanent! Editing a user�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������record will only alter privileges for the selected user.

Select
user to
edit

Then click
here
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4. Make any necessary changes.

5. Click the Update button to save your changes (Figure 4.11).

 

Figure 4.11 Completing Editing Process

Click here to
save
changes
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4.1.5.5. Deleting a User Record

1. In the Login Controls tab, click the Create Login Card button
(Figure 4.2).

2. Select the user to be deleted by clicking on their name in the User
List Window (Figure 4.12).

Figure 4.12 Selecting a User to be Deleted

3. Select Delete User from the Edit drop-down menu (Figure 4.13).

Figure 4.13 Deleting a Login User

Warning!
When deleting a User, the database retains the user information for
report generation only. A deleted user cannot be recovered.
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4. A confirmation to delete a user will appear. If you wish to
proceed, click the Yes button. Click the No button to cancel the
operation (Figure 4.14).

Figure 4.14 Deletion Confirmation
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4.1.5.6. Cloning a User
Cloning a user is a timesaving technique used to create multiple users
with the same or similar user address and software privileges. When
cloning a user all fields except Account, Last Name, and First Name are
recreated. To clone a record:

1. In the Login Controls tab, click the Create Login Card button
(Figure 4.2).

2. Select the user to be cloned by clicking on their name in the User
List Window (Figure 4.15).

Figure 4.15 Selecting a User to be Cloned

3. Select Clone User from the Edit drop-down menu (Figure 4.16)

Figure 4.16 Cloning a User

4. Enter a new Account name/number (Figure 4.17).

5. Enter Last and First Name fields (Figure 4.17).

6. Make any other applicable changes.
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7. Click the Update button to save the new user to the system (Figure
4.17).

 

Figure 4.17 Entering a New User
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fields
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4.1.5.7. Copying User Privileges
You can copy privileges from one user to another. To copy privileges:

1. In the Login Controls tab, click the Create Login Card button
(Figure 4.2).

2. In the User List Window select user whose privileges will be
copied (Figure 4.18).

Figure 4.18 Selecting a User

3. Select Copy Privileges from the Edit drop-down menu (Figure
4.19).

Figure 4.19 Copying Privileges

4. In the User List Window select user to copy privileges to
(Figure 4.18).

5. Select Paste Privileges from the Edit drop-down menu (Figure
4.20).

Select
a user
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Figure 4.20 Pasting Privileges

5.1.5.8. Resetting a Login Card Serial Number

If a system user’s Login Card is lost or damaged, reset the user’s card
serial number before a new one can be issued.

To reset a user’s Login Card serial number:

1. In the Login Controls tab, click the Create Login Card button
(Figure 4.2).

2. In the User List Window select user to reset card serial number for
(Figure 4.10).

3. Click the Edit button (Figure 4.10).

4. Select Reset Serial Number from the Edit drop-down menu
(Figure 4.21).

5. A warning window will appear, click Yes to continue or No to
cancel.

6. Click the Update button.

Warning!
By resetting the serial number of a user, you will lose the link between
the user and the card already created for him/her.
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Figure 4.21 Resetting a User’s Card Serial Number
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5 . 1 . 1 .  O ve r v i e w

Locations are the fundamental building blocks of the SMS2 database.
Locations must be defined and entered into the system before any
machines can be setup in the software database, or programmed for
operation.

Location records can identify individual or groups of facilities for the
purpose of usage restriction and more meaningful report generation.

The Locations function offers two useful features to the system operator:

! Locations allow the software to identify and gather data
collected from each facility separately, allowing for greater
flexibility in report generation. For example, an operator can
view total revenue by location rather than the totals for the
entire route.

! Utilizing multiple locations allows operators to restrict
machine usage and offers greater flexibility in controlling door
access. For example, if a route operator manages multiple
Laundromats within the same vicinity, utilizing location
restrictions prevents a customer from spending their money in
one location to buy a Cash Card and then using the card in a
different facility to purchase wash and dry cycles.

�������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�������������������������������������������������������������������������������������������������������������������������������������������������������������������������Note:�������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�������������������������������������������������������������������������������������������������������������������������������������������������������������������������Even if SMS2 is being used to manage only one facility, it is still�������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�������������������������������������������������������������������������������������������������������������������������������������������������������������������������necessary to create at least one location.

5LOCATIONS
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5 . 1 . 2 .  W ork i n g  w i t h  L oc a t i on  R ec o r ds

5.1.2.1 The Interface
The Location Record consists of four basic components (Figure 5.1):

1. The Location List Window displays all the Locations entered
into the software. The Location ID, Location Name, Contact and
the City of the Location are listed for easy identification and
sorting.

2. The Main Body of the record contains the Location information:
Location ID, Location Name, as well as address and contact
information. While the Location ID is a required alphanumeric
field, all other fields in this part of the record are optional.

3. Cluster Information is an advanced location restriction feature of
the software. It allows for laundry machine usage restriction by
location, while allowing for semi-restricted use of a centrally
located Card Transaction Station.

4. Command buttons for the most commonly used features have
been included for ease of use.

 

Figure 5.1 Location Data Interface
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Table 5.1 describes each field in the Locations Record and identifies the
field restrictions.

Table 5.1 Locations Record Fields

Field Name Description Restrictions

Location ID Required unique field containing a case-
sensitive identity for the location. This
identification is used in reports, machine
setup cards and all other functions
utilizing Locations.

Any alphanumeric
combination up to
ten characters in
length

Location
Name

Name of Location Up to 32 characters

Address1 Address of Location Up to 32 characters

Address2 Address of Location Up to 32 characters

City City of Location Up to 16 characters

State/Prov State or Province of Location Up to 16 characters

Zip Postal code of Location Up to 16 characters

Contact Name of contact at Location Up to 32 characters

Phone Phone number for Location Up to 16 characters

Fax Fax number for Location Up to 16 characters

E-Mail Email address or the Location contact Up to 16 characters

The only required field is the Location ID Field. All other fields are
optional and are kept in the database for ease of managing large numbers
of facilities.

Tech Tip:
A system administrator can decide to store other information than what is currently
listed in the Locations database. For example, if the Contact Name is not being used,
the name of the service technician who is responsible for this site can be entered
instead.
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5.1.2.2. Understanding Location Clustering
The clustering feature of the SMS2 allows for more advanced location
restrictions in the Card Transaction Station when that option is enabled.
This feature was designed to address the needs of those administering
large apartment complex facilities.

It allows end-users to purchase cards from a central location, yet limits
their use of laundry machines to a single location.

Clustering looks at the first four digits of the location ID as the global
identifier and the remainder of the ID field as the unique location
restriction.

When utilizing the clustering feature, you must begin all Location ID’s
for an apartment complex with the same four digits, and continue with
unique values for the rest of the field. Table 5.2 is an example of
assigning four location ID’s with a common clustering ID.

Table 5.2 Locations Clustering Sample

Location Building
Number

Location ID

Lakeview 100 LKVW100

Lakeview 200 LKVW200

Lakeview 300 LKVW300

Lakeview 400 LKVW400

If the location ID’s are entered in this fashion, the Card Transaction
Stations can be set up to recharge cards of tenants from any of these
buildings, yet the laundry machines in building 100, would only be
available to those tenants living in that building.

�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������

Note:�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������In order for this clustering sample to work, the CTS Profile would need�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������to have the “clustering” option enabled and would require that the four�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������Location ID’s listed in Table 5.2 be used.
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5.1.2.3. Opening the Locations Database
There are two ways to open the Locations Database (Figure 5.2):

! Clicking the Locations button in the main SMS2 interface, or

! Clicking the Locations button within the related managers:
Laundry Machines, CTS Card, Credit CTS and Door Access
Manager.

Figure 5.2 Opening the Locations Database

To open the
Locations
Database Click
the Locations
Button Located
in the Main
Interface, or in
related
managers.
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5.1.2.4. Adding a Location
1. Open the Locations Database (Section 5.1.2.3).

2. Select Add New Locations from the Edit drop-down menu (Figure
5.3).

3. Enter data into the appropriate fields (Table 5.1)

4. Verify that the data you have entered is accurate and click the
Update button to save (Figure 5.3).

Figure 5.3 Adding Locations

Click here
to save
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5.1.2.5. Editing a Location
1. Open the Locations Database (Section 5.1.2.3).

2. Select the location you wish to edit from the Locations List
Window (Figure 5.4).

3. Select Edit Selected Location from the Edit drop-down menu
(Figure 5.4).

4. Enter necessary changes.

5. Verify that the new information is accurate, and click the Update
button to save changes.

 
Figure 5. 4 Editing Locations

Tech Tip
Steps 2 and 3 can be avoided by simply double clicking on the location to be edited from
the Locations List Window.
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5.1.2.6. Deleting a Location
1. Open the Locations Database (Section 5.1.2.3).

2. Click the location you wish to delete from the Locations List Window
(Figure 5.5).

3. Select Delete Selected Location from the Edit drop-down menu
(Figure 5.5).

4. A confirmation window will appear, click Yes to continue, or No to
cancel.

  

Figure 5.5 Deleting a Location

Warning!
Deleted Locations cannot be recovered
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5 . 1 . 3 .  V i e w i ng  o r  P r i n t i ng  L oc a t i o n  L i s t  Rep o r t s

A report can be printed to list all the locations entered in SMS2. The
Report includes the Location ID, Location Name, Contact Name and City
of the location.

To print a Location List Report:

1. Click the Location List button in the main SMS2 window (Figure
5.6).

Figure 5.6 Opening a Location List Report

2. The Location List report will be open. You can view it on screen
or click the printer icon to print the report (Figure 5.7)

Figure 5.7 Location List Report

Click here
to print

Click here
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6 . 1 . 1 .  O ve r v i e w

The User Cards Manager is an advanced feature of the SMS2 software
package.  This manager allows the system administrator to distribute
individualized cards to end-users so that their activity can be tracked.
This manager can also be used to assign Door Access privileges.

These features make the User Cards Manager ideal for operations that
need to:

! Reconcile user transactions in cash systems.

! Track door access activity of individual end-users or
employees.

! Track user activity in the laundry machines and Card
Transaction Stations.

6 . 1 . 2 .  Ho w  Do es  i t  W ork ?

The User Cards Manager’s database must first be set up before individual
user cards can be created. Once the laundry machines, transaction
machines and Door Access Readers are properly programmed,
information can be tracked and a record of usage is established and
maintained.

A User Data Collection card is created. This card is then used to collect
the data from the machine. This User Data is later transferred into the
software. Once this process is completed, a report can be viewed or
printed to show individual user activity.

These are the steps that need to be followed to get the most of your User
Cards Manager:

1. Enter user information into the User Manager.

2. Create individual’s user cards in the User Card Manager.

3. Be sure to use the User Transaction Data Collection Dallas Stick
in all Laundry Machine Readers and Card Transaction Stations
where user transactions will be tracked.

4. Periodically collect data with your User Data Collection Card

5. View or print reports to see individual’s usage.

6USER CARDS MANAGER



CHAPTER 6: USER MANAGER SMART CARD MANAGEMENT SYSTEM 2

104 Rev. B

6.2. User Manager

The User Manager is a part of the User Cards Manager that keeps track of
all users in the system. Name, address and access information for Door
Access Readers is entered into the User Manager.

�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������Note:�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������Although the Access Privileges for Door Access Readers can be assigned�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������in the User Manager, a Door Access Location List must be set up in the�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������Door Access Manager in order for this feature to work (See Chapter 11).
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6 . 2 . 1 .  T he  Us e r  M an ag e r  I n t e r f ace

The User Manager is comprised of five sections (Figure 6.1):

1. The User Information section includes the user’s personal
information including name, address and access information.

2. Card Information that is associated with the User Card.

3. The Access Information section allows the administrator to
assign specific Door Access privileges to each user.

4. The User Manager utilizes command buttons to allow for
convenient access to commonly used functions.

5. The Users List Window allows for onscreen viewing of all users
in the system.

Figure 6.1 User Manager Interface

Users List
Window

Command
buttons

Access
Information

Card
Information

User
Information



CHAPTER 6: USER MANAGER SMART CARD MANAGEMENT SYSTEM 2

106 Rev. B

Table 6.1 describes each field in the User Manager, explains its
significance and identifies field restrictions:

Table 6.1 User Manager Fields

Field Name Description Restrictions

Last Name Last name of user Up to 32 characters

First Name First name of user Up to 32 characters

Address 1 Address of user Up to 32 characters

Address2 Address of user Up to 32 characters

Apartment Apartment number of user Up to 16 characters

Building Building number of user Up to 16 characters

City City of user Up to 32 characters

State/Prov State or Province of user Up to 16 characters

Zip Postal code of user Up to 16 characters

Phone Phone number for user Up to 16 characters

Fax Fax number for user Up to 16 characters

Email Email address of user Up to 30 characters

Number of
Adults

Number of adults living in apartment No restrictions

Number of
Children

Number of children living in apartment No restrictions

Rank The order of payment types this customer
prefers to use to reconcile his or her
account (Example: Cash then Credit Card
then Debit Card).

Drop-down menu

Tracking
ID

 A customized system to save time in
distributing User Cards (Section 6.3.1).

Drop down
selection

Account # Assigns a unique identity to the user Required
alphanumeric field
up to 10 characters
in length

Location # Assigns user to a location existing in the
Locations Manager

Required field,
Drop down
selection

Valid
Through

Assigns a start and expiration date for the
User Card (currently only applicable to
Door Access Cards).

Date/Time field

continued on next page
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Table 6.1 continued

Initial
Charge

When this option is enabled in the User
Profile as well as the Card Transaction
Station a user will be charged a fee
(entered in the CTS profile), the first time
the card is used.

Check box

No Time
Restriction

When this option is enabled the user will
not be affected by time restrictions set for
Door Access Readers (Chapter 11).

Check box

Assigned
Card Serial
#

Displays card serial number once a User
Card has been assigned to the user

Software defined

Access
Information

This section pertains to Door Access.
Refer to Chapter 11 of this manual for
further details.

Check boxes
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6 . 2 . 2 .  W ork i n g  w i t h  t he  Us e r  M an ag e r

6.2.2.1. Adding a User
1. In the User Cards Manager, click the User Manager button (Figure

6.2).

Figure 6.2 Opening the User Manager

2. Click the Add New User button or select Add New User from the
Edit drop-down menu (Figure 6.3).

3. Enter or select all information for the User Information and Card
Information sections (Table 6.1).

4. If Door Access is being used, check all areas that the user will
have access to and enable the “Active Access” option.

Tech Tip
When entering users in their respective locations, you can click the Load Address button
to enter the address information for that location.

Click
here
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5. After verifying that all user information and access privileges
have been entered correctly, click the Update button (Figure 6.3).

Figure 6.3 Adding a User

To Add
User

Click
Update
when
finished
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6.2.2.2. Editing a User
1. In the User Cards Manager, click the User Manager button

(Figure 6.2).

2. Click the user you wish to edit from the Users List Window
(Figure 6.4).

3. Select Edit Selected User from the Edit drop-down menu
(Figure 6.4).

4. Make necessary changes.

5. Verify that the new information is accurate, and click the
Update button to save changes.

  

Figure 6.4 Editing a User

Tech Tip
Steps 2 and 3 can be avoided by simply double clicking on the user to be edited from
the Users List Window.
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6.2.2.3. Deleting a User

1. In the User Cards Manager, click the User Manager button
(Figure 6.2).

2. Click the User you wish to delete from the Users List Window
(Figure 6.5).

3. Select Delete Selected User from the Edit drop-down menu
(Figure 6.5).

4. A window will appear to verify deletion of selected users,
click the Yes button to proceed with the deletion. Click the No
button to cancel this operation.

  

Figure 6.5 Deleting a User

Warning!
When deleting a User, the database retains the user information for
report generation only. A deleted user cannot be recovered.
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6.2.2.4. Cloning Users
The cloning feature has been included with SMS2 as a timesaving feature
for adding multiple users with similar information, such as tenants from
the same apartment but with separate accounts.

The cloning feature allows the system administrator to copy all the
information for an existing user except for the Account Number, and
name fields.

To clone a user, follow these steps:

1. In the User Cards Manager, click the User Manager button
(Figure 6.2).

2. Click the user you wish to clone from the Users List Window.

3. Select Clone User from the Edit drop-down menu (Figure 6.6).

4. Enter a new account number and make any other changes.

5. Enter the user’s name in the appropriate fields.

6. Click the Update button to save the information for the new
user to the database.

  

Figure 6.6 Cloning a User
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6.2.2.5. Resetting a User Card Serial Number

If a new card needs to be issued to a user after one has already been
issued, the card serial number that is tracked in the User Profile needs to
be reset first.

To do so follow these steps:

1. In the User Cards Manager, click the User Manager button (Figure
6.2).

2. In the Door Access User Profile Window select the user for whom
the card serial number is to be reset (Figure 6.7).

3. Click the Edit button.

4. Select Reset Card Serial Number from the Edit drop-down menu
(Figure 6.7).

5. A warning window will appear, click Yes to continue or No to
cancel.

6. Click the Update button.

 

Figure 6.7 Resetting a User Card Serial Number
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6.3. Creating User Cards

Once a user or a number of users have been entered into the system, user
cards can be issued. The User Card Manager is the tool for creating these
cards.

The User Card Manager creates either single user cards, or it can allow
for convenient multiple card creation.

6 . 3 . 1 .  T r ac k in g  I D  ( Op t i on a l  F ea t u re )

The Tracking ID feature has been implemented to save time in issuing
cards to a large number of users

Cards can be purchased with an external Tracking ID number printed on
the card. In this case Greenwald Intellicard can provide a database disk
that contains all of the Tracking ID numbers and their corresponding
internal card serial number.

Once this database is copied into the software the User Manager can use
this information to associate a card’s internal serial number to the
Tracking ID number on the card. This means that when entering a user
into the system, an available Tracking ID number is selected and the user
is issued that card.

This saves time because the card creation procedure is bypassed.

�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������Note:�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������

Importing the Tracking ID User Database is covered in Appendix A.
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6 . 3 . 2 .  W ork i n g  w i t h  t he  Us e r  Ca r d  Ma na g e r

6.3.2.1. Creating a Single User Card
1. In the User Cards Manager tab, click the User Card Manager

button (Figure 6.7).

Figure 6.7 Opening the User Card Manager

2. Select the user’s location from the Card Location drop down
selection (Figure 6.8).

3. If this card is being created for a new user, select the “Load only
new users for this location” sorting option to limit the number of
users to be listed (Figure 6.8).

4. Select the User Account Number or name from the appropriate
drop down selection (Figure 6.8).

Tech Tip
If managing a large number of users, you may first select the user’s building, apartment
or telephone number to narrow the number of users that will appear in the Account
Number or Name field.

Click here to
open the User
Card Manager
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5. If this user card will also be used for door access privileges,
enable the “Create Door Access Card” option by clicking on the
appropriate box (Figure 6.8).

6. Insert a user card into the PC Reader (Section 2.4.2).

7. Click the Create Card button (Figure 6.8).

 

Figure 6.8 Creating a single User Card

8. A window showing the card creation progress will appear. When
it has closed, the card has been created (Figure 6.9).

Figure 6.9 Card Creation Progress Window
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Option

4. Select
User
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Door
Access
privileges

7. Click
button to
create
card
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6.3.2.2. Creating Multiple User Cards
SMS2 allows for creation of multiple user cards by location or specific
buildings in a location. This option can be used to create cards for all
users in a selected location/building or for new users only (those who
have not had a user card issued to them).

To create multiple user cards, follow these steps:

1. In the User Cards Manager tab, click the User Card Manager
button (Figure 6.7).

2. Select the users’ location from the User Location drop down
selection (Figure 6.10).

3. If cards are being created only for new users, select the “Load
only new users for this location” option (Figure 6.10).

4. If cards are being created only for a specific building for this
location, select the building from the Building drop down
selection (Figure 6.10).

5. If these user cards are to be used for door access privileges, enable
the “Create Door Access Card” option by clicking on it (Figure
6.10).

6. Enable the “Auto Move to Next” option (Figure 6.10). This will
automatically go to the next new user to be created in the list.

7. Insert a blank user card into the PC Reader (Section 2.4.2).

8. Click the Create Card button (Figure 6.10).

 

Figure 6.10 Creating Multiple User Cards
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9. A window showing the card creation progress will appear. When
it has closed, the card has been created (Figure 6.9).

10. The software will automatically move to the next user in that
location/building. Insert a new card and click the Create Card
button again and continue this process for creating the desired
number of user cards.
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6.4. User Transaction Data Collection Dallas Stick

In order to benefit from the User Card options, all machines must be
equipped with the User Transaction Data Collection Dallas Stick.

If Laundry Machine Readers and Card Transaction Stations are not
currently equipped with the User Transaction Data Collection Dallas
Stick, an upgrade can be purchased by contacting Greenwald Intellicard
at 1-800-221-0982.

Warning!
Once a user card is issued, it will work on all programmed Laundry
Machine Readers and Card Transaction Stations regardless of whether
the User Transaction Data Collection Dallas Stick is installed in these
units or not.



CHAPTER 6: USER MANAGER SMART CARD MANAGEMENT SYSTEM 2

120 Rev. B

6.5. Collecting Data

When a User Card is used to operate a unit that has been programmed to
record machine activity, a transaction data record is kept in its memory.
To retrieve transaction records and view them, follow these three steps.

1. Create a User Data Collection Card.

2. Collect data from the machine.

3. Read the Data Card (transfer the transaction record into the
software).

Once these steps are completed, reports of user transactions can be
viewed or printed (Section 6.6.1).
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6 . 5 . 1 .  C r e a t i ng  a  Us e r  Da ta  Co l l ec t i on  Ca rd

1. Insert an 8K Management Smart Card into the PC Reader
(Section 2.4.2).

2. Click the Create Data Card button in the User Cards tab
(Figure 6.11).

 

Figure 6.11 Create User Data Card

3. A card creation progress window will appear. When
completed, the card has been created (Figure 6.12).

Figure 6.12 Card Creation Progress Window

Warning!
This process will delete any previous collections on the card. If this card
has been used for data collections in the past, read the data card into
the appropriate manager first.

Click here to
create a User
Data Card
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6 . 5 . 2 .  Co l l ec t i ng  t he  Us e r  Da t a

Before any User data can be collected, a Service Card must first be
inserted into the reader of the laundry machine or Card Transaction
Station (for further details on creating Service Cards, see Chapter 13). To
collect data, insert the User Data Collection Card into machine within one
minute of removing the Service Card and follow the instructions on the
display.

�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������Note:�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������Each User Transaction Collection Card has a limited capacity. Depending�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������upon the amount of data being collected, each card can collect the data�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������from 1 to 20 machines. These cards are also reusable. Once the data is�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������transferred from the card to a PC, you can recreate the collection card,�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������erasing all previous collections.
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6 . 5 . 3 .  Re a d i ng  Us e r  D a t a  Co l l ec t i o n  Ca rds

Reading the Data Card transfers the transaction records into the PC so
that the data can be viewed or used for report generation.

To read the User Data Collection Card:

1. Insert a User Transaction Data Collection Card with data on it into
the PC Reader (Section 2.4.2).

2. Click the Read Data Card button in the User Cards tab (Figure
6.13).

 

Figure 6.13 Reading a User Data Card

Click here to
read data
card
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3. Select one of the viewing options, then click the Read CTS
Collection Card button (Figure 6.14).

Figure 6.14 Reading the User Data Collection Card

4. The Read User Data Collection Card window will open and list all
the User data collections on the card. Select which records to save
select the Save Selected Records from the File drop-down menu
or click the Save and Exit button to save all records (Figure 6.15).

Figure 6.15 Saving the Collection Records

5. Double-clicking on a collection record listed in the Read User
Data Collection Card window will open a window containing the
Transaction Information, Machine ID, Location and Collection
Date/Time of that record.

Select viewing
option

Then click here

Then
click
here

Select
records
to save

Or here
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6.6. User Reports

User reports allow you to view or print a detailed report showing an
individuals’ usage of the different machines supported by the SMS2
software. Both User and Service transaction reports are available in the
User Cards Manager

6 . 6 . 1 .  V i e w i ng  an d  P r i n t i ng  Use r  Rep o r t s

Once data has been collected and transferred to a PC, follow these steps
to view or print a report:

1. In the User Cards Manager click the desired report or select it
from the User submenu of the Reports drop-down menu in the
main SMS window (Figure 6.16).

 

Figure 6.16 Accessing User Reports

Two methods
to initiate a
report
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2. A window specifying a date range will appear (Figure 6.17).
Enter the beginning and ending transaction dates for the
desired report. You can select the “No upper Bound” option to
view a report containing all transactions since the “Start of
range” field value or select the “No lower Bound” option to
view a report containing all transactions leading up to the
“End of range” value.

Figure 6.17 Date Range Window

3. The report will be generated and appear on your screen. You
can either view it on the screen, or click the printer icon to
print the report (Figure 6.18).

Figure 6.18 Cash Card Report Window

Click here to
print report
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6 . 6 . 2 .  Un d e rs t an d i n g  Us e r  Re po r t s

The report generated reflects all collected transactions for the date ranges
that were specified.

Tables 6.2 and 6.3 identify and explain each field in the User and Service
Transaction Data Collection Report.

Table 6.2 User Transaction Data Collection Report

Field Name Description

Account User’s account number.

Location Location of transaction.

Machine Machine ID of transaction.

Serial No. Serial number of User Card.

Dispensed Was a card dispensed or not.

Amount Amount of money for transaction.

Open Balance Balance prior to transaction.

Closed Balance Balance after transaction.

Transaction Date/Time The date and time of transaction.

Collection Date/Time The date and time of collection.

Table 6.3 Service Transaction Report

Field Name Description

Account User’s account number.

Location Location of transaction.

Machine Machine ID of transaction.

Serial No. Serial number of Service Card.

Transaction Type Type or transaction.

Transaction Date Transaction date and time.

Collection Date/Time The date and time of collection.
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6 . 6 . 3 .  De l e t i ng  Co l l ec t i o n  Da t a

You can periodically purge the collection data so that it will not take up
unnecessary disk space on your computer.

1. Click the View/Print/Delete button (Figure 6.19).

Figure 6.19 The Data Collected Window

2. Select the collection records to delete (Figure 6.20).

3. Select Delete Selected Records from the Edit menu (Figure
6.20).

Figure 6.20 Deleting the Collected Data

4. A confirmation window will appear. Click the Yes button to
proceed or the No button to cancel.

Warning!
Deleted collection data cannot be recovered.

Click
here

Select
data to
delete

Then click
here
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7 . 1 . 1 .  O ve r v i e w

Once Locations are defined and entered into the system, all machines
must be defined. Machines include:

! Laundry Card Readers

! Cash Transaction Stations

! Credit Card Transaction Stations

During the setup process each machine type and make are entered into the
Machine Manager and associated with a location. When entering
machines of the same type that are in the same location you may enter the
machine into the software only once. However if individualized reports
are desired or when user transaction data collection is used, it is necessary
to assign each machine a unique identification.

7Machine Manager



CHAPTER 7: MACHINE MANAGER SMART CARD MANAGEMENT SYSTEM 2

130 Rev. B

7 . 1 . 2 .  W ork i n g  w i t h  Mac h i n e  Ma na ge r  Rec o rd s

      7.1.2.1. The Interface
The Machine Manager Record consists of three components (Figure 7.1):

1. The Machine Manager List Window lists the following
information on all of the Machines: The Machine ID, associated
location, position in room, machine type and make of machine.

2. The main body of the record contains the Machine information
detailed in Table 7.1, display options, collection and installation
date information.

3. Command buttons for the most commonly used features have
been included for ease of use.

Figure 7.1 Machine Record Interface

Command Buttons

Collection
Information

Machine List
Window

Display Options

Initial Setup Date
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Table 7.1 describes each field in the Machine Record and identifies the
field restrictions.

Table 7.1 Machine Record Fields

Field Name Description Restrictions

Location ID Required field. Operator selects a
Location to be associated with
machine.

Drop-down menu
listing operator-
defined Locations

Machine ID Required field, assigns a unique
identity to the machine. The software
uses this identification in reports,
machine setup and card creation.

Any unique
alphanumeric
combination up to ten
characters in length

Type Required field. Operator selects a
machine type (example: washer, dryer,
stack and CTS).

Drop-down menu
listing machine types
predefined by
software

Make Required field. Operator selects a
machine make from a list
corresponding to the machine type

Drop-down menu
listing machine
makes predefined by
software according to
machine type
selected

Position in
Room

Optional field that is manually entered
and updated. Used for describing
position of machine in room. This field
is especially helpful if each machine in
a location is setup independently.

Up to 10 characters

Firmware
Version

Optional field that is manually entered
and updated. Allows system operator to
quickly view firmware version of
machine.

Up to 10 characters

Model
Number

Optional field that is manually entered
and updated. Model number of
machine.

Up to 48 characters

Serial
Number

Optional field that is manually entered
and updated. Serial number of machine.

Up to 48 characters

Last
Collection
Date

Automatic field. Software records the
date of the last data collection.

Defined by software

Install Date Software records the date of the initial
machine setup.

Defined by software

Sorting
Options

Allows system operators to view entire
machine database or selected by
location.

Check-box selections
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       7.1.2.2. Supported Machines
At the time of this publication, SMS2 is capable of supporting numerous
machine readers and Card Transaction Stations. Table 7.2 lists all
machines currently supported by the software. Greenwald Intellicard is
continually developing and implementing solutions for different laundry
machines. If the list does not include a machine make that you are
currently operating, please contact Greenwald Intellicard for possible
software upgrades.

Table 7.2 SMS2 Supported Machines

Machine Type Machine Make

Washers Whirlpool EMS 2000

Maytag Retrofit/Gen2

Speed Queen Retrofit

Continental Retrofit

Dexter Retrofit

Wascomat Retrofit

Whirlpool EMS 1000 Retrofit

Sears W 260516908

Speed Queen W SWT210/211*A

Speed Queen W SWT220/221*A

Speed Queen W SWT020/221*A

Hubesch W HWT120*C

Hubesch W HWT110*C

continued on next page
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Table 7.2 continued

Dryers Whirlpool EMS 2000

Maytag Retrofit/Gen2

American Dryer Retrofit

Speed Queen Retrofit

Whirlpool EMS 1000 Retrofit

Sears D 660051690

Speed Queen D SDE107*F

Speed Queen D SDG109*F

Speed Queen D SDG 009*A

Hubesch D HDE107*F

Hubesch D HDG109*F

Stack Dryers Whirlpool EMS 2000

Maytag Retrofit/Gen2

American Dryer Retrofit

Sears S 2679082990

Speed Queen S SSE107/117*F

Speed Queen S SSG109/119*F

Hubesch S HSE107/117*F

Hubesch S HSG109/119*F

CTS Intellicard CTS Cash/MiniMate

Intellicard CTS Credit

Intellicard CTS Combo Box

�������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�������������������������������������������������������������������������������������������������������������������������������������������������������������������������*�������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�������������������������������������������������������������������������������������������������������������������������������������������������������������������������
An asterisk indicates that any character(s) in its place will be supported.
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7 . 1 . 3 .  W ork i n g  w i t h  t he  M ach i ne  Ma n ag e r

7.1.3.1. Opening the Machine Manager Record
There are two ways to open the Machine Manager Record (Figure 7.2):

! Clicking the Machine button in the main SMS2 interface, or

! Clicking the Machine button within the related managers:
Laundry Machines, CTS Card and Credit CTS.

Figure 7.2 Opening the Machine Manager Record

To open the
Machine
Manager, Click
the Machine
Button Located
in the Main
Interface, or in
the related
managers.
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7.1.3.2. Adding a Machine
1. Open the Machine Manager (Figure 7.2).

2. Select Add New Machine from the Edit drop-down menu (Figure
7.3).

3. Enter data into fields (Table 7.1).

4. Verify that all data has been entered or selected correctly.

5. Click the Update button to save new machine.

Figure 7. 3 Adding a Machine

7.1.3.3. Editing a Machine
1. Open the Machine Manager (Figure 7.2).

2. Click the machine to edit from the Machine List Window (Figure
7.4).

3. Select Edit Selected Machine from the Edit drop-down menu
(Figure 7.4).

Click here
to save
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Figure 7. 4 Editing Machines

4. Make necessary changes.

5. Verify that the new information is correct, and click the Update
button to save changes (Figure 7.5).

Figure 7.5 Saving Changes

Tech Tip
Steps 2 and 3 can be avoided by simply double clicking on the machine to be edited
from the Machine List Window.

Click here
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7.1.3.4. Deleting a Machine

1. Open the Machine Manager record (Figure 7.2).

2. Click the machine to delete from the Machine List Window
(Figure 7.6).

3. Select Delete Selected Machine from the Edit drop-down menu
(Figure 7.6).

  

Figure 7.6 Deleting a Machine

4. A message will appear to verify deletion of selected Machine.
Click the Yes button to proceed with deletion of machine or No to
cancel (Figure 7.7).

Figure 7.7 Deletion Confirmation Window

Warning!
When deleting a Machine, the database retains the information for
report generation only. Deleted Machines cannot be recovered
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7.1.3.5. Cloning a Machine
The cloning feature has been included with SMS2 as a time saving
feature for adding multiple machines with similar information. This
feature is ideal in facilities where each machine is setup individually with
its own ID to track usage.

The cloning feature allows the system operator to copy all the information
from an existing machine in the database except for the Machine ID field.
Once a machine is cloned, the operator enters a new Machine ID, and the
new Machine information will be saved as a new record.

1. Open the Machine Manager (Figure 7.2).

2. Click the machine to clone from the Machine List Window
(Figure 7.8).

3. Select Clone Machine from the Edit drop-down menu (Figure
7.8).

 

Figure 7.8 Cloning a Machine
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4. Enter a new machine identification in the Machine ID Record
(Figure 7.9).

5. Click the Update button to save new machine record (Figure 7.9).

Figure 7.9 Completing the Cloning Process

Enter new
machine ID

Click here to
save new
machine
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7.1.3.6. Viewing the Machine List
1. Open the Machine Manager (Figure 7.2).

2. The Machine(s) will be listed in the Machine List Window.

3. Select a sorting preference by clicking the appropriate check-box
(Figure 7.10):

a. Display Machines at Selected Locations. This permits
viewing only machines associated with the location
selected in the Location ID record.

b. Display All Machines. Displays all machines in the
database.

4. To view details of an individual machine, select it by clicking on
the corresponding Machine ID in the Machine List Window.

Figure 7.10 Viewing Machines by Location

Tech Tip
To further sort the machine list, click the header that corresponds to the field by which
you wish to sort. For example, to view all Washers, click the Type list header. This will
sort the list by machine type and all the washers will be grouped together.

Location to View

Sorted Machine
View

List View
Preference

List Header
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        7.1.3.7. Printing a List of Machines
A list of all the machines in the database can be printed. The report
includes the Machine ID, Location, Position, Type and Make of each
machine.

To print the List of Machines report:

1. Open the Machine Manager (Figure 7.2).

2. Select Print List from the File drop-down menu (Figure 7.11).

Figure 7.11 Opening the Machine List Report

3. In the List Print Manager Window click the Print button (Figure
7.12).

Figure 7.12 Printing the Machine List Report

Click here



CHAPTER 7: MACHINE MANAGER SMART CARD MANAGEMENT SYSTEM 2

142 Rev. B

This page intentionally left blank



143 Rev. B

8 . 1 . 1 .  O v e r v i e w

An important function of the SMS2 software is to manage Smart Card
operated laundry machines that are equipped with Greenwald Intellicard
Machine Card Readers. The Laundry Machines Manager is the SMS2
module that is used to manage the data and functions needed to setup and
operate washers, dryers and stack laundry machines.

The capabilities of the Laundry Machines Manager include:

! Entering and managing Laundry Machine Profiles

! Creating Laundry Machine Setup Cards

! Defining and creating cards for Price Special Profiles

! Data collection and report generation

8.1.1.1 Laundry Machine Profiles
Laundry Machine Profiles define various functions and operation of the
Machine Card Readers and the laundry machines they control. Profiles
differ for each machine type (Section 8.2), but generally contain
information such as:

! Pricing

! Cycle durations

! Display message specifications

! Location restrictions

! Data collection and cash deduction option

8.1.1.2. Laundry Machine Setup Cards
Laundry Machine Setup Cards are used to program the Machine Card
Readers with the data that has been entered into the software. When the
card is created, a Location, Machine ID and Profile are selected and that
information is loaded onto a Smart Card. This card can then be used to
program one or more Machine Card Readers.

8LAUNDRY MACHINES
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8.1.1.3. Price Special Profiles
SMS2 allows for special pricing based on the time of day and the day of
the week. Price Special Profiles can be used for discounts during off
hours or premium pricing at peak use. Additionally, this feature can be
used to disable a machine at a specified time.

The Laundry Machines Manager allows you to define any number of
Price Special Profiles and create cards to program this information into
the Machine Card Readers. This feature can only be used on machines
previously programmed.

8.1.1.4. Data Collection and Report Generation
The Laundry Machines Manager is used to create Laundry Machine Data
Collection cards so that data can be collected. Once this card has been
used to collect the machine information, the Laundry Machines Manager
is used to read the data and generate reports.

8.1.1.5. The Laundry Machines Manager Interface
The Laundry Machines Manager (Figure 8.1), is used to access the
components discussed above as well as the Locations and Machine
managers.

Figure 8.1 The Laundry Machines Manager Interface
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8.2. Profi les

8 . 2 . 1 .  U n d e r s t a n d i n g  P r o f i l e s

The Profiles in the Laundry Machines Manager contain all the
administrator-defined specifications of the function and operation for
washers, dryers, and stack laundry machines being managed by the SMS2
software. Because SMS2 supports numerous makes and models of
laundry machines, there are six different Laundry Profiles and a Price
Special Profile to accommodate each machine type. Although each
profile is unique, pricing, cycle length and display specifications are
generally defined for each machine.

8.2.1.1. Profile Reference Table
Table 8.1 lists each profile type and the machine make that is associated
with it. Use this Table to determine which profile is used with the laundry
machines in a system.

Table 8.1 Profile Reference Table

Profile Supported Machine

Retrofit Maytag Retrofit

Speed Queen Retrofit

Continental Retrofit

Dexter Retrofit

Wascomat Retrofit

Whirlpool EMS 1000

American Dryer Retrofit

(Continued on next page)
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(Table 8.1 continued)

Electromechanical
Retrofit

Sears W 260516908

Speed Queen W SWT210/211*A

Speed Queen W SWT220/221*A

Speed Queen W SWT020/221*A

Hubesch W HWT120*C

Hubesch W HWT110*C

Sears D 660051690

Speed Queen D SDE107*F

Speed Queen D SDG109*F

Speed Queen D SDG 009*A

Hubesch D HDE107*F

Hubesch D HDG109*F

Sears S 2679082990

Speed Queen S SSE107/117*F

Speed Queen S SSG109/119*F

Hubesch S HSE107/117*F

Hubesch S HSG109/119*F

EMS 2000 Whirlpool EMS 2000 (Basic
Features)

EMS 2000 Cycle Setup Whirlpool EMS 2000 (Advanced
Cycle Setup)

Maytag Gen 2 Maytag Generation 2 (Basic
Features)

Maytag Gen 2 Advanced
Setup

Maytag Generation 2 (Advanced
Features)

Price Special Whirlpool EMS 2000

�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������*�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������An asterisk indicates that any character(s) in its place will be supported.
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8 . 2 . 2 .  T h e  L a u n d r y  P r o f i l e  I n t e r f a c e

The Laundry Machine Profile record consists of three common
components (Figure 8.2):

1. The Profile List Window lists all of the profile records in the
system.

2. The Main Body of the record contains the profile information,
which includes a profile name, profile type, pricing information,
location restriction and collection specifications.

3. Command buttons for the most commonly used features have
been included for ease of use.

             

Figure 8. 2 Laundry Profile Record

Command Buttons

Profile List
Window

Main Body
Data
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8 . 2 . 3 .  C o m m o n  L a u n d r y  P r o f i l e  E l e m e n t s

Although each profile type is unique, there are some elements associated
with most or all of the profiles. The following is an explanation of some
of these elements.

8.2.3.1. Idle Message
This message can appear on the Laundry Machine Reader display while
the laundry machine is not in operation. Typically a welcome message or
instruction is specified. In addition to the Idle Message, the Machine Card
Reader has the capability to display the price specified in the profile.
During the setup process, choose to display either, both or neither of these
messages.

8.2.3.2. Busy Message
This message can appear on some Laundry Machine Reader display when
the laundry machine is in use. Typically a message stating that the
machine is not available is specified. During the setup process, choose
whether or not to display a Busy Message.

8.2.3.3. Scroll Speed
The Scroll Speed field determines the speed that the Idle Message and
Busy Message are displayed on the Machine Card Reader. The speed can
be set anywhere from 0 to 100. A popular setting for this field is 80.

8.2.3.4. Cash Deduction
There are three styles of operation to deduct value from a Cash Card that
can be selected:

! Immediate The standard method of operation. When a
customer inserts a Cash Card into the Machine Card Reader
the card value is shown. After a short delay the new card value
(the original value less the vend cost) is shown. When this
process is completed a cycle is initiated in the laundry
machine when card is removed.

! Count Down A Cash Card is inserted into the reader and after
the card value is displayed, a count down from 3 to 1 gives
customers an opportunity to remove their cash card before the
vend cost is deducted.



CHAPTER 8: LAUNDRY MACHINES SMART CARD MANAGEMENT SYSTEM 2

149 Rev. B

! Re-insert A Cash Card is inserted into a reader and after
displaying the card value the customer is prompted to remove
and re-insert the Cash Card before the vend cost is deducted
and the cycle is initiated in the laundry machine.

8.2.3.5. Clear Counters After Collection
Each Machine Card Reader keeps a transaction record of the laundry
machine usage (counters). When collecting this data and viewing it in the
form of a report, the ability to see both elapsed and interval counters is
available. The “Clear Counters After Collection” option clears only the
usage information since the last data collection. When this option is
enabled, the viewing of both elapsed and interval counters is possible. If
this option is not enabled, the elapsed and interval counters will be
identical.

8.2.3.6. Check Location
When this option is enabled, the Machine Card Reader installed on the
laundry machine will verify that the Cash Card has been issued (either by
a Card Transaction Station or PC) with the correct location identification.
If the Location Identification does not match, the transaction will be
denied. This option allows the restriction of machine usage to a single
location.
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8 . 2 . 4 .  R e t r o f i t  P r o f i l e s

Retrofit Profiles are used to define the function and operation parameters
of the following laundry machine types:

! Maytag Retrofit

! Speed Queen Retrofit

! Continental Retrofit

! Dexter Retrofit

! Wascomat Retrofit

! Whirlpool EMS 1000

! American Dryer Retrofit

8.2.4.1. Overview
All of the laundry machines listed above were originally designed to work
with a coin-drop unit. Coin-drop operated laundry machines are already
equipped with an advanced electronic or computerized circuitry to
identify and verify that the correct coins are passing through the coin-
drop unit. This is accomplished with a special sensor that is located in the
coin-drop unit and is integrated with the circuitry of the laundry machine.
When coins are dropped, the sensor measures the time it takes the coin to
drop through it and the circuitry in the laundry machine verifies time
duration of the drop. When a coin is accepted the sensor will then send a
signal to the laundry machine called a pulse.

The Greenwald Intellicard System integrates with these laundry
machines, by simulating coin pulses with a relay installed on the Machine
Card Reader.

It is important to understand that the main functions of the Machine Card
Readers in these machine types is to display a price for customers, deduct
the vend cost from their Cash Card, and send the number of pulses
specified to the machine. For example, a laundry machine may start with
four pulses for a regular cycle (typically a value of one dollar), and set the
Greenwald Intellicard System to charge $1.25 or even have variable
pricing according to the time of day. As long as the laundry machine is
set to start with four pulses and the profile specifies a four pulse start, the
machine will operate at any set price.

Since these machines are equipped with electronic or computerized logic,
they may have advanced features built in such as variable cycle settings.
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In order to use these features, they must be programmed in the laundry
machine as specified by the machine’s manufacturer.

8.2.4.2. The Retrofit Profile Interface
Table 8.2 describes each field and its restrictions in the Retrofit Profile
(Figure 8.3).

Table 8.2 Retrofit Profile

Field Name Description Restrictions

Profile Name Required field creating an identity for the
profile. The software will use this
identification in reports, machine setup, and
card creation.

Any alphanumeric
combination up to
30 characters in
length

Profile Type Defines type of profile. Drop-down menu,
select “Retrofit”

Vend Price Price to begin normal cycle. Currency field

Top Off Price Price to initiate a top off cycle. Currency field

Idle Message Message to scroll on smart card reader display
when machine is not in use

Up to 30 character
(capitalized letters
only)

Busy Message Message to scroll on smart card reader display
while machine is in use.

Up to 30 character
(capitalized letters
only)

Scroll
Speed/Value

Scroll speed is a visual representation of the
scroll value for messages displayed on the
smart card reader display.

Range is between 0
to 100. Software
defaults to 50.

Number of
Pulses

Determines the number of pulses to send to
machine for a full vend (normal cycle). Top
off vends (for dryers) are automatically set to
one pulse.

Numerical Field

Display Options Allows operator to specify whether to display
the idle message, the price, or both when
machine is idle.

Two separate
check-boxes, one,
both, or neither can
be activated

Cash Deduction Selects the cash deduction style for the user
interface.

Drop-down menu

Clear Counters
after Collection

Enabling this option will clear the interval
counters when collecting data.

Check Box

Check Location Activates or deactivates the Check Location
option.

Check Box

User
Transaction
Collection

Enables user transaction collection in readers
equipped with the User Transaction Data
Collection Dallas Stick.

Check Box
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Figure 8.3 Retrofit Profile
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8 . 2 . 5 .  E l e c t r o m e c h a n i c a l  R e t r o f i t  P r o f i l e s

Electromechanical Retrofit Profiles are used to define the function and
operation parameters of the following laundry machine types:

! Sears W 260516908

! Speed Queen W SWT210/211*A

! Speed Queen W SWT220/221*A

! Speed Queen W SWT020/221*A

! Hubesch W HWT120*C

! Hubesch W HWT110*C

! Sears D 660051690

! Speed Queen D SDE107*F

! Speed Queen D SDG109*F

! Speed Queen D SDG 009*A

! Hubesch D HDE107*F

! Hubesch D HDG109*F

! Sears S 2679082990

! Speed Queen S SSE107/117*F

! Speed Queen S SSG109/119*F

! Hubesch S HSE107/117*F

! Hubesch S HSG109/119*F

8.2.5.1. Overview
Electromechanical Retrofit machines are washers and dryers designed to
work with a coin-chute and an electromechanical timer. The timer is
equipped with one or more switches to signal the laundry machine to start
or stop a cycle. When a customer actuates the coin-chute it physically
engages the electromechanical timer initiating its cycle.

�������������������������������������������������������������������������������������������������������������������������������������������������������������������������
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The Greenwald Intellicard System integrates with these laundry machines
by replacing the entire coin-chute and timer system with the Machine
Card Readers that utilize internal relay switches to signal the laundry
machines.

8.2.5.2. The Electromechanical Retrofit Profile Interface
Table 8.3 describes each field and its restrictions in the Electromechanical
Retrofit Profile (Figure 8.4).

Table 8.3 Electromechanical Profile Fields

Field Name Description Restrictions

Profile Name Required field creating an identity for the profile.
The software in reports, machine setup, and card
creation will use this identification.

Any alphanumeric
combination up to
30 characters

Profile Type Defines type of profile. Drop-down menu,
select
“Electromechanical”

Vend Price Price to begin normal cycle. Currency field

Top Off Price Price to initiate a top off cycle. Currency field

Idle Message Message to scroll on smart card reader display when
machine is not in use

Up to 30 character
(capitalized letters
only)

Busy Message Not applicable on Electromechanical machines.

Scroll
Speed/Value

Scroll speed is a visual representation of the scroll
value for messages displayed on the smart card
reader display.

Range is between 0
to 100. Software
defaults to 50.

Dryer Run Time Time duration of dryer cycle with normal vend. Numerical Field

Heat Time Portion of Dryer Run Time that will be heated (be
sure to consult dryer manual to determine correct
Run Time to Heat Time Ratio).

Numerical Field

Top Off Time Dryer cycle time duration for Top Off vend. Numerical Field

Display Options Allows operator to specify whether to display the
idle message, the price, or both when machine is
idle.

Two separate check-
boxes, one, both, or
neither can be
activated

Cash Deduction Cash deduction method for the user interface. Drop-down menu

Clear Counters
after Collection

Activates or deactivates the clear counter option. Check Box

Check Location Activates or deactivates the Check Location option. Check Box

User Transaction
Collection

Enables user transaction collection in readers
equipped with the User Transaction Data Collection
Dallas Stick.

Check Box
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Figure 8.4 Electromechanical Retrofit Profile
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8 . 2 . 6 .  E M S  2 0 0 0  P r o f i l e

The Whirlpool EMS 2000 washer and dryer series is a card-ready system.
These machines already come equipped with smart card readers. Most
functions are set through the machine interface (see EMS 2000 Owner’s
Manual), but the SMS2 software sets pricing and dryer run time.

Table 8.4 describes each field and its restrictions in the EMS 2000 Profile
(Figure 8.5).

Table 8.4 EMS 2000 Profile Record

Field Name Description Restrictions

Profile Name Required field creating an identity for the profile.
The software in reports, machine setup, and card
creation will use this identification.

Any alphanumeric
combination up to
30 characters

Profile Type Defines type of profile. Drop-down menu,
select “EMS 2000”

Vend Price Price to begin normal cycle. Currency field

Top Off Price Price to initiate a top off cycle. Currency field

Dryer Run Time Time duration of dryer cycle with normal vend. Numerical Field

Heat Time Portion of Dryer Run Time that will be heated is set
automatically by software according to Whirlpool
specifications

Software Defined

Top Off Time Dryer cycle time duration for Top Off vend. Numerical Field

Clear Counters
after Collection

Activates or deactivates the clear counter option. Check Box

Check Location Activates or deactivates the Check Location option. Check Box

User Transaction
Collection

Not Applicable for EMS 2000. Check Box
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Figure 8.5 EMS 2000 Profile
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8 . 2 . 8 .  M a y t a g  G e n 2  P r o f i l e

Maytag Gen2 machines (PR series) are card ready. They can be managed
by SMS2. In this profile only basic features such as pricing, washer cycle
length, rinse length and dyer time are defined. However, for ease of
operation the Maytag Gen2 Advanced profile can be used instead of
programming with the MEQ Maytag Machine Programmer. Table 8.7
describes each field and its restrictions.

Figure 8.7 Maytag Gen2 Setup Profile

Table 8.7 Maytag Gen2 Profile Record Fields

Field Name Description Restrictions

Profile Name Required field creating an identity for the profile.
The software will use this identification in
machine setup, and card creation.

Any alphanumeric
combination up to 30
characters

Profile Type Defines type of profile. Drop-down menu,
select “Maytag Gen2”

Vend Price Price to begin normal cycle. Currency field

Top Off Price Price to initiate a top off cycle. Currency field

Washer Option Select this option for use with washers. Includes
user defined wash agitate and rinse agitate cycle
length.

Check box with two
numerical fields for
cycle lengths

Dryer Option Select this option for use with dryers. Includes user
defined dryer cycle time.

Check box with a
numerical field for
dryer run time

Clear Counters
after Collection

Activates or deactivates the clear counter option. Check Box

Check Location Activates or deactivates the Check Location
option.

Check Box

User Transaction
Collection

Enables user transaction collection in readers
equipped with the User Transaction Data
Collection Dallas Stick.

Check Box

8 . 2 . 9 .  M a y t a g  G e n 2  Ad v a n c e d  P r o f i l e
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In this profile, all features and functions available to the Maytag Gen2
series of laundry equipment can be managed. Please refer to the Maytag
Gen2 Advanced Feature (Section 8.5.1).

Figure 8.9 Maytag Gen2 Advanced Profile

Table 8.8 Maytag Gen2 Advanced Profile Record Fields

Field Name Description Restrictions

Profile Name Required field creating an identity for the profile.
The software in machine setup, and card creation
will use this identification.

Any alphanumeric
combination up to
30 characters

Profile Type Defines type of profile. Drop-down menu,
select “Maytag
Gen2 Advanced”

Advanced
Features Tabs

A series of advanced options designed to meet
Maytag specifications (Section 8.5.1)

Series of four tabs
with multiple check
boxes and drop-
down menus

Clear Counters
after Collection

Activates or deactivates the clear counter option. Check Box

Check Location Activates or deactivates the Check Location option. Check Box

User Transaction
Collection

Enables user transaction collection in readers
equipped with the User Transaction Data Collection
Dallas Stick.

Check Box
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8 . 2 . 1 0 .  W o r k i n g  w i t h  t h e  L a u n d r y  P r o f i l e s

8.2.10.1. Adding a Laundry Profile
1. In the Laundry Machine tab, click the Laundry Profile button

(Figure 8.9).

2. Select Add New Profile from the Edit drop-down menu.

3. Enter/select data into the appropriate fields (See Tables 8.3 – 8.9)

4. Verify that all information is correct and click the Update button
to save the new record.

      

Figure 8.9 Creating a Laundry Profile

Click the Laundry
Profile Button

Select Add New
Machine
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8.2.10.2. Editing a Laundry Profile
1. In the Laundry Machine tab, click the Laundry Profile button

(Figure 8.9).

2. Click the profile to edit from the Laundry Profile List Window
(Figure 8.10).

3. Select Edit Selected Profile from the Edit Drop-down menu
(Figure 8.10).

   

Figure 8.10 Editing Retrofit Profile

4. Enter necessary changes.

5. Verify that the new information is accurate, and click the Update
button to save changes.

Tech Tip
Time Saving Shortcut – Double click Profile to be edited in the Profile List Window and
skip steps 2 and 3.
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8.2.10.3. Deleting a Laundry Profile
1. In the Laundry Machine tab, click the Laundry Profile button

(Figure 8.9).

2. Click the profile to delete from the Profile List Window (Figure
8.11).

3. Select Delete Selected Profile from the Edit drop-down menu
(Figure 8.11).

  

Figure 8.11 Deleting a Laundry Profile

4. A message will appear to verify deletion of selected Profile, click
the Yes button to proceed with deletion of machine or the No
button to cancel.

Warning!
Once a profile is deleted it cannot be retrieved. Be sure that the profile
being deleted will not be needed anymore for machine setup.
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8.2.10.4. Cloning a Laundry Profile
The cloning feature has been included with SMS2 as a time saving
feature for adding multiple profiles with similar information.

The cloning feature allows the system operator to copy all the information
for an existing profile in the database except for the Profile Name field.
Once a profile is cloned, the operator enters a new Profile Name, and the
new Machine information is saved as a new record.

1. In the Laundry Machine tab, click the Laundry Profile button
(Figure 8.9).

2. Click the profile to clone in the Profile List Window (Figure
8.12).

3. Select Clone Profile from the Edit drop-down menu (Figure 8.12).

 

Figure 8.12 Cloning a Laundry Machine

4. Enter new machine identification in the Machine ID Record
(Figure 8.13).

5. Click the Update button to save new machine record (Figure
8.13).

Figure 8.13 Completing the Cloning Process

Enter
new
profile
name Then

click
here
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8 . 2 . 1 1 .  W o r k i n g  w i t h  P r i c e  S p e c i a l  P r o f i l e s

SMS2 allows for special pricing and functions based on the time of day
and the day of the week. Price Special Profiles can be used for discounts
during off hours or premium pricing at peak use. Additionally, this
feature can be used to disable machines at a specified times.

The Laundry Machines Manager allows you to define any number of
Price Special Profiles and to create cards to program this information into
the Machine Card Readers. This feature can only be used on laundry
machines that have already been programmed.

To setup a Price Special Profile:

1. Create a Profile

2. Define up to twenty-three specials within the profile.

3. Create a Price Special Card to program the machine with.

8.2.11.1. Opening the Price Special Profiles Window
To open the Price Special Profiles Window click the Price Special button
in the Laundry Machines Manager (Figure 8.14).

Figure 8.14 Opening the Price Special Profiles Window

Click here
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8.2.11.2. The Price Special Profiles Window Interface
The Price Special Profiles window consists of five basic components
(Figure 8.15):

1. The Profile List Window displays all the profiles entered into the
software.

2. The Profile Information section contains the profile’s default
pricing information.

3. The Special List Window displays all the specials of a selected
profile.

4. The special information section contains the day, time and
specifications of the selected special.

5. Function and command buttons for the most commonly used
features have been included for ease of use.

Figure 8.15 The Price Special Profiles Interface

Profiles
List
Window

Profile
Information

Specials
List
Window

Special
Information

Function/
Command
buttons
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8.2.11.3. Adding a Price Special Profile
1. In the Price Special Profile window select Add Profile from the

edit drop-down menu (Figure 8.16).

Figure 8.16 Adding a Profile

2. Enter a profile name, the default price (price when no special is in
effect), Top Off price and time (for dryers only)(Figure 8.17).

3. Click the Update button (Figure 8.17).

Figure 8.17 Entering the Profile Information

Enter the
profile
information

Then
click
here
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8.2.11.4. Editing a Price Special Profile
1. In the Price Special Profile window select the Profile to edit from

the Profiles List Window (Figure 8.18).

2. Select Edit Profile from the edit drop-down menu (Figure 8.18).

 

Figure 8.18 Editing a Profile

3. Edit the profile information: profile name, default price (price
when no special is in effect), Top Off price and time (for dryers
only)(Figure 8.19).

4. Click the Update button (Figure 8.19).

Figure 8.19 Editing the Profile Information

Edit the
profile
information

Then
click
here
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8.2.11.5. Deleting a Price Special Profile

1. In the Price Special Profile window select the Profile to edit
from the Profiles List Window (Figure 8.20).

2. Select Delete Profile from the edit drop-down menu (Figure
8.20).

 

Figure 8.20 Deleting a Price Special Profile

Warning!
A deleted Price Special Profile cannot be recovered.
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8.2.11.6. Adding a Special
1. Select a Profile from the list to add a Special to (Figure 8.21).

2. Click the Add Special button (Figure 8.21).

Figure 8.21 Adding a Special

3. Enter the Special Information (Figure 8.22):

! Select the days for Special to apply (click the All days
button to select all the day of the week).

! Enter the Start and Stop time of the special or select All
Day.

! Enter the price for the special or select Machine Off for
machine to be off during the days and times specified.

4. Click the Update button (Figure 8.22)

Figure 8.22 Entering the Special Information

Then
click
hereEnter the

Special
Information

Select a
profile

Then
click
here
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8.2.11.7. Editing a Special
1. Select a Profile containing the Special to edit from the Profiles

List Window (Figure 8.23).

2. Select the Special to edit (Figure 8.23).

3. Click the Edit Special button (Figure 8.23).

Figure 8.23 Editing a Special

4. Make changes to the Profile information (Figure 8.24).

5. Click the Update button (Figure 8.24)

Figure 8.24 Editing the Special Information

Select a
profile

Then
click
here

And
select a
Special

Then
click
hereEdit the

Special
Information
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8.2.11.8. Deleting a Special

1. Select the Profile containing the Special to delete from the
Profiles List Window (Figure 8.25).

2. Select the Special to delete (Figure 8.25).

3. Click the Delete Special button (Figure 8.25).

Figure 8.25 Deleting a Special

Warning!
A deleted special cannot be recovered

Select a
profile

Then
click
here

And
select a
Special
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8.2.11.9. Creating a Price Special Card
1. In the Price Special Profile window select a profile to create a

card for from the Profiles List Window (Figure 8.26).

2. Insert a Management Card into the PC Reader (Section 2.4.2).

3. Click the Create Card button. (Figure 8.26).

Figure 8.26 Creating a Price Special Card

8.2.11.10. Creating a Clear Price Card
A Clear Card is used to clear the Price Specials once they have been
programmed into a Laundry Machine Reader.

1. Insert a Management Card into the PC Reader (Section 2.4.2).

2. Click the Create a Clear Card button (Figure 8.27).

Figure 8.27 Creating a Clear Card

Select a
profile

Then
click
here

Then
click
here
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8.3. Laundry Setup Cards

Once the location, machine and profile information have been entered,
you are ready to create a setup card.

The card creation is accomplished in the Laundry Setup Card window.
This window is comprised of three parts (Figure 8.28):

1. In the select machine ID and Location ID section, select which
laundry machine type and at what location to program (machine
setup is discussed in chapter 7). Additionally, an option to sort by
location is available and may be needed for users who have many
facilities.

2. In the Select Profile section, choose from a list of profiles.

3. In the last section of the Laundry Setup Card Window, the card
programming process is completed.

Figure 8.28 Create CTS Setup Card Window
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8 . 3 . 1 .  C r e a t i n g  a  L a u n d r y  S e t u p  C a r d

1. In the Laundry Machines tab, click the Create Setup Card button
(Figure 8.29).

Figure 8.29 Creating a Laundry Setup Card

2. Select a Machine ID with a corresponding Location ID by
clicking on it. There are two ways to view the machines in the
database (Figure 8.30):

a. Click “Show all Locations” and view the entire list of
machines.

b. Click “Show only Location” and use the drop-down menu
to view only machines from the selected locations

3. Click the Select Profile button (Figure 8.30).

Click here to
open card
creation
window
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Figure 8.30 Laundry Setup Card Creation Steps

4. Select profile from Profile List Window (Figure 8.31).

5. Review to verify that the profile information is correct, and click
the Select button (Figure 8.31).

 

Figure 8.31 Selecting a Laundry Machine Profile

Choose a
sorting
option

Click to
select
machine

Click to
select
profile

Click
profile to
be used

Click here to
continue
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6. Insert a management smart card into the PC reader (Section 2.4.2.)
and click the Create Laundry Setup Card button (Figure 8.32).

 

Figure 8.32 Creating the Laundry Machine Setup Card
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�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������“Automatically Move to the Next Machine In List After Card Creation”�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������

option. This will automatically go to the next machine on the list and
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������

save time. Be sure to use a different management card each time.

Click here to
complete
Laundry
Setup Card
creation
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8.4. Reports

The Laundry Machines Manager can generate laundry Machine Counter
reports. There are numerous advanced reports for the Maytag Gen2 series
of laundry machines described in Section 8.5.2.

The process for generating the reports is as follows:

1. Create a Data Collection Card

2. Collect data from machine

3. Read Data Card

4. View or print the report
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8 . 4 . 1 .  C r e a t i n g  a  D a t a  C o l l e c t i o n  C a r d

1. Insert a management card into the PC Reader (Section 2.4.2).

2. In the Laundry Machines tab, click one of the following (Figure
8.33):

a. Click the Create Data Card button to collect standard
reports from all machines.

b. Click the Create Adv Data Card button to collect advanced
reports in the Maytag Gen2 machines.

Figure 8.33 Creating a Laundry Machine Data Collection Card

8 . 4 . 2 .  C o l l e c t i n g  D a t a  f r o m  a  M a c h i n e

To collect data from a laundry machine, insert the card into the machine
reader and remove it when prompted by the display.

Click here for
regular data
collection

Click here for
Gen2
Advanced
Collection
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8 . 4 . 3 .  R e a d i n g  a  D a t a  C a r d

1. Insert a data card with collection information into the PC reader
(Section 2.4.2.).

2. In the Laundry Machines tab, click the Read Data Card button
(Figure 8.34).

Figure 8.34 Reading a Laundry Machine Data Collection Card

3. Select an option to show all the data collections on the card or
only data that has not been saved to the database then click the
Read Machine Collection Card button (Figure 8.35).

 

Figure 8.35 Reading the Data Collection Card

Click here to read
the Data
Collection Card

Select viewing
option

Then click here
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4. The Read Machine Data Collection Card window will open and
list all the User data collections on the card. Select which records
to save. Select the Save Selected Records from the File drop-down
menu or click the Save and Exit button to save all records (Figure
8.36).

 

Figure 8.36 Saving the Collection Records

5. Double-clicking on a collection record listed in the Read User
Data Collection Card window will open a window containing the
Transaction Information, Machine ID, Location and Collection
Date/Time of that record.

Then
click
here

Select
records
to save

Or here
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8 . 4 . 4 .  V i e w i n g  a n d  P r i n t i n g  R e p o r t s

1. Click the Laundry Counters button in the Laundry Machines
Manager for that report or select any other desired report from
the Laundry sub menu of the Reports drop-down menu (Figure
8.37).

 

Figure 8.37 Selecting Laundry Machine Report

2. A window specifying a date range will appear (Figure 8.38).
Enter the beginning and ending collection dates for the desired
report. Select the “No upper Bound” option to view a report
containing all transactions since the “Start of range” field
value or select the “No lower Bound” option to view a report
containing all transactions leading up to the “End of range”
value.

Figure 8.38 Date Range Window

Select Report
to View/Print
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3. The report will be generated and appear on your screen. Either
view the report on the screen, or click the printer icon to print
the report (Figure 8.39).

Figure 8.39 Viewing the Machine Counters Report

Click here to
print report
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8 . 4 . 5 .  U n d e r s t a n d i n g  L a u n d r y  C o u n t e r s  R e p o r t s

The report generated reflects all collected data for the date ranges that
were specified.

Table 8.9 identifies and explains each field in the Laundry Counters
Report.

Table 8.9 Laundry Counter Report

Field Name Explanation

Location Location of collection.

Machine Collected machine ID.

Interval Cycle Number of cycles since last collection.

Elapsed Cycle Total number of cycles.

Interval Bill Value Dollar value charged for vends since last collection.

Elapsed Bill Value Total dollar value charged for vends.

Collection Date/Time Date and time of collection.

�������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�������������������������������������������������������������������������������������������������������������������������������������������������������������������������Note:�������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�������������������������������������������������������������������������������������������������������������������������������������������������������������������������For Maytag Gen2 report explanation, refer to section 8.5.2.
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8 . 4 . 6 .  D e l e t i n g  C o l l e c t i o n  R e p o r t s

It is recommended to periodically purge the collection data so that it will
not take up unnecessary disk space on your hard drive.

1. Click the View/Print/Delete button (Figure 8.40).

 

Figure 8.40 Opening the Data Collected Window

2. Select the collection records you wish to delete (Figure 8.41).

3. Select Delete Selected Records from the Edit drop-down menu
(Figure 8.41).

 

Figure 8.41 Deleting the Collection Records

4. A confirmation window will appear. Click the Yes button to
proceed or the No button to cancel.

Click
here

Then
click
here

Select
reports to
delete
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8.5. Maytag Gen2 Information

8 . 5 . 1 .  M a y t a g  G e n 2  Ad v a n c e d  F e a t u r e s

8.5.1.1. Dryer or Dryer Stack

Washer/Dryer Tab

Position This value represents the position of the dryer or dryer stack in the room.
This is a required field with values predetermined by Maytag. The
available values range for dryers is 65-127.

Coin 1 Value Not used.

Location Not used.

Topoff Value Not used.

Machine Serial # This is the machine serial number assigned to this profile.

Reg Cycle (Min) Represents the number of minutes for a regular cycle.

Spc Cycle (Min) Represents the number of minutes for a special cycle.

Features Tab

Fixed Cycle A dryer set up for “Fixed Cycle” operation can only accept additional
time accumulated by increments equal to the length of a complete dry
cycle.

Special Pricing Enables Special Pricing.

Add Coin Mode This option causes the machine display to show the number of coins (coin
1) to enter, rather than the dollars-and-cents amount.

Coin Slide Mode Machine set to operate with Coin-Slide system.

Clear Escrow
Disabled

If not disabled, money held in escrow for 30 minutes without further
escrow or cycle activity will be cleared.

Disable Price
Display

Disables price from being displayed on the machine’s display.

Debit Only Machine set to operate with Smart Card system only.

Coins Only Machine set to operate with Coin-Drop system only.

Enhanced Debit This setting must be selected for the Greenwald Intellicard system.

Continued on next page
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8.5.1.1. Dryer or Dryer Stack continued

Prices Tab

Penny Offset This is a preset value by Maytag. If vend value is at $.25 on the
Washer/Dryer Tab and $.03 in the penny offset field then the vend price
is now calculated at $.28 to start the machine. The penny offset will also
change your special pricing and cycle based pricing by the increment
chosen.

Special Vend
Price

This is the value to set special time of day pricing.

This is the value to set for cycle based pricing.Regular Vend
Price

Time Time period when special pricing is in effect.

Days Days of the week when special pricing is in effect.

Super Cycle/Action Codes Tab

Set Serial Enables the serial number entered in the Washer/Dryer tab to be
transferred into the machine’s microprocessor.

Set
Location/Position

Enables the Location/Position set on the Washer/Dryer Tab to be set in
the Maytag Microprocessor.

Set Price/Coin
Value

Enables the Price/Coin Values set on the Washer/Dryer tab to be set in
the Maytag Microprocessor.

Set Cycle
Length/# Rinses

Enables the Cycle lengths/and number of rinses set on the Washer/Dryer
tab to be set in the Maytag Microprocessor.

Clear Interval
Counts

Enables the interval counters to be cleared after data collection.

Clear Interval
Counts-CCC

For use with Maytag Accutrac System

Record Used
Already

For use with Maytag Accutrac System
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8.5.1.2. Washer Dryer Stack

Washer/Dryer Tab

Position This value represents the position of the washer/ dryer stack in the
room. This is a required field with values predetermined by Maytag.
The available values range for washer/ dryer stack are 1-127.

Spin Speed* Maximum spin speed. *Horizontal models only.

Extra Rinse/Cycle Rinses/Cycle (Horizontal and Vertical), Extra Rinses/Cycle (Stack)

Coin 1 Value Not used.

Location Not used.

Prewash Time
(Min)

Length of time for a pre-wash in minutes, range is 0-10.

Rinse Agitate
(Min)

Not used.

Coin 2/Topoff This represents the value of the Topoff value in number of nickels.
05=$0.25

Machine Serial # This is the machine serial number assigned to this profile.

Wash Agitate
(Min)

Length of main wash cycle. Range is 8-20 minutes; default is 10.

Reg Cycle (Min) Represents the number of minutes for a regular cycle.

Spc Cycle (Min) Represents the number of minutes for a special cycle.

Final Spin (Min) Length of the final spin in minutes. Range is 3-10 minutes; default is 4.

Features Tab

Fixed Cycle A dryer set up for “Fixed Cycle” operation can only accept additional
time accumulated by increments equal to the length of a complete dry
cycle.

Special Pricing Enables Special Pricing.

Add Coin Mode This option causes the machine display to show the number of coins
(coin 1) to enter, rather than the dollars-and-cents amount.

Coin Slide Mode Machine set to operate with Coin-Slide system.

Clear Escrow
Disabled

If not disabled, money held in escrow for 30 minutes without further
escrow or cycle activity will be cleared.

Super Cycle Mode Allows for optional cycle enhancements to be purchased

Disable Price
Display

Disables price from being displayed in the machine.

Suds Detect Mode Allows machine to respond with special function when suds are sensed
– Horizontal units only. Minimum wash cycle of 10 minutes required.

Debit Only Machine set to operate with Smart Card system only.

Continued on next page
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8.5.1.2. Washer Dryer Stack continued

Coins Only Machine set to operate with Coin-Drop system only.  Not applicable for
Smart Card systems.

Enhanced Debit This setting must be selected for the Greenwald Intellicard system.

Max Extract
Disabled

Avoids wrinkles if activated, max water extraction if not.

Cycle Based
Pricing

Allows cycles to be priced differently for different water temperatures.

Prices Tab

Washer

Penny Offset This is a preset value by Maytag. If you set your vend value at $.25 on
the Washer/Dryer Tab and you select $.03 in the penny offset field then
the vend price is now calculated at $.28 to start the machine. The penny
offset will also change your special pricing and cycle based pricing by
the increment chosen.

Regular Vend
Price

Price of a regular cycle.

Regular Cold
Price

Price of a regular cold water cycle.

Regular Warm
Price

Price of a regular warm water cycle.

Regular Hot Price Price of a regular hot water cycle.

Special Vend
Price

This is the value set for special time of day pricing

Special Cold Price Price of a special cold water cycle.

Special Warm
Price

Price of a special warm water cycle.

Special Hot Price Price of a special hot water cycle.

Dryer

Penny Offset This is a preset value by Maytag. If you set your vend value at $.25 on
the Washer/Dryer Tab and you select $.03 in the penny offset field then
the vend price is now calculated at $.28 to start the machine. The penny
offset will also change your special pricing and cycle based pricing by
the increment chosen.

Special Vend
Price

Price of a normal cycle during a special time period.

Time Time period when special pricing is in effect.

Days Days of the week when special pricing is in effect.

Continued on next page
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8.5.1.2. Dryer Washer Stack continued

Super Cycle/Action Codes Tab

Upgrade Price Cost to upgrade to a Super Cycle (must be enabled in features)

Type Sets super cycle type. 1 for agitation enhanced, 2 for water enhanced,
3 for both.

Set Serial Enables the serial number entered in the Washer/Dryer tab to be
transferred into the machine’s microprocessor.

Set
Location/Position

Enables the Location/Position set on the Washer/Dryer Tab to be set
in the Maytag Microprocessor.

Set Price/Coin
Value

Enables the Price/Coin Values set on the Washer/Dryer tab to be set
in the Maytag Microprocessor.

Set Cycle Length/#
Rinses

Enables the Cycle lengths/and number of rinses set on the
Washer/Dryer tab to be set in the Maytag Microprocessor.

Clear Interval
Counts

Enables the interval counters to be cleared after data collection.

Clear Interval
Counts-CCC

For use with Maytag Accutrac System

Record Used
Already

For use with Maytag Accutrac System
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8.5.1.3. Horizontal Washer

Washer/Dryer Tab

Position This value represents the position of the horizontal washer in the room.
This is a required field with values predetermined by Maytag. The
available values range for washers are 1-63.

Spin Speed Maximum spin speed. *Horizontal models only.

Extra Rinse/Cycle Rinses/Cycle (Horizontal and Vertical), Extra Rinses/Cycle (Stack)

Coin 1 Value Not used.

Location Not used.

Prewash Time
(Min)

Length of time for a pre-wash in minutes, range is 0-10.

Coin 2/Topoff Not used.

Machine Serial # This is the machine serial number assigned to this profile.

Wash Agitate
(Min)

Length of main wash cycle. Range is 8-20 minutes; default is 10.

Final Spin (Min) Length of the final spin in minutes. Range is 3-10 minutes; default is 4.

Features Tab

Special Pricing Enables Special Pricing.

Add Coin Mode This option causes the customer display to show the number of coins
(coin 1) to enter, rather than the dollars-and-cents amount.

Coin Slide Mode Machine set to operate with Coin-Slide system.

Clear Escrow
Disabled

If not disabled, money held in escrow for 30 minutes without further
escrow or cycle activity will be cleared.

Super Cycle Mode Allows for optional cycle enhancements to be purchased

Disable Price
Display

Disables price from being displayed in the machine.

Suds Detect Mode Allows machine to respond with special function when suds are sensed
– Horizontal units only.

Debit Only Machine set to operate with Smart Card system only.

Coins Only Machine set to operate with Coin-Drop system only.  Not applicable in
Smart Card systems.

Enhanced Debit This setting must be selected for the Greenwald Intellicard system.

Max Extract
Disabled

Avoids wrinkles if activated, max water extraction if not.

Cycle Based
Pricing

Allows cycles to be priced differently for different temperatures.

Continued on next page
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8.5.1.3. Horizontal Washer continued

Prices Tab

Penny Offset This is a preset value by Maytag. If you set your vend value at $.25 on
the Washer/Dryer Tab and you select $.03 in the penny offset field then
the vend price is now calculated at $.28 to start the machine. The penny
offset will also change your special pricing and cycle based pricing by
the increment chosen.

Regular Vend
Price

Price of a regular cycle.

Regular Cold
Price

Price of a regular cold water cycle.

Regular Warm
Price

Price of a regular warm water cycle.

Regular Hot Price Price of a regular hot water cycle.

Special Vend
Price

Represent the number of quarter (coin 2); may adjust from 0-39.

Special Cold Price Price of a special cold water cycle.

Special Warm
Price

Price of a special warm water cycle.

Special Hot Price Price of a special hot water cycle.

Penny Offset This is a preset value by Maytag. If you set your vend value at $.25 on
the Washer/Dryer Tab and you select $.03 in the penny offset field then
the vend price is now calculated at $.28 to start the machine. The penny
offset will also change your special pricing and cycle based pricing by
the increment chosen.

Special Vend
Price

This is the value you set for special time of day pricing.

Regular Vend
Price

Price of a regular cycle.

Time Time duration when special pricing is in effect.

Days Days of the week when special pricing is in effect.

Super Cycle/Action Codes Tab

Upgrade Price Cost to upgrade to a Super Cycle (must be enabled in features)

Type Sets super cycle type. 1 for agitation enhanced, 2 for water enhanced,
3 for both.

Set Serial Enables the serial number entered in the Washer/Dryer tab to be
transferred into the machine’s microprocessor.

Set
Location/Position

Enables the Location/Position set on the Washer/Dryer Tab to be set
in the Maytag Microprocessor.

Set Price/Coin
Value

Enables the Price/Coin Values set on the Washer/Dryer tab to be set
in the Maytag Microprocessor.

Continued on next page
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8.5.1.3. Horizontal Washer continued

Set Cycle Length/#
Rinses

Enables the Cycle lengths/and number of rinses set on the
Washer/Dryer tab to be set in the Maytag Microprocessor.

Clear Interval
Counts

Enables the interval counters to be cleared after data collection.

Clear Interval
Counts-CCC

For use with Maytag Accutrac System

Record Used
Already

For use with Maytag Accutrac System
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8.5.1.4. Vertical Washer

Washer/Dryer Tab

Position This value represents the position of the vertical washer in the room.
This is a required field with values predetermined by Maytag. The
available values range for washers are 1-63.

Spin Speed Maximum spin speed. *Horizontal models only.

Extra Rinse/Cycle Rinses/Cycle (Horizontal and Vertical), Extra Rinses/Cycle (Stack)

Coin 1 Value Not used.

Location Not used.

Prewash Time
(Min)

Length of time for a pre-wash in minutes, range is 0-10..

Rinse Agitate
(Min)

Not used.

Coin 2/Topoff Not used.

Machine Serial # This is the machine serial number assigned to this profile.

Wash Agitate
(Min)

Length of main wash cycle. Range is 8-20 minutes; default is 10.

Final Spin (Min) Length of the final spin in minutes. Range is 3-10 minutes; default is 4.

Features Tab

Special Pricing Enables Special Pricing.

Add Coin Mode This option causes the customer display to show the number of coins
(coin 1) to enter, rather than the dollars-and-cents amount.

Coin Slide Mode Machine set to operate with Coin-Slide system.

Clear Escrow
Disabled

If not disabled, money held in escrow for 30 minutes without further
escrow or cycle activity will be cleared.

Super Cycle Mode Allows for optional cycle enhancements to be purchased

Disable Price
Display

Disables price from being displayed in the machine.

Suds Detect Mode Allows machine to respond with special function when suds are sensed
– Horizontal units only.

Debit Only Machine set to operate with Smart Card system only.

Coins Only Machine set to operate with Coin-Drop system only.  Not applicable in
Smart Card systems.

Enhanced Debit This setting must be selected for the Greenwald Intellicard system.

Max Extract
Disabled

Avoids wrinkles if activated, max water extraction if not.

Cycle Based
Pricing

Allows cycles to be priced differently for different temperatures.

Continued on next page
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8.5.1.4. Vertical Washer continued

Prices Tab

Penny Offset This is a preset value by Maytag. If you set your vend value at $.25
on the Washer/Dryer Tab and you select $.03 in the penny offset
field then the vend price is now calculated at $.28 to start the
machine. The penny offset will also change your special pricing and
cycle based pricing by the increment chosen.

Regular Vend Price Price of a regular cycle.

Regular Cold Price Price of a regular cold water cycle.

Regular Warm Price Price of a regular warm water cycle.

Regular Hot Price Price of a regular hot water cycle.

Special Vend Price Represent the number of quarter (coin 2); may adjust from 0-39.

Special Cold Price Price of a special cold water cycle.

Special Warm Price Price of a special warm water cycle.

Special Hot Price Price of a special hot water cycle.

Penny Offset This is a preset value by Maytag. If you set your vend value at $.25
on the Washer/Dryer Tab and you select $.03 in the penny offset
field then the vend price is now calculated at $.28 to start the
machine. The penny offset will also change your special pricing and
cycle based pricing by the increment chosen.

Special Vend Price Price of a normal cycle during a special time period.

Regular Vend Price Price of a regular cycle.

Time Time duration when special pricing is in effect.

Days Days of the week when special pricing is in effect.

Super Cycle/Action Codes Tab

Upgrade Price Cost to upgrade to a Super Cycle (must be enabled in features)

Type Sets super cycle type. 1 for agitation enhanced, 2 for water enhanced,
3 for both.

Set Serial Enables the serial number entered in the Washer/Dryer tab to be
transferred into the machine’s microprocessor.

Set
Location/Position

Enables the Location/Position set on the Washer/Dryer Tab to be set
in the Maytag Microprocessor.

Set Price/Coin
Value

Enables the Price/Coin Values set on the Washer/Dryer tab to be set
in the Maytag Microprocessor.

Set Cycle Length/#
Rinses

Enables the Cycle lengths/and number of rinses set on the
Washer/Dryer tab to be set in the Maytag Microprocessor.

Clear Interval
Counts

Enables the interval counters to be cleared after data collection.

Clear Interval
Counts-CCC

For use with Maytag Accutrac System

Record Used
Already

For use with Maytag Accutrac System
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8 . 5 . 2 .  M a y t a g  G e n 2  R e p o r t s

8.5.2.1. Machine List

Location Location ID of Machine (SMS2 Location ID).

Name Name of machine's location.

Machine Machine ID of Machine.

Model Model Number (if entered).

Position Position in Room (if entered).

Machine Serial Machine's serial Number (if entered).

8.5.2.2. Machine Elapsed Monies

Location Location ID of Machine.

Machine Name of machine's location.

Model Code Model Code (sent from Machine).

Int Cash Cash collected for this interval.

Elp Money Total cash collected since installation.

Collection
Date/Time

Date and time of collection.
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8.5.2.3. Machine Interval Counters

Location Location ID of Machine.

Machine Name of machine's location.

Model Model Code (sent from Machine).

Reg Prc Cycle Number of regular priced cycles.

Spc Prc Cycle Number of special cycles

No Runs Number of cycles where money was taken, but machine did not
run.

Srv Cycles Number of service cycles.

Trouble Cycles Number of trouble cycles.

Power Downs Number of times machine was powered down.

UnAuth Srv Number of unauthorized service door openings.

Auth Srv Number of authorized service door openings.

UnAuth Coin Va Number of unauthorized coin vault openings

Auth Coin Value Number of authorized coin vault openings

Collection
Date/Time

Date and time of collection

8.5.2.4. Machine Elapsed Counters

Location Location ID of Machine.

Machine Name of machine's location.

Model Model Code (sent from Machine).

Reg Prc Cycle Number of regular priced cycles.

Spc Prc Cycle Number of special cycles

No Runs Number of cycles where money was taken, but machine did not
run.

Srv Cycles Number of service cycles.

Trouble Cycles Number of trouble cycles.

Power Downs Number of times machine was powered down.

UnAuth Srv Number of unauthorized service door openings.

Auth Srv Number of authorized service door openings.

UnAuth Coin Va Number of unauthorized coin vault openings

Auth Coin Value Number of authorized coin vault openings

Collection
Date/Time

Date and time of collection
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8.5.2.5. Machine Service

Location Location ID of Machine.

Machine Name of machine's location.

Time Last CV Time of last coin vault opening.

Time Last Trouble Time of last trouble cycle.

Time Last Power
Down

Time of last power failure/shutoff to machine.

Time Last Srv Opns Time of Last service door opening.

Time Prev Srv Opns Time of previous service door opening.

Time Prev CV Time of previous coin vault opening.

Time Prev Trouble Time of previous trouble cycle.

Time Prev Power
Down

Time of previous power down.

Time Last Setup Time of last machine setup, price change, etc.

Collection Date/Time Date and time of collection.
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8.5.2.6. Stack Interval Washer Counters

Location Location ID of machine.

Machine Name of machine's location.

Model Model Code (sent from Machine).

Sud Cyc Number of suds cycles performed.

Suds Rec Cyc Number of suds recovery cycles performed.

Power Off Number of times machine was powered off.

UA Srv Number of unauthorized service door openings.

A Srv Number of authorized service door openings.

UA Coin V Number of unauthorized coin vault openings.

A Coin V Number of authorized coin vault openings.

Reg Prc Cyc Number of regular priced cycles performed.

Spc Prc Cyc Number of special priced cycles performed.

No Runs Number of times where money was taken, but machine did not run.

Serv Cyc Number of service cycles.

Trouble Number of trouble cycles.

Collection
Date/Time

Date and time of collection
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8.5.2.7. Stack Elapsed Washer Counters

Location Location ID of Machine.

Machine Name of machine's location.

Model Model Code (sent from Machine).

Sud Cyc Number of suds cycles performed.

Suds Reg Cyc Number of suds recovery cycles performed.

Power Off Number of times machine was powered off.

UA Srv Number of unauthorized service door openings.

A Srv Number of authorized service door openings.

UA Coin V Number of unauthorized coin vault openings.

A Coin V Number of authorized coin vault openings.

Reg Prc Cyc Number of regular priced cycles performed.

Spc Prc Cyc Number of special priced cycles performed.

No Runs Number of times where money was taken, but machine did not run.

Serv Cyc Number of service cycles.

Trouble Number of trouble cycles.

Collection
Date/Time

Date and time of collection
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8.5.2.8. Stack Interval Dryer Counters

Location Location ID of Machine.

Machine Name of machine's location.

Model Model Code (sent from Machine).

Power Off Number of times machine was powered off.

UA Serv Number of unauthorized service door openings.

A Serv Number of authorized service door openings.

UA Coin V Number of unauthorized coin vault openings.

A Coin V Number of authorized coin vault openings.

Reg Topoff Cyc Number of regular top-off cycles performed.

Spc Topoff Cyc Number of special top-off cycles performed.

Reg Cyc Number of regular priced cycles performed.

Spc Cyc Number of special priced cycles performed.

No Runs Number of times where money was taken, but machine did not run.

Service Number of service cycles.

Trouble Number of trouble cycles.

Collection
Date/Time

Date and time of collection
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8.5.2.9. Stack Elapsed Dryer Counters

Location Location ID of Machine.

Machine Name of machine's location.

Model Model Code (sent from Machine).

Power Off Number of times machine was powered off.

UA Serv Number of unauthorized service door openings.

A Serv Number of authorized service door openings.

UA Coin V Number of unauthorized coin vault openings.

A Coin V Number of authorized coin vault openings.

Reg Topoff Cyc Number of regular top-off cycles performed.

Spc Topoff Cyc Number of special top-off cycles performed.

Reg Cyc Number of regular priced cycles performed.

Spc Cyc Number of special priced cycles performed.

No Runs Number of times where money was taken, but machine did not run.

Service Number of service cycles.

Trouble Number of trouble cycles.

Collection
Date/Time

Date and time of collection
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8.5.2.10. Stack Washer Dryer Service

Location Location ID of machine.

Machine Name of machine's location.

Model Model code (sent by machine).

Last Coin V Time of last coin vault opening.

Last Serv Time of last service door opening.

Last Power Off Time of last machine power off.

Last Setup Time of last machine setup, price change, etc.

Last D Trouble Time of last dryer trouble cycle.

Last W Trouble Time of last washer trouble cycle.

Prev Serv Time of previous service door opening.

Prev Coin V Time of previous coin vault opening,

Prv Power Off Time of previous machine power off.

Prev D Trouble Time of previous dryer trouble cycle.

Prev W Trouble Time of previous washer trouble cycle.

Collection
Date/Time

Date and time of collection
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9.1.1. Overview

A Cash Card Transaction Station (Cash CTS), allows for unattended
smart card purchases or recharge (adding value to an existing card). Three
basic types of Cash CTS’s are currently supported by the SMS2 software:

! Cash CTS with Dispenser

! Add-Value only Cash CTS (without dispenser)

! MiniMate – Low Cost Add-Value Station

While the three Cash CTS types are somewhat different, their basic
operation are similar.

9.1.1.1. Cash CTS Operation
The Cash CTS is typically located in the vicinity of the laundry machines.
The Cash CTS is ruggedly constructed of heavy-duty stainless steel for
optimal security of the stored cash within.

When a customer needs to purchase a new smart card, or add value to an
existing card, cash is inserted into the bill acceptor. When the cash is
accepted, the Cash CTS will ask if the customer wants to add value to an
existing card or purchase a new one (provided that the machine has a
dispenser). If the customer decides to purchase a new card, a message can
appear stating the cost for a new card and the required action for the
customer to proceed. If only adding value, the Cash CTS will prompt the
customer to insert their existing card. At this point, the Cash CTS will
either dispense the new card or add value to the existing card.

During these two different transactions, a record is kept. When cash is
collected, a Data Collection Card is inserted into the Cash CTS. All
information pertaining to the cash collected by the machine and cards
dispensed is transferred to the Data Collection Card. The data can then be
transferred to a PC and viewed by an administrator at a later time.

9.1.1.2. The Setup Process
There are four steps necessary to setup the Cash CTS:

1. Create a Location (see chapter 5).

2. Enter Cash CTS information into the Machine Manager (see
chapter 7).

3. Create a Cash CTS profile (Section 9.2).

9CTS Card Manager
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4. Create a Cash CTS setup card (Section 9.3).

9.2 Cash CTS Profi les

The Cash CTS Profile Manager record is made up of three basic
components (Figure 9.1):

! The CTS Profile List Window displays all the Cash CTS
profiles in the software. The records are sorted by the Profile
Name, Idle Message, and Problem Message.

! The Main Body of the record contains the profile information
specified by the system user.

! Command buttons for the most commonly used features
have been included for ease of use.

Figure 9.1 Cash CTS Profile Record Interface

Profile
Information

Cash CTS
Profile List
Window

Command Buttons
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Table 9.1 describes each field in the Cash CTS Profile Manager and
identifies the field restrictions.

Table 9.1 Cash CTS Profile Manager Fields

Field Name Description Restrictions

Profile Name Required unique field creating an
identity for the profile.

Any alphanumeric
combination up to
30 characters in
length

Idle Message Message displayed on Cash CTS while
not in use.

Up to 20 characters

Problem
Message

Message displayed on Cash CTS when
an error has occurred.

Up to 20 characters

Max Value on
Card

Sets the maximum amount of value that
can be set to the card.

Currency field

Cash CTS
Cutoff Value

Sets the Cash CTS to go into an error
mode once a certain amount of cash has
been collected.

Currency field

Check User
Card
Location

If this option is selected, only users with
correct location ID can add value to
their card.

Check Box

Location
Clustering

Selecting this feature enables location
clustering (See Chapter 5).

Check Box

Manual Data
Collection
Card

Enabling this feature allows for the use
of a manual collection card. A manual
collection card displays collection
information on the Cash CTS display,
but does not transfer that information to
the card.

Check Box

Clear
Counters

Clear counters, when enabled, clears all
collection information after the use of
Manual Collection Card. Use caution
with this feature as all information is
lost once data is displayed on the Cash
CTS screen.

Check Box

Dispenser This will enable or disable the dispenser
in the Cash CTS

Check Box

Display
Deposit
Message

Enabling this feature prompts the Cash
CTS to display cost of card for new
card purchases, and for customer to
accept before proceeding.

Check Box

continued on next page
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Table 9.1 continued

Card Deposit Sets the cost for dispensed cards. Currency field

Charge for
Initial Card
Use

When this option is selected the first
time a User Card with this option
enabled the user will be charged a fee to
offset the cost of the card.

Check Box

Initial Charge Sets the Initial Charge cost for using a
User Card for the first time.

Currency field

Denomination Lists all bill denominations accepted by
bill acceptor.

Software Specified

Accept Allows specifying which bills to accept. Check Box

Awarded Specifies amount of value awarded for
each bill. For example, you can award a
$22 value for a $20 bill to encourage
the use of larger bills.

Currency field
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9 . 2 . 1 .  W ork i n g  w i t h  t he  Cash  CT S  P ro f i l e
M a n ag e r

9.2.1.1. Adding a Profile
1. In the Cash CTS Cards tab, click the Cash CTS Profile button

(Figure 9.2).

Figure 9.2 Opening the Cash CTS Profile Manager

2. Select Add New Profile from the edit drop-down menu (Figure
9.3).

Figure 9.3 Adding a Cash CTS Profile

Click here
to open
Cash CTS
Profile
Manager
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3. Enter data into fields (see table 9.1)

4. Verify that all data has been entered correctly; click the Update
button to save the new profile (Figure 9.4).

Figure 9.4 Saving Additions/Changes to Cash CTS Profile Manager

Click here
to save
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9.2.1.2. Editing a Profile
1. In the Cash CTS Cards tab, click the Cash CTS Profile button (see

Figure 9.2).

2. Click the profile to edit from the Cash CTS Profile List Window
(Figure 9.5).

3. Select Edit Selected Profile from the Edit drop-down menu
(Figure 9.5).

 

Figure 9.5 Editing a Cash CTS Profile

4. Make necessary changes.

5. Verify that the new information is correct, and click the Update
button to save changes (see Figure 9.4).

Tech Tip
Steps 2 and 3 can be avoided by simply double clicking on the profile to be edited from
the Profile List Window.
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9.2.1.3. Deleting a Profile

1. In the Cash CTS Cards tab, click the Cash CTS Profile button (see
Figure 9.2).

2. Click the profile to delete from the Profile List Window (Figure
9.6).

3. Select Delete Selected Profile from the Edit drop-down menu
(Figure 9.6).

 

Figure 9.6 To Delete a Cash CTS Profile

4. A message will appear to verify deletion of selected Profile, click
the Yes button to proceed with deletion of machine or the No
button to cancel (Figure 9.7).

Figure 9.7 Deletion Confirmation

Warning!
A deleted profile cannot be recovered
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9.2.1.4. Cloning a Profile
The cloning feature has been included with SMS2 as a time saving
feature for adding multiple profiles with similar information.

The cloning feature allows the system operator to copy all the information
for an existing profile in the database except for the Profile Name field.
Once a profile is cloned, the operator enters a new Profile Name, and the
new profile information is saved as a new record.

1. In the Cash CTS Cards tab, click the Cash CTS Profile button (see
Figure 9.2).

2. Click the profile to clone from the Profile List Window (Figure
9.8).

3. Select Clone Profile from the Edit drop-down menu (Figure 9.8).

 

Figure 9.8 Cloning a Cash CTS Profile

4. Enter a new Profile Name (Figure 9.9).

5. Click the Update button to save the new profile record (Figure
9.9).
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Figure 9.9 Cloning a Cash CTS Profile

Enter new
Profile
Name

Then click
here to
save new
profile



CHAPTER 9: Cash CTS CARD MANAGER SMART CARD MANAGEMENT SYSTEM 2

215 Rev. B

9.3. Cash CTS Setup Card

Once the location, machine and profile information have been entered, a
setup card can be created.

The card creation is accomplished in the Cash CTS Setup Card window.
This window is comprised of three parts (Figure 9.10):

1. In the select machine ID and Location ID section, you can select
which Cash CTS type and at what location to program (machine
setup is discussed in chapter 7). Additionally, an option to sort by
location is available and may be needed for users who have many
facilities.

2. In the Select Profile section, a list of previously created profiles
appears to choose from.

3. In the last section of the Cash CTS Setup Card Window, the card
programming process is executed.

Figure 9.10 Create Cash CTS Setup Card Window
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9 . 3 . 1 .  C r e a t i ng  a  Cash  CT S  S e tu p  Ca r d

1. In the Cash CTS Card tab, click the Create Setup Card button
(Figure 9.11).

Figure 9.11 Creating Cash CTS Setup Card

2. Select a Machine ID with a corresponding Location ID by
clicking on it. There are two ways to view the machines in the
database (Figure 9.12):

a. Click “Show all Locations” and view the entire list of
machines.

b. Click “Show only Location” and use the drop-down menu
to view only machines from the selected locations

3. Use the “Do Not Change Machine’s Current Machine ID and
Location ID” option to reprogram machine options without
changing its ID. This option allows one card to reprogram many
machines.

4. Click the Select Profile button (Figure 9.12).

Click here to
open card
creation
window
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Figure 9.12 Cash CTS Setup Card Creation Steps

5. Select profile from Profile List Window (Figure 9.13).

6. Review to verify that the profile information is correct, and click
the Select button (Figure 9.13).

Figure 9.13 Selecting a Cash CTS Profile

Choose a
sorting
option

Click to
select
machine

Click to
select
profile

Click
profile to
be used

Click here to
continue
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7. Insert a management smart card into the PC reader (Section 2.4.2),
and click the Create Cash CTS Setup Card button (Figure 9.14).

Figure 9.14 Creating the Cash CTS Setup Card

�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������Note:�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������

If multiple machines are to be setup, enable the “Automatically Move to
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������the Next Machine In List After Creating Card” option. This will�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������automatically go to the next machine on the list and save time. Be sure�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������to use a different management card each time.

Click here to
complete
Cash CTS
Setup Card
creation
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9.4. Reports and Data Collection

There are four reports available for the Cash CTS, they are:

! Cash CTS Dispensed Elapsed Counters

! Cash CTS Dispensed Interval Counters

! Cash CTS Elapsed Card Counters

! Cash CTS Interval Card Counters

Each one of these reports shows either the elapsed total or the interval
amounts of money collected for either dispensed cards or reloaded
(revalued) cards. Each report is prepared with the Location ID, Machine
ID, total cash collected, and an inventory of each bill denomination.

The process for getting the report is as follows:

1. Create a Data Collection Card

2. Collect data from machine

3. Read Data Card

4. View or print the report
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9 . 4 . 1 .  C r e a t i ng  o r  C l ea r i ng  a  Co l l ec t i on  Ca r d

This process is used to create or clear a Data Collection Card. To collect
CTS counter information, a standard data collection card is used. To
collect the Initial Card Charge information in addition to the CTS counter
information, an advanced data collection card is used. .

1. Insert a management card into the PC Reader (Section 2.4.2).

2. In the Cash CTS Card tab, click the Create/Clear Data Card or the
Create/Clear Adv Data Card button (Figure 9.15).

Figure 9.15 Creating a Cash CTS Data Collection Card

9 . 4 . 2 .  Co l l ec t i ng  Da ta  f r o m th e  Cas h  CTS

To collect data from a Cash CTS, insert a data collection card into the
unit’s card reader and remove it when prompted by the Cash CTS.

�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������Note:�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������If “User Transaction” Data Collection is enabled, a service card must be�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������inserted into the Cash CTS. Once the Service Card has been inserted�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������there is one minute to use the Data Collection Card.

Select data
collection card to
create
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9 . 4 . 3 .  Re a d i ng  a  D a t a  C a r d

1. Insert data card with the collection information into the PC reader
(Section 2.4.2).

2. In the Cash CTS Card tab, click the Read Data Card button
(Figure 9.16).

Figure 9.16 Reading a Cash CTS Data Collection Card

3. Select option to show all the Cash CTS data collections on the
card or only ones that have not been saved to the database, then
click the Read CTS Collection Card button (Figure 9.17).

Figure 9.17 Reading the Cash CTS Data Collection Card

Click here

Select viewing
option

Then click here
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4. The Read CTS Data Collection Card window will open and list all
the CTS data collections on the card. Select which records to save.
Select the Save Selected Records from the File drop-down menu
or click the Save and Exit button to save all records (Figure 9.18).

 

Figure 9.18 Saving the Collection Records

5. Double-clicking on a collection record listed in the Read User
Data Collection Card window will open a window containing the
Transaction Information, Machine ID, Location and Collection
Date/Time of that record.

Then
click
here

Select
records
to save

Or here
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9 . 4 . 4 .  V i e w i ng  an d  P r i n t i ng  Rep o r t s

1. Open a desired report in one of two ways (Figure 9.19):

! Click on the button for the desired report in the CTS Cards
Manager.

! Select the desired report from the CTS sub menu of the
Reports drop-down menu in the main window.

 

Figure 9.19 Opening a Cash CTS Report

2. A window specifying a date range will appear (Figure 9.20). Enter
the beginning and ending collection dates for the desired report.
Select the “No upper Bound” option to view a report containing
all transactions since the “Start of range” field value or select the
“No lower Bound” option to view a report containing all
transactions leading up to the “End of range” value.

Figure 9.20 Date Range Window

Two methods
to open a
report
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3. The report will be generated and appear on the screen. You can
either view it on the screen, or click the printer icon to print the
report (Figure 9.21).

 

Figure 9.21 Viewing the Cash CTS Report

Click here to
print report
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9 . 4 . 5 .  Un d e rs t an d i n g  t h e  Cas h  CTS  Re po r t s

The report generated reflects all collected transactions for the date ranges
that were specified.

Tables 9.2 – 9.5 identify and explain each field in the different Cash CTS
Collection Report.

Table 9.2 Cash CTS Dispensed Elapsed Counters Report

Field Name Explanation

Location Location of collection

Machine Collected machine ID

Card Value Elapsed total for dollars sold on dispensed cards
(does not include deposit cost)

Card Cost Elapsed total for dollars collected for card deposit.

Cards Disp Elapsed total for number of cards dispensed.

Bills Elapsed total number of bills collected by machine.

Bill Value Elapsed total value of currency collected by machine.

Ones Elapsed total number of ones collected.

Twos Elapsed total number of twos collected.

Fives Elapsed total number of fives collected.

Tens Elapsed total number of tens collected.

Twenties Elapsed total number of twenties collected.

Collection Date/Time Date and time of collection.
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Table 9.3 Cash CTS Dispensed Interval Counters Report

Field Name Explanation

Location Location of collection

Machine Collected machine ID

Card Value Interval (since last collection) total for dollars sold on
dispensed cards (does not include deposit cost)

Card Cost Interval total for dollars collected for card deposit.

Cards Disp Interval total for number of cards dispensed.

Bills Interval total number of bills collected by machine.

Bill Value Interval total value of currency collected by machine.

Ones Interval total number of ones collected.

Twos Interval total number of twos collected.

Fives Interval total number of fives collected.

Tens Interval total number of tens collected.

Twenties Interval total number of twenties collected.

Collection Date/Time Date and time of collection.
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Table 9.4 Cash CTS Elapsed Card Counters Report

Field Name Explanation

Location Location of collection

Machine Collected machine ID

Card Loaded Elapsed total number of cards revalued by machine.

Bills Elapsed total number of bills collected by machine.

Bill Value Elapsed total value of currency collected by machine.

Ones Elapsed total number of ones collected.

Twos Elapsed total number of twos collected.

Fives Elapsed total number of fives collected.

Tens Elapsed total number of tens collected.

Twenties Elapsed total number of twenties collected.

Collection Date/Time Date and time of collection.

Table 9.5 Cash CTS Interval Card Counters Report

Field Name Explanation

Location Location of collection

Machine Collected machine ID

Card Loaded Interval (since last collection) total number of cards
revalued by machine.

Bills Interval total number of bills collected by machine.

Bill Value Interval total value of currency collected by machine.

Ones Interval total number of ones collected.

Twos Interval total number of twos collected.

Fives Interval total number of fives collected.

Tens Interval total number of tens collected.

Twenties Interval total number of twenties collected.

Collection Date/Time Date and time of collection.
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9 . 4 . 6 .  De l e t i ng  Co l l ec t i o n  Re p o r t s

It is recommended to periodically purge the collection data so that it will
not take up unnecessary disk space on your computer.

1. Click the View/Print/Delete button (Figure 9.22).

Figure 9.22 To Open the Data Collected Window

2. Select the collection records to delete (Figure 9.23).

3. Select Delete Selected Records from the Edit drop-down menu
(Figure 9.23).

Figure 9.23 Deleting the Collection Records

4. A confirmation window will appear. Click the Yes button to
proceed or the No button to cancel.

Click
here

Then
click
here

Select
reports to
delete
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9 . 4 . 7 .  Ma n ua l  Da t a  Co l l ec t i o n

A Manual Data Collection card is used to view the transaction
information on the display of the Cash CTS.

In order for the Manual Data Collection card to function, the “Manual
Data Collection Card” option in the Cash CTS profile must be enabled. If
the “Clear Counters” option has been enabled as well, the data will be
deleted after it is displayed. Otherwise, it can be collected with a Data
Collection card at a later time.

9.4.7.1. Creating a Manual Data Collection Card
1. Insert a Management Card into the PC Reader (Section 2.4.2).

2. Click the Create Manual Card button in the CTS Cards
Manager (Figure 9.24)

Figure 9.24 Creating a Manual Data Collection Card

Warning!
The Manual Data Collection card does not actually collect the data
from the Cash CTS. If the “Clear Counters” option is enabled in the
profile of the Cash CTS from which you are collecting the data will be
lost after it is displayed.

Click
here
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10.1.1. Overview

The Credit Card Transaction Station (Credit CTS) allows for a cash-free
vending enviroment. Instead of using coins for commercial laundry
applications, or cash to purchase smart cards, customers use their major
credit or debit cards to purchase valued smart cards or add value to
existing cards.

This further reduces the cost of handling money and the expense
associated with vandalism, as with this system there is no cash on the
premises.

10.1.1.1. Credit CTS Operation
The Credit CTS is typically located near the laundry area where the
valued cards will be used. Customers simply swipe their credit or debit
cards and select one of three predetermined monetary values to add to
their card. The transaction is approved via a modem, and purchased
amount is then transferred to the smart card.

Programming the Credit CTS and data collection can be accomplished
through a modem connection or a direct serial PC connection.

10.1.1.2. The Setup Process
There are four steps necessary to setup the CTS:

1. Define Locations (see chapter 5).

2. Enter Credit CTS information into the Machine Manager (see
chapter 7).

3. Create a Credit CTS profile (covered in this chapter, Section
10.1.2).

4. Program this information into the Credit (covered in this chapter,
Section 10.1.3).
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 10Credit CTS Manager
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1 0 . 1 .2 .  C r ed i t  CTS  P r o f i l e s

Credit CTS Profiles are entered and edited in the Credit Profile window.

10.1.2.1. Opening the Credit Profile Window
To open the Credit Profile window click the Create Profile button in the
Credit CTS Manager (Figure 10.1).

Figure 10.1 Opening the Credit Profile Window

Credit
CTS
Manager

Click
here
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10.1.2.2. The Credit Profile Window Interface
The Credit CTS Profile Manager record is made up of three basic
components (Figure 10.2):

! The Profile List Window lists all CTS profiles in the
software. The records are sorted by the Profile Name.

! The Main Body of the record contains the profile
information specified by the system user.

! Command Buttons for the most commonly used features
have been included for ease of use.

 

Figure 10.2 Credit CTS Profile Record Interface

Main Body Data

CTS Profile List
Window

Command Buttons
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Table 10.1 describes each field in the Credit CTS Profile Manager, and
identifies field restrictions.

Table 10.1 Credit CTS Profile Manager Fields

Field Name Description Restrictions

Profile Name Required unique field creating an
identity for the profile.

Any alphanumeric
combination up to
30 characters in
length

Idle Message Message displayed on Credit CTS while
not in use.

Up to 20 characters

Error
Message

Message displayed on Credit CTS while
in error mode.

Up to 20 characters

Acquirer
Phone

Number of the clearing house for Credit
CTS to dial for credit card transactions.

To be entered
exactly as dialed.
Use commas for
pausing (example:
9,18605551212)

Card Deposit Sets cost for purchasing new cards. Currency field

Max Value on
User Card

Sets the maximum value a user can
have on their card. Credit CTS will not
allow a transaction to occur if customer
has already reached this limit.

Currency field

Receipt
Header

Three lines of text to be printed on top
of the customer credit card receipt.

Up to 20 characters
on each of the
3lines.

Receipt
Footer

Three lines of text to be printed at the
bottom of the customer credit card
receipt.

Up to 20 characters
on each of the
3lines.

Button
Values

Sets the value for each of the three
buttons located on the Credit CTS.
These are the only values that a
customer can purchase.

Currency fields
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10.1.2.3. Adding a Profile
1. In the Credit CTS tab, click the Create Profile button (Figure

10.3).

 

Figure 10.3 Opening the Credit CTS Profile Window

2. Select Add New Profile from the edit drop-down menu (Figure
10.4).

Figure 10.4 Adding CTS Profile

3. Enter data into fields (see Table 10.1)

4. Verify that all data has been entered correctly; click the Update
button to save the new profile (Figure 10.5).

Click here to
open Credit
CTS Profile
Window
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Figure 10.5 Completing/Saving the Credit CTS Profile

Click here
to save
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10.1.2.4. Editing a Profile
1. In the Credit CTS tab, click the Create Profile button (Figure

10.3).

2. Click on the profile to edit in the Profile List Window (Figure
10.6).

3. Select Edit Selected Profile from the Edit drop-down menu
(Figure 10.6).

  

Figure 10.6 Editing a Credit CTS Profile

4. Make any necessary changes.

5. Verify that the new information is correct, and click the Update
button to save changes (Figure 10.5).

Tech Tip
Steps 2 and 3 can be avoided by simply double clicking on the profile to be edited from
the Profile List Window.

Select
Profile to
Edit
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10.1.2.5. Deleting a Profile

1. In the Credit CTS tab, click the Create Profile button (Figure
10.3).

2. Click the profile to delete from the Profile List Window (Figure
10.7).

3. Select Delete Selected Profile from the Edit drop-down menu
(Figure 10.7).

 

Figure 10.7 Deleting a Credit CTS Profile

Warning!
A deleted profile cannot be recovered. Be sure that the profile being
deleted will not be needed anymore as it may affect machine setup.

Select
Profile to
Delete
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10.1.2.6. Cloning a Profile
The cloning feature has been included with SMS2 as a time saving
feature for adding multiple profiles with similar information.

The cloning feature allows the system operator to copy all of the
information for an existing profile in the database except for the Profile
Name field. Once a profile is cloned, the operator enters a new Profile
Name, and the profile information is saved as a new record.

1. In the Credit CTS tab, click the Create Profile button (Figure
10.3).

2. Click the profile to clone from the Profile List Window (Figure
10.8).

3. Select Clone Profile from the Edit drop-down menu (Figure 10.8).

 

Figure 10.8 Cloning a Credit CTS Profile

4. Enter a new Profile Name (Figure 10.9).

5. Click the Update button to save the new profile record (Figure
10.9).

Select
Profile to
Clone
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Figure 10.9 Completing the Cloning Process

Enter new
Profile name

Click here to
save new profile
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1 0 . 1 .3 .  S e t t i ng  Up  an d  Co l l ec t i n g  t he  C re d i t
C T S

Once the location, machine and profile information have been entered,
the Credit CTS can be set up and collected.

To setup or collect data from the Credit CTS:

1. Define the Credit Setup.

2. Connect to the Credit CTS via a modem or direct serial
connection.
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10.1.3.1. Creating or Editing the Credit Setup
1. Click the Credit Setup button in the Credit CTS tab (Figure

10.10).

 

Figure 10.10 Opening the Credit Setup Window

2. Select a machine from the drop-down menu to setup or edit
(Figure 10.11).

3. Enter the dial up phone number of the Credit CTS exactly as it is
to be dialed (Figure 10.11).

4. Enter the Terminal ID (this number is assigned by the credit
transaction clearing house being used) (Figure 10.11).

5. Enter the current password. If this is the first time the machine is
being programmed enter ten zeros for the password (0000000000)
(Figure 10.11).

6. Enter a new password if changing the password. If the password is
not being changed, enter the password in Step 5 for verification
(Figure 10.11).

7. Select a profile from the drop-down menu to be used for this
machine (Figure 10.11).

8. Click on the Machine Active option to enable machine (Figure
10.11).

9. Click on the Dispenser Active option if machine model is
equipped with a dispenser (Figure 10.11).

10. Click the update button to save the new information (Figure
10.11).

Click here to
open Credit
Setup Window
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Figure 10.11 The Credit Setup Steps

Step 2
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Step 10
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10.1.3.2. Downloading/Uploading Credit CTS Information
1. Click the Connect to Machine button in the Credit CTS tab

(Figure 10.12).

Figure 10.12 Connecting to the Machine

2. Select method of connecting to the Credit CTS (Figure 10.13):

! If using the “Modem” option, select the assigned COM
Port (communications port) for your modem (refer to your
PC/Windows documentation) and select the “Wait for Dial
Tone” option if necessary with your telephone system.

! If using the “Direct” option (direct connection), select the
COM Port used for your serial connection (refer to your
PC/Windows documentation) and connect serial port to
Credit CTS using a serial cable.

3. Select the Machine to program (Figure 10.13).

Click here
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4. Select those functions to activate during the connection (Figure
10.13).

! “Send Setup” will send Location, Machine, and Credit CTS
Profile information.

! “Send Receipt Header/Footer” will send any updated receipt
information only.

! “Send Modem Initialization String” is used the first time the
Credit CTS is set up to initialize the modem in the Credit CTS
(refer to Credit CTS documentation).

! “Get Counters/Transactions” downloads transaction data from
the Credit CTS to be used for report generation.

! “Clear Counters/Transactions After Collection” is used to
clear interval counters after collection.

5. Click the Start button (Figure 10.13).

Figure 10.13 Connecting to the Credit CTS

Select a
connection
method

Select a
machine
to program

Select
tasks

Then click
here
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1 0 . 1 . 4 .  C r e d i t  C TS  R e p o r t s

There are four reports available from the Credit CTS Manager:

1. The Credit Elapsed Counter report shows the overall totals for
credit card transactions.

2. The Credit Interval Counter report shows the interval (the
totals for each collection period) for credit card transactions.

3. The Debit Elapsed Counter report shows the overall totals for
debit card transactions.

4. The Debit Interval Counter report shows the interval (the
totals for each collection period) for debit card transactions.

Each report provides the following information:

! Location – location where the transaction took place.

! Machine – machine identification.

! Card Value – total monetary value for recharged Cash
Cards.

! Dispensed Card Value – total monetary value for
dispensed Cash Cards.

! Card Dispensed – number of cards that were dispensed.

! Card Cost – portion of the money that went towards the
card cost rather than the value added to Cash Cards.

! Cards Loaded – number of cards that were recharged.

! Collection Date/Time – date and time of the collection.
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10.1.4.1. Viewing and Printing Credit CTS Reports

1. Open a desired report in one of two ways:

! Click on the desired report button in the Credit CTS Manager.

! Select the desired report from the Credit CTS sub menu of the
Reports drop-down menu in the main window.

Figure 10.14 Opening a Credit CTS Report

2. A window specifying a date range will appear (Figure 10.15).
Enter the beginning and ending collection dates for the desired
report. Select the “No upper Bound” option to view a report
containing all transactions since the “Start of range” field value or
select the “No lower Bound” option to view a report containing all
transactions leading up to the “End of range” value.

Two methods
to initiate a
report
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Figure 10.15 Date Range Window

3. The report will be generated and appear on your screen. View it
on the screen, or click the printer icon to print the report (Figure
10.16).

Figure 10.16 Credit CTS Report Window

Click here to
print report
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O ve r v i e w

Along with SMS2, the Greenwald Intellicard Door Access Readers are used to
control door entry.

The Door Access Readers are installed in the vicinity of the entry point and are
integrated with a low voltage electric locking device such as an electric strike or
magnetic lock (refer to the Door Access Reader documentation for further
details). Once the installation is complete, the reader setup information is entered
into the Door Access Manager and Setup Cards are created and used to program
the Door Access Readers.

Users of the Door Access Readers may be issued Door Access or User Cards that
define the specific location or areas within a location to which access will be
granted. In other cases, users may use their existing cards to access entry points
within a location.

Once the Door Access system is up and running access privileges can be changed
at any time by either issuing the user a new card or by updating the list of valid
users at the Door Access Reader.

The Door Access Manager also has the ability to create Data Collection cards for
the Door Access Reader. Once the data is collected, user access reports can be
viewed or printed.

11DOOR ACCESS MANAGER
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11.1. The Setup Process

Before entering data into the Door Access Manager it is important to
understand how it works. After understanding the multiple ways to
restrict and grant access, a strategy for setting up a facility can be
formulated.

1 1 . 1 . 1 .  U n d e r s t a n d i n g  D o o r  A c c e s s  R e s t r i c t i o n s

The Door Access Manager uses several criteria for restricting access:

11.1.1.1. Locations
Each user entered into the database is assigned to a specific location. A
Door Access Reader will only permit access to individuals with a Door
Access or User Card programmed with the same location identification as
the reader. The only exception is a Master Card, which can access any
location managed by the SMS2 software from which it was issued.

11.1.1.2. Areas
Areas allow further access restriction within a location. Each Location
can be set up with as many as eight areas. When a Door Access or User
Card is created the system administrator selects the areas to which the
user will have access. Door Access Readers are assigned to an Area and
will only permit access to those users allowed to enter the specified Area.
An area can include one or more readers, which is useful when more than
eight entry points are being managed in one location.

11.1.1.3. Time Restrictions
Each Door Access Reader can be programmed to restrict access at certain
times of the day on specified days of the week. When a User Card is
created the system administrator can select whether or not to have time
restrictions apply.

11.1.1.4. Active/Inactive Access
A user’s access privileges can be suspended at any time. This can be
accomplished without their knowledge or permission and requires
reprogramming of all the readers to which the user had access with a
Reader User List Card.
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1 1 . 1 .2 .  Ch oos i ng  a  Do o r  Acce ss  S ys t em

There are two ways to set up Door Access Readers:

11.1.2.1. Standard Door Access System
In the standard system, Locations (Section 11.1.1.1) is the only criterion
used for access restriction. Users with any valid Cash Card, Door Access
Card or User Card will have access to the reader if the location
identification on the card is the same as that programmed to the reader.

This system is easy to manage because updating the reader every time
users’ restrictions are altered or new users are assigned to the software is
unnecessary. In this system time restrictions, access reports and the
ability to eliminate a single user’s access are not available.

This system is ideal for simple applications such as allowing all the
tenants and employees of an apartment building access to a laundry room
at any time.

11.1.2.2. Advanced Door Access System
To benefit from the multiple restriction criteria described in section
11.1.1 the Advanced Door Access System needs to be implemented. In
this system each user must be entered into the system with their access
privileges or restrictions defined before a Door Access or User Card is
issued to them.

This system is ideal for providing flexible control over door access.
However when using this system, whenever there is a change to the Door
Access Manager database, all Door Access Readers which will be
affected by the change will have to be reprogrammed
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1 1 . 1 . 3 .  S t a n d a r d  S ys t e m S e t u p  S t e p s

The following is the order of setting up the User Cards and Door Access
Readers when choosing to utilize the Standard Door Access System:

11.1.3.1. Step One: Add or Edit Location
In the Door Access Location List window  (Figure 11.1) new locations
can be added and their areas defined. Locations that were set up
previously can be edited to include Areas.

Figure 11.1 Door Access Location List Window
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11.1.3.2. Step Two (Optional): Add or Edit User Profiles
In the Standard Door Access System any valid Cash Card, Door Access
Card or User Card with a location that corresponds to the Door Access
Reader will work. Therefore it is not necessary to issue Door Access
Cards if other card types are being used. If a card needs to be issued, the
Door Access Profile window (Figure 11.2) can be utilized to accomplish
this. It is important to remember that in this system access records are not
tracked even if the user has been entered into the database.

Figure 11.2 Door Access User Profile Window

11.1.3.3. Step Three (Optional): Create User Cards
If User Profiles are being used (See Step Two), User Cards are created in
the Door Access User Card Manager (Figure 11.3).

Figure 11.3 Door Access User Card Manager
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11.1.3.4. Step Four: Create Reader Setup Card
The Reader Setup window (Figure 11.4) creates the setup card to program
the Door Access Reader. In this step a location identification to be
associated with the reader is assigned.

Figure 11.4 Reader Setup Window
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1 1 . 1 .4 .  A d va nc ed  S ys t e m Se t up  S te ps

The following is the order of setting up the Door Access User Cards and
the Door Access Readers when choosing to utilize the Advanced Door
Access System:

11.1.4.1. Step One: Add or Edit Location
In the Door Access Location List window (Figure 11.5) new locations
can be added and their Areas defined. Locations that were previously set
up can be edited to include Areas.

Figure 11.5 Door Access Location List Window
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11.1.4.2. Step Two: Add or Edit User Profiles
In the Door Access User Profile window (Figure 11.6) each user’s
information is entered. In addition to the user contact information such as
name, address and telephone number the following access privilege
information is entered:

! Location to be associated with the user.

! Area or areas accessible to the user.

! Optional user time restrictions.

! Active or Inactive Access status of user.

! Master Card Privileges

! Access expiration date

! Initial Charge User Option (See Chapter 9)

 Figure 11.6 Door Access User Profile Window
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11.1.4.3. Step Three: Create User Cards
The Door Access User Card Manager (Figure 11.7) is used to set up user
account information and door access information. It is also used to create
and read Door Access and User Cards.

Figure 11.7 Door Access User Card Manager

11.1.4.4. Step Four: Create Reader Setup Card
In the Reader Setup window (Figure 11.8) the setup card to program the
Door Access Reader is created. In this step you will assign both location
identification and an area number.

Figure 11.8 Reader Setup Window
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11.1.4.5. Step Five: Create User List Card
The User List Card transfers all of the valid users assigned to a Door
Access Reader. This card is not only used during the initial setup process,
but also to update the Door Access Reader any time a change is made to
the database (Figure 11.9).

Figure 11.9 Reader User List Setup Window

11.1.4.6. Step Six: Create Reader Time Card
In the Time Card window (Figure 11.10) a card to set the time in the
Door Access Reader is created. This is an important step if access reports
will be viewed at a later time or if using time restrictions.

Figure 11.10 Time Card Window
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11.1.4.7. Step Seven (Optional):  Create Reader Restriction
Card
In the Door Access Restriction Time window (Figure 11.11) access can
be further restricted to specified users using the time of day and days of
the week.

Figure 11.11 Door Access Restriction Time Window
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1 1 . 1 . 5 .  W ork i n g  w i t h  L oc a t i o n s

Locations are the fundamental building blocks of the SMS2 database and
the primary restriction criterion in Door Access. New locations can be
created in the Door Access Location List window and existing locations
can be edited to include additional information needed for the Door
Access Manager.

11.1.5.1. Opening the Door Access Locations List Window
To open the Door Access Locations List Window click the Add/Edit
Location button in the Door Access Manager (Figure 11.12).

Figure 11.12 Opening the Door Access Locations List Window
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�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������When setting up the database to run a “Standard System” it is not�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������necessary to add any additional information to existing locations.

Door
Access
Manager

Click
here
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11.1.5.2. The Door Access Locations List Window Interface
The Door Access Locations List Window consists of three basic
components (Figure 11.13).

1. The Location List Window lists all the Locations entered into the
software. The Location ID, Location Name, Contact and the City
of the Location are listed for easy identification and sorting.

2. The Main Body of the window contains the Location information:
Location ID, Location Name, Area Identifiers, as well as address
and contact information.

3. Command buttons for the most commonly used features have
been included for ease of use.

Figure 11.13 Door Access Location List Interface
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Location
Information
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Table 11.1 describes each field in the Door Access Location List window
and identifies the field restriction.

Table 11.1 Door Access Location List Fields

Field Name Description Restrictions

Location ID Required unique field containing an
identity for the location. This
identification is used for door entry
restrictions, in reports, machine setup
cards and all other functions utilizing
Locations.

Any alphanumeric
combination up to
ten characters in
length

Location
Name

Name of Location Up to 32 characters

Address1 Address of Location Up to 32 characters

Address2 Address of Location Up to 32 characters

City City of Location Up to 16 characters

State/Prov State or Province of Location Up to 16 characters

Zip Postal code of Location Up to 16 characters

Contact Name of contact at Location Up to 32 characters

Phone Phone number for Location Up to 16 characters

Fax Fax number for Location Up to 16 characters

Area 1 –
Area 8

A secondary criteria for access restriction.
When using the Advanced Setup each
user is assigned to any number of areas
within a location and each Door Access
Reader is assigned to an Area. You can
have up to eight Areas at each Location.

Any alphanumeric
combination up to
ten characters in
length
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11.1.5.3. Adding a Location
1. In the Door Access Location List window select Add New

Location from the Edit drop-down menu (Figure 11.14).

2. Enter data into the appropriate fields (Table 11.1).

3. Verify that the data entered is accurate and click the Update
button to save (Figure 11.14).

Figure 11.14 Adding a Location

Click here to
save

Click here to
add a
location
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11.1.5.4. Editing a Location
1. In the Door Access Location List Window select the location to

edit from the Locations List Window (Figure 11.15).

2. Select Edit Selected Location from the Edit drop-down menu
(Figure 11.15).

  

Figure 11.15 Editing a Location

3. Enter the necessary changes or additions such as the Area
identification fields.

4. Verify that the new information is accurate and click the Update
button to save your changes (Figure 11.16).

Tech Tip
The first two steps can be avoided by simply double clicking on the location to be edited
from the Locations List Window.
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Figure 11.16 Updating an Edited Location

Click here
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11.1.5.5. Deleting a Location

1. In the Door Access Location List window click the location you
wish to delete from the Locations List Window (Figure 11.17).

2. Select Delete Selected Location from the Edit drop-down menu
(Figure 11.17).

3. A confirmation window will appear, click Yes to continue or No
to cancel.

 

Figure 11.17 Deleting a Location

Warning!
A deleted Location cannot be recovered.
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11.1.5.6. Cloning a Location
The cloning feature has been included with SMS2 as a timesaving feature
for adding multiple Locations with similar information.

When cloning, a new Location is created with all the information being
identical except for the Location ID.

To clone a Location, follow theses steps:

1. In the Door Access Location List window click the location to
clone from the Locations List Window (Figure 11.18).

2. Select Clone Location from the Edit drop-down menu (Figure
11.18).

 
Figure 11.18 Cloning a Location

3. Enter a new Location ID and make any other changes.

4. Click the Update button to save the new Location (Figure 11.19).
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Figure 11.19 Completing the Cloning Process
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ID
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1 1 . 1 .6 .  W ork i n g  w i t h  Us e r  P ro f i l e s

In this part of the database, specific user information is entered into the
software. In addition to the user’s personal information their access
privileges and restrictions are determined in the Door Access User Profile
window.

11.1.6.1. Restricting Access in the User Profile
The User Profile includes numerous ways to restrict access to individual
users:

Active Access – When using the Advanced System this option must be
enabled for a user to have any access privileges. This option can also be
used to temporarily suspend a user’s access privileges.

Master Card – When this option is enabled, the user will have access to
all Door Access Readers in all the locations programmed by SMS2.

Location ID - Whether using the Basic System or Advanced System in
setting up your Door Access System, Locations are the primary criteria
for restricting users’ access. Unless the Master Card option is enabled, a
user will only be able to access doors programmed with the same
Location ID as their own profile.

Areas – When using the Advanced System a reader is set up with a
specific area (areas are defined in the Door Access Locations List). When
entering a user into the system, select which of the eight available Areas
in each Location a user will be allowed access.

Valid Through – In these two fields enter a start and end date for a
period during which the user’s card will be valid. This allows for an
expiration date on a Door Access or User Card.

No Time Restriction – The Greenwald Intellicard Door Access System
allows for restricting access to individual readers according to the time of

�������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�������������������������������������������������������������������������������������������������������������������������������������������������������������������������Note:�������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�������������������������������������������������������������������������������������������������������������������������������������������������������������������������
When making any changes to a user’s restrictions each Door Access

�������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�������������������������������������������������������������������������������������������������������������������������������������������������������������������������Reader that will be affected by this change must be reprogrammed with�������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�������������������������������������������������������������������������������������������������������������������������������������������������������������������������a Reader User List Card (Section 11.1.9).
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day and day of week. By selecting this option the user’s access will not be
affected by these time restrictions.



CHAPTER 11: DOOR ACCESS MANAGER SMART CARD MANAGEMENT SYSTEM 2

271 Rev. B

11.1.6.2. Opening the Door Access User Profile Window
To Open the Door Access User Profile window click the Add/Edit User
Profile in the Door Access Manager (Figure 11.20)

Figure 11.20 Opening the Door Access User Profile Window

Door
Access
Manager

Click
here
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11.1.6.3. The Door Access User Profile Window Interface
The Door Access User Profile window consists of three basic components
(Figure 11.21):

1. The User Profile List Window lists all of the Users entered into
the software (this includes those users entered in the User
Manager, Utility Cards Manager or the Login Controls Manager).
The name, address and Location information are listed for easy
identification and sorting.

2. The main body of the window contains the User Information.

3. Command Buttons for the most commonly used features have
been included for ease of use.

Figure 11.21 The Door Access User Profile Window Interface
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Table 11.2 describes each field in the Door Access User Profile window
and identifies field restrictions:

Table 11.2 User Manager Fields

Field Name Description Restrictions

Last Name Last name of user Up to 32 characters

First Name First name of user Up to 32 characters

Address 1 Address of user Up to 32 characters

Address2 Address of user Up to 32 characters

Apartment Apartment number of user Up to 16 characters

Building Building number of user Up to 16 characters

City City of user Up to 32 characters

State/Prov State or Province of user Up to 16 characters

Zip Postal code of user Up to 16 characters

Phone Phone number for user Up to 16 characters

Fax Fax number for user Up to 16 characters

Email Email address of user Up to 30 characters

Number of
Adults

Number of adults living in apartment No restrictions

Number of
Children

Number of children living in apartment No restrictions

Rank The order of payment types this customer
prefers to use to reconcile his or her account
(Example: Cash then Credit Card then Debit
Card).

Drop down selection

Tracking ID A feature of the User Card Manager,
selecting a Tracking ID that corresponds to
a card will save time in issuing cards (See
User Card Manager, Chapter 6)

Drop down selection

Account # Assigns a unique identity to the user Required
alphanumeric field up
to 10 characters in
length

Location ID Assigns user to a location existing in the
Locations Manager

Required field, Drop
down selection

Valid
Through

Defines the time period the card will be
valid.

Two time/date fields.
Format:
MO/DY/YEAR HR:
MN.

continued on next page
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Table 11.2 continued

Initial Charge Enabling this option will prompt the Cash
Card Transaction Machine to charge the
user an initial fee typically to offset the cost
of the card (Section 9.2).

Check Box

No Time
Restriction

Gives the user the ability to use Door
Access Readers even during predefined
restricted times (see section 11.1.11)

Check Box

Assigned
Card Serial #

Displays card serial number once a card has
been assigned to the user

Software defined

Active Access This option enables in a user to have access
to specified Locations and Areas.

Check Box

Master Card Enabling this option allows user access to
all Door Access Readers programmed by
your SMS2 package.

Check Box

Area 1 –

Area 8

Selects which Areas (Predefined in the
Door Access Location List window section
11.1.5) the user will be granted access to.

Check boxes
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11.1.6.4. Adding a User
1. In the Door Access User Profile window click the Add New User

button or select Add New User from the Edit drop-down menu
(Figure 11.22).

2. Enter the information for the User (Table 11.2).

3. After verifying that all user information and access privileges
have been entered correctly, click the Update button (Figure
11.22).

Figure 11.22 Adding a User

Tech Tip
When entering users in their respective locations, click the Load Address button to
automatically load the address information for that location.

To Add
User

Click
Update
when
finished
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11.1.6.5. Editing a User
1. In the Door Access User Profile window click the user to edit

from the Users List Window (Figure 11.23).

2. Select Edit Selected User from the Edit drop-down menu.

3. Make any necessary changes.

4. Verify that the new information is accurate, and click the
Update button to save changes.

   

Figure 11.23 Editing a User

Tech Tip
Steps 1 and 2 can be avoided by simply double clicking on the user to be edited from
the Users List Window.
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11.1.6.6. Deleting a User

1. In the Door Access User Profile window click the User to
delete from the Users List Window (Figure 11.24).

2. Select Delete Selected User from the Edit drop-down menu
(Figure 11.24).

3. A window will appear to verify deletion of the selected user,
click the Yes button to proceed with the deletion. Click the No
button to cancel this operation.

  

Figure 11.24 Deleting a User

Warning!
When deleting a User, the database retains the user information for
report generation only. A deleted user cannot be recovered.
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11.1.6.7. Cloning a User
The cloning feature has been included with SMS2 as a time saving
feature for adding multiple users with similar information, such as tenants
from the same apartment but with separate accounts or access restrictions.

The cloning feature allows the system administrator to copy all the
information for an existing user except for the Account Number, and
name fields.

To clone a user, follow these steps:

1. In the Door Access User Profile window click the user to
clone from the Users List Window  (Figure 11.25).

2. Select Clone User from the Edit drop-down menu (Figure
11.25).

3. Enter the new user’s name and a new unique account number.

4. Make any additional changes to the new user’s record.

5. Click the Update button to save the information for the new
user to the database.

 

Figure 11.25 Cloning a User



CHAPTER 11: DOOR ACCESS MANAGER SMART CARD MANAGEMENT SYSTEM 2

279 Rev. B

11.1.6.8. Resetting a User Card Serial Number

If a new card needs to be issued to a user after one has already been
issued, the card serial number that is tracked in the User Profile needs to
be reset first.

To do so follow these steps:

1. In the Door Access User Profile Window select the user for whom
the card serial number is to be reset (Figure 11.26).

2. Click the Edit button.

3. Select Reset Card Serial Number from the Edit drop-down menu
(Figure 11.26).

4. A warning window will appear, click Yes to continue or No to
cancel.

5. Click the Update button.

 

Figure 11.26 Resetting a User Card Serial Number

Warning!
By resetting the serial number of a user, you will lose the link between
the user and the card already created for that person.
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1 1 . 1 .7 .  C r ea t i n g  Use r  Ca r ds

Once the database has been setup and the Door Access Readers have been
programmed, User Cards can be created and issued to users.

User Cards can be issued either one at a time or to an entire building or
location.

11.1.7.1. Creating a Single User Card
1. Click the Create User Card button in the Door Access Manager

(Figure 11.27).

Figure 11.27 Opening the Door Access User Card Manager

2. Select the user’s location from the Card Location selection (Figure
11.28).

3. If this card is being created for a new user, select the “Load only
new users for this location” sorting option to limit the number of
users to be listed (Figure 11.28).

4. Select the User Account Number or name from the appropriate
drop down selection (Figure 11.28).

Tech Tip
When managing a large number of users, first select the user’s building, apartment or
telephone number to narrow the number of users that will appear in the Account
Number or Name field.

Click here to
open the User
Card Manager
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5. Enable the “Create User Card” option by clicking on the
appropriate box if the card will be used for laundry vending
applications (Figure 11.28).

6. Insert the user card into the PC Reader (Section 2.4.2).

7. Click the Create Card button (Figure 11.28).

Figure 11.28 Creating a single User Card

8. A window showing the card creation progress will appear. When
the window closes, the card has been created (Figure 11.29).

Figure 11.29 Card Creation Progress Window
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5. Select
User
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User Card
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create
card
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11.1.7.2. Creating Multiple User Cards
SMS2 allows for creation of multiple user cards by location or specific
buildings in a location. This option can be used to create cards for all
users in a selected location/building or for new users only (those who
have not had a user card issued to them).

To create multiple user cards, follow these steps:

1. Click the Create User Card button in the Door Access Manager
(Figure 11.27).

2. Select the users’ location from the User Location selection (Figure
11.30).

3. If cards are being created only for new users, select the “Load
only new users for this location” option (Figure 11.30).

4. If cards are being created only for a specific building for this
location, select the building from the Building drop-down
selection (Figure 11.30).

5. Enable the “User Card” option by clicking on it if the cards are
also going to be used for laundry vending applications (Figure
11.30).

6. Enable the “Auto Move to Next” option (Figure 11.30).

7. Insert a blank user card into the PC Reader (Section 2.4.2).

8. Click the Create Card button and repeat process (Figure 11.30).

Figure 11.30 Multiple User Cards Creation
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9. A window showing the card creation progress will appear. When
it has closed, the card has been created (Figure 11.29).

10. The software will automatically move to the next user in that
location/building. Insert a new card and click the Create Card
button again and continue this process for creating the desired
number of user cards.
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1 1 . 1 . 8 .  D o o r  A c c e s s  R e a d e r  S e t u p  C a r d

Door Access Reader Setup Cards are created from Profiles that are
managed in the Reader Setup window. Once a profile is entered for a
Door Access Reader, a setup card can be created to program it.

When using the Standard Door Access System, the reader can then be
programmed with this card. When using the Advanced Door Access
System, the User List (Section 11.1.9), Reader Time (Section 11.1.10)
and Reader Restriction (Section 11.1.11) cards will be needed during the
programming process.

11.1.8.1. Opening the Reader Setup Window
To open the Reader Setup window click the Create Reader Setup Card
button in the Door Access Manager (Figure 11.31).

Figure 11.31 Opening the Reader Setup Window
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11.1.8.2. The Reader Setup Window Interface
The Reader Setup window consists of three basic components (Figure
11.32):

1. The Reader Setup Profile Window lists all the Profiles
entered into the software.

2. The Reader Setup Information of the window contains the
reader setup information.

3. Command Buttons for the most commonly used features and
Card Function buttons have been included for ease of use.

Figure 11.32 Reader Setup Window Interface
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Profile Window

Command
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Table 11.3 describes each field in the Reader Setup window and identifies
field restrictions.

Table 11.3 Reader Setup Window Fields

Field Name Description Restrictions

Profile
Name

Required unique field assigning an
identity to the profile.

Any alphanumeric
combination up to
30 characters in
length

Location
Number

Associates one of the existing locations
with the reader.

Drop Down
Selection

Relay Delay  This determines how long the door will
stay unlocked each time a valid card is
accepted. The range is 0-9 seconds.

Drop Down
Selection

Reader ID Required unique field assigning an
identity to the reader that will be
programmed with the profile.

Any alphanumeric
combination up to
ten characters in
length

Advanced
or Standard
System

Selecting one or the other of these options
determines whether the Door Access
Reader will operate in Standard or
Advanced mode (see section 11.1.2).

Check Boxes

Accept Old
Card
Versions

If this option is enabled the Door Access
Reader programmed from this version of
software will accept cards from previous
versions of SMS2 which do not include
an expiration date or time restriction
override. If this option is not enabled, the
users’ old cards will not work and new
cards will have to be issued.

Check Box

Area 1 –
Area 8

Associates one of the existing Areas in
the selected Location with the reader.

Check Boxes
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11.1.8.3. Adding a Reader Setup Profile
1. In the Reader Setup window select Add New Profile from the

Edit drop-down menu (Figure 11.33).

2. Enter the data into the appropriate fields.

3. Verify that the data that was entered is accurate and click the
Update button to save.

Figure 11.33 Adding a Reader Setup Profile

Click here
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11.1.8.4. Editing a Reader Setup Profile
1. In the Reader Setup window select the profile to edit from the

Profile List Window (Figure 11.34).

2. Select Edit Profile from the Edit drop-down menu (Figure
11.34).

 

Figure 11.34 Editing a Reader Setup Profile

3.   Enter the necessary changes.

4 Verify that the new information is accurate and click the
Update button to save the changes (Figure 11.35).

Figure 11.35 Saving the Reader Setup Profile Changes

Tech Tip
Steps 1 and 2 can be bypassed by double clicking on the profile to be edited from the
Profile List Window.

Click
here
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11.1.8.5. Deleting a Single Reader Setup Profile

1. In the Reader Setup Profile window click the profile to delete
from the Profile List Window (Figure 11.36).

2. Select Delete Selected Profile from the Edit drop-down menu
(Figure 11.36).

3. A Confirmation window will appear, click Yes to continue or No
to cancel.

  

Figure 11.36 Deleting a Single Reader Setup Profile

Warning!
A deleted reader setup profile cannot be recovered.
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11.1.8.6. Deleting All Existing Reader Setup Profiles

1. In the Reader Setup window select Delete All Profiles from the
Edit drop-down menu (Figure 11.37).

2. A Confirmation window will appear, click Yes to continue or No
to cancel.

Figure 11.37 Deleting All the Reader Setup Profiles

Warning!
Deleted reader setup profiles cannot be recovered
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11.1.8.7. To Clone a Reader Setup Profile
The cloning feature has been included with SMS2 as a time saving
feature for adding multiple Locations with similar information.

When cloning, a new Reader Setup Profile is created with all the
information being identical except for Profile Name and Reader ID.

To clone a Reader Setup Profile, follow these steps:

1. In the Reader Setup window click the profile to clone from the
Profile List Window (Figure 11.38).

2. Select Clone Selected Profile from the Edit drop-down menu
(Figure 11.38).

 

Figure 11.38 Cloning a Reader Setup Profile

1.   Enter a new Profile Name and Reader ID and make any
changes.

3. Click the Update button to save the new Reader Setup Profile
(Figure 11.39).

Figure 11.39 Completing the Cloning Process

Click
here
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11.1.8.8. Creating a Reader Setup Card
Once a profile has been entered for a reader, follow theses steps to create
a setup card for it:

1. Insert a management card into the PC Card Reader (See
section 2.4.1 and 2.4.2).

2. In the Reader Setup window select the profile from the Profile
List Window to be used for the setup card (Figure 11.40).

3. Click the Create Card button (Figure 11.40).

Figure 11.40 Creating a Door Access Reader Setup Card
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11.1.8.9. Reading an Existing Door Access Setup Card
1. Insert the Door Access Setup Card into the PC Reader (See

Section 2.4.2).

2. In the Reader Setup window click the Read Card button
(Figure 11.41).

3. The card information will be displayed in the main body of the
window (Figure 11.41).

Figure 11.41 Reading an Existing Reader Setup Card
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1 1 . 1 .9 .  Re ad e r  Us e r  L i s t  Ca rd

The Reader User List Card transfers the list of users with their access
status to a particular Door Access Reader. This card must be used during
the initial setup of a Door Access Reader and any time changes are made
to the database that will affect a reader.

To create a User List Card:

1. In the Door Access Manager click the Create Reader User List
Card button (Figure 11.42).

Figure 11.42 To Create a Reader User List Card

2. Select the Location of the reader from the Location drop-down
menu (Figure 11.43).

3. Select the reader’s Area (Figure 11.43).

4. Insert a 8k Management Card into the PC Card Reader
(Section 2.4.2).

Click
here
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5. Click the Create User List Card button (Figure 11.43).

Figure 11.43 Creating a Reader User List Setup Card

�������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�������������������������������������������������������������������������������������������������������������������������������������������������������������������������Note:�������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�������������������������������������������������������������������������������������������������������������������������������������������������������������������������Users who will be allowed entry will be displayed in the window as the�������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�������������������������������������������������������������������������������������������������������������������������������������������������������������������������card is being created.
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1 1 . 1 . 1 0 .  R ea d e r  T i m e  Ca rds

In the Advanced Door Access System the Door Access Readers must be
set with the correct time in order for reporting capabilities and time
restriction to function correctly.

11.1.10.1. Creating a Time Card
1. Click the Create Reader Time Card button in the Door Access

Manager (Figure 11.44).

Figure 11.44 Creating a Time Card

2. If this card is to be issued with only a limited number of uses,
check the “Check Uses Remaining” option and enter the number
of times this card can be used (Figure 11.45).

3. Enable the “Create Card with Current Date/Time” option to create
the Time Card with your PC’s Date and Time, or disable this
option and enter desired date and time manually (Figure 11.45).

4. Insert a Smart Card into the PC Reader (Section 2.4.2)

�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������Note:�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������Disabling this option allows the creation of time cards to be used at a�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������later time.
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5. Click the Create Time Card button (Figure 11.45).

Figure 11.45 Creating the Time Card
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Time Card
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Usage
Limit
Option
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1 1 . 1 . 1 1 .  R e a d e r  Res t r i c t i o n  C a r d s

The Door Access Manager has the ability to restrict access to specific
Door Access Readers according to the day of week and time of day.

Time restrictions are organized into Profiles that can contain up to
twenty-three restrictions. Each restriction determines the time of day and
which days the access will be restricted to a particular Door Access
Reader. For example a particular profile can restrict access to an entry
point between 5PM and 10PM Monday through Friday and restrict access
for the entire day on Saturday and Sunday.

To set up time restrictions in a Door Access Reader:

1. Add a Time Restriction Profile.

2. Create up to twenty-three restrictions for that profile.

3. Create a Reader Restriction Card for programming the Door
Access reader.

4. A “Clear Card” can be created to remove time restrictions from
the Door Access Reader

�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������Note:�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������Time restrictions do not apply to users set up with either the “No Time�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������Restriction” or the “Master Card” options enabled (section 11.1.7).�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������Additionally, time restrictions cannot be used in the Standard Door�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������Access System.
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11.1.11.1. Opening the Door Access Restriction Time Window
To Open the Door Access Restriction Time Window, click the Create
Reader Restriction Card button in the Door Access Manager (Figure
11.46).

Figure 11.46 Opening the Door Access Restriction Time Window
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Manager

Click
here
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11.1.11.2. The Door Access Restriction Time Window Interface
The Door Access Restriction Time window consists of four basic
components (Figure 11.47):

1. The Profile List Window lists all the profiles entered into the
software.

2. The Restriction List Window lists all the restrictions of a
selected profile.

3. The Restriction Information section contains the day and time
specifications of the selected restriction.

4. Command and Function Buttons for the most commonly used
features have been included for ease of use.

Figure 11.47 The Door Access Restriction Time Window
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Table 11.4 describes each field in the Door Access Restriction Time
window and identifies its restrictions.

Table 11.4 Reader Setup Window Fields

Field Name Description Restrictions

Profile
Name

Required unique field assigning an
identity to the profile.

Any alphanumeric
combination up to
30 characters in
length

Days Selects which day or days of the week the
restriction will apply to.

Check Boxes for
each day of the
week

All Days This time saving feature selects all the
days of the when clicking this button.

Button

Start Time
/Stop Tim

Select this option when defining a limited
time period for the restriction to be active.
The starting and ending times entered will
apply to the day(s) selected. Note: Time
restrictions cannot cross the 23:59 to
00:00 time change (see note in Section
11.1.11.6)

Check Box to
select Option. Time
fields formatted to
“Military Time.”
HH:MM

All Day If selecting this option access restrictions
will apply to the entire day or days
selected.

Check Box
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11.1.11.3. Adding a Reader Restriction Profile
1. In the Door Access Restriction Time window select Add Profile

from the Edit drop-down menu (Figure 11.48).

2. Enter an identification in the Profile Name field (Figure 11.48).

3. Click the Update button to save the new profile (Figure 11.48).

Figure 11.48 Adding a Door Access Restriction Time Profile

1. Click here

2. Enter name

3. Click here
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11.1.11.4. Editing a Reader Restriction Profile Name
1. In the Door Access Restriction Time window select a profile to

edit from the Profile List Window.

2. Select Edit Profile from the Edit drop-down menu (Figure 11.49).

3. Edit the Profile Name field (Figure 11.49).

4. Click the Update button to save changes to the profile (Figure
11.49).

 

Figure 11.49 Editing a Door Access Restriction Time Profile

2. Click here

3. Edit name

4. Click here
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11.1.11.5. Deleting a Door Access Restriction Time Profile

1. In the Door Access Restriction Time window select a profile
to delete from the Profile List Window (Figure 11.50).

2. Select Delete Profile from the Edit drop-down menu (Figure
11.50).

 

Figure 11.50 Deleting a Door Access Restriction Time Profile

Warning!
A deleted Door Access Restriction Profile and all Restrictions assigned to
it cannot be recovered.
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11.1.11.6. Adding a Restriction

1. In the Door Access Restriction Time window select a profile
to add the restriction to (Figure 11.51).

2. Click the Add Restriction button (Figure 11.51).

Figure 11.51 Adding a Restriction

3. Enter the restriction days and time as defined in Table 11.3
(Figure 11.52).

�������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�������������������������������������������������������������������������������������������������������������������������������������������������������������������������Note:�������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�������������������������������������������������������������������������������������������������������������������������������������������������������������������������A single time restriction cannot cross the 23:59 to 00:00 time change.�������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�������������������������������������������������������������������������������������������������������������������������������������������������������������������������For example to create a time restriction from 5PM to 9AM two separate�������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�������������������������������������������������������������������������������������������������������������������������������������������������������������������������restrictions need to be created, one from 17:00 to 23:59 and one from�������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�������������������������������������������������������������������������������������������������������������������������������������������������������������������������00:00 to 9:00.
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4. Click the Update button to save the new restriction (Figure
11.52).

Figure 11.52 Selecting Restriction Parameters

Then click
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Enter day
and time
information
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11.1.11.7. Editing a Restriction
1. In the Door Access Restriction Time window select a profile

and the restriction to edit (Figure 11.53).

2. Click the Edit Restriction button (Figure 11.53).

Figure 11.53 Editing a Restriction

3. Edit the restriction days and time as defined in Table 11.4
(Figure 11.54).

4. Click the Update button to save the new changes (Figure
11.54).

Figure 11.54 Editing a Restriction
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11.1.11.8. Deleting a Restriction

1. In the Door Access Restriction Time window select a profile
and the restriction to delete (Figure 11.55).

2. Click the Delete Restriction button (Figure 11.55).

Figure 11.55 Deleting a Restriction

Warning!
A deleted Door Access Restriction cannot be recovered.
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11.1.11.9. Creating a Reader Restriction Time Card
Once the profiles and restrictions have been entered, Reader Restriction
Time Cards are created to program the Door Access Readers with the
profile information.

To Create a Reader Restriction Card:

1. Insert a Management Card into the PC Card Reader (Sections
2.4.1 and 2.4.2).

2. In the Door Access Restriction Time Window select a profile
to use (Figure 11.56).

3. Click the Create Card Button (Figure 11.56).

Figure 11.56 Creating a Reader Restriction Time Card
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11.1.11.10. Creating a Reader Restriction Time “Clear Card”
Once a Door Access Reader has been programmed with time restrictions,
a Clear Card can be used to remove those restrictions from the reader.

To Create a Reader Restriction Time Clear Card:

1. Insert a Management Card into the PC Card Reader (Sections
2.4.1 and 2.4.2).

2. In the Door Access Restriction Time Window click the Create
Clear Card button (Figure 11.57).

Figure 11.57 Creating a Reader Restriction Time Clear Card

Click here
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11.2. Collecting Data

When a User Card is used to gain access through a Door Access Reader
in the Advanced System, an entry record is kept in the machine’s
memory. To retrieve transaction records and view them, follow these
three steps.

1. Create a Reader Data Collection Card.

2. Collect data from the Door Access Reader.

3. Read the Data Card (transfer the record into the software).

These steps are discussed in further detail in Section 11.2.1. Once these
steps are completed, reports of user transactions can be viewed or printed
(Section 11.3).
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1 1 . 2 . 1 .  C r ea t i n g  a  Da t a  Co l l e c t i o n  Ca r d

1. Insert an 8K Management Smart Card into the PC Reader
(Section 2.4.2).

2. Click the Create Reader Data Collection button in the Door
Access Manager (Figure 11.58).

Figure 11.58 Creating a Reader Data Collection Card

3. In the Door Access Data Collection window click the
Create/Clear Card button. (Figure 11.59).

Figure 11.59 Creating the Data Collection Card

Warning!
This process will delete any previous collections on the card. If this card
has been used for data collections in the past, be sure to read the data
card into the appropriate manager first.

Click here to
create a User
Data Card
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1 1 . 2 . 2 .  C o l l ec t i n g  Da t a

To collect data, insert a Service Card into the Door Access Reader and
then insert the Door Access Data Collection Card within one minute.

�������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�������������������������������������������������������������������������������������������������������������������������������������������������������������������������
Note:�������������������������������������������������������������������������������������������������������������������������������������������������������������������������

�������������������������������������������������������������������������������������������������������������������������������������������������������������������������The memory capacity of a Door Access Data Collection card allows for�������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�������������������������������������������������������������������������������������������������������������������������������������������������������������������������only one Door Access Reader collection per card.
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  11 . 2 . 3 .  Re ad i ng  t he  Us e r  Da ta  Co l l ec t i o n  Ca rd

Reading the Data Card transfers the records into the PC so that the data
can be viewed or used for report generation.

1. Insert the Door Access Data Collection card into the PC Reader
(Section 2.4.2)

2. Click the Create Reader Data Collection button in the Door
Access Manager (Figure 11.58).

3. In the Door Access Data Collection window click the Read Card
button (Figure 11.60).

4. Click the Exit button when completed (Figure 11.60).

Figure 11.60 Reading the Door Access Data Collection Card
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11.3. Door Access Reports

Door Access reports allow you to view or print a detailed report showing
an individuals’ usage of the Door Access Readers.

1 1 . 3 . 1 .  V ie w i n g  a n d  P r i n t i n g  Us e r  Re po r t s

Once data has been collected and transferred into the PC, follow these
steps to view or print a report:

1. Click the Data Collection button in the Door Access Manager
(Figure 11.61).

Figure 11.61 Door Access User Reports

Click here to
access reports
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2. A window specifying a date range will appear (Figure 11.62).
Enter the beginning and ending collection dates for the desired
report. Select the “No upper Bound” option to view a report
containing all transactions since the “Start of range” field value or
select the “No lower Bound” option to view a report containing all
transactions leading up to the “End of range” value.

Figure 11.62 Date Range Window

3. Click OK when finished.

4. The report will be generated and appear on your screen. At this
time either view it on the screen, or click the printer icon to print
the report (Figure 11.63).

Figure 11.63 Door Access Report Window

Click here to
print report
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1 1 . 3 .2 .  Un de rs tand i ng  Us e r  Rep o r t s

The report generated reflects all collected records for the date ranges that
were specified.

Table 11.5 identifies and explains each field in the User Transaction Data
Collection Report.

Table 11.5 Door Access Report

Field Name Explanation

Account User’s account number.

Location Location of Reader.

Serial No User’s card serial number.

Area Area of reader.

Access Date Date and time of access.

Collection Date/Time The date and time of collection.
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1 1 . 3 . 3 .  D e le t i n g  C o l l ec t ed  Da t a

After collected data is no longer needed it can be deleted to save disk
space.

1. In the Door Access Manager click the Create Data Collection
button (Figure 11.64).

2. Select the criteria to search records by and enter the range into
the appropriate field, or select View All.

3. Click the Search button.

Figure 11.64 Searching Collected Data

4. Select collected data to delete (Figure 11.65).

Warning!
A deleted data collection record cannot be recovered.

Search Criteria

Range

Then click here
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5. Select Delete Selected Records from the File menu (Figure
11.65).

Figure 11.65 Deleting a Collected Record
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A. Importing a User List

There is a menu option in the User Manager dialog (under the File
menu), to import the user list, which only an Administrator can do. The
file will come on a floppy disk with a shipment of user cards if the system
user has purchased that option (called card Serialization). The file will be
tab delimited, and should contain two columns, which are the cross-
reference of each card’s externally printed number to the internal serial
number of the card.

The first line MUST contain the Card’s chip ID (numeric value, 0 =
Solaic/Pocketbook, 1 = Bull Scot5), and optionally a file version number.
Each subsequent line must contain 4 fields, separated by tabs.

Column 1 = External number, in decimal notation.

Column 2 = 4 byte card serial number, in decimal notation.

Column 3 = Location ID (supplied by the user)

Column 4 = Account ID (supplied by the user)

The recommended way to supply the 2 user fields is to:

1. Open the file in Excel, opening it as a tab delimited text file.

2. Enter the location ID to put on the cards in the third column of the
first user record.

3. Paste that location ID down the list for all cards.

4. Supply an account ID for each record. The simplest technique is
to use sequential Account IDs.  Enter the starting account ID in
the fourth column of the first record, and then use the
Edit/Fill/Series option of Excel, and highlight fill down the
column with a linear Series. Account ID’s MUST be unique.

5. Save the modified database as a tab delimited text file using the
file name “Serial Numbers.txt” into the SMS directory.

6. In the User Manager of SMS2 select Import User List from the
File drop-down menu.

14Appendixes
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When imported, SMS2 creates a user record for each card, assigning all
the above values and leaving all other information at its default (no name,
address, etc). (The External number is the Tracking ID in SMS2). When
users cards are handed out, the user information should be recorded (user
name, address, the card’s external number) so that the information can be
entered into SMS2 to correctly reflect whom the card has been given to.

This feature is a quick way to allow the SMS2 user to create many user
records in SMS2, and associate each user with a card. However, the
SMS2 user is responsible for making sure that the cards corresponding to
the imported data have the correct Location ID on them, and that they are
created as User cards (this is generally accomplished with a CTS). Also,
it should be noted that the CTS will create the cards as generic user cards,
and that no advanced user features will be available (such as Initial Card
Charge, or card Expiration date). The SMS2 user needs to create, or
recreate, these types of user cards through SMS2 to enable these features.



CHAPTER 14: Appendixes SMART CARD MANAGEMENT SYSTEM 2

345 Rev. B

B. Using a Logo in Printed Reports

A graphic, such as a company logo, can be included in SMS2 reports.

The graphic must be either a Bitmap (.bmp) or Jpeg (.jpg) digital file
type. The logo cannot exceed a length of 225 pixels or a height of 50
pixels.

To include a logo in SMS2 Reports:

1. From the File drop-down menu click Select Logo (Figure 14.1).

Figure 14.1 Selecting a Logo for Reports

2. Select either .bmp or .jpg file type from the Files of type drop-
down menu (Figure 14.2).

3. Select file to insert as logo (Figure 14.2).

4. Click the open button (Figure 14.2).

Figure 14.2 Opening the Logo
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5. A confirmation window will appear stating the maximum allowed
size of the logo. Click the Yes button to continue or No to cancel.

6. If logo was successfully selected, it will now be displayed in all
SMS2 reports (Figure 14.3).

Figure 14.3 Report with Logo
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C. Exporting SMS2 Databases

SMS2 reports can be exported and customized. Exported report data can
be viewed or manipulated in a database or spreadsheet software package.
SMS2 can export data in either a tab delimited or MS Access format.

Table 14.1 describes the databases that can be exported.

Table 14.1 Exportable SMS2 Databases

Name Description

Axcoll.mdb Door Access data collection information.

Crdsmade.mdb
Log of when User Cards and Cash Cards were created
and by whom.

Datacol.mdb
Card Transaction Station and Laundry Machine Reader
Counters.

Manager.mdb
SMS2 database including all Users, Machines, Profiles
and Locations.

Transcol.mdb Collected User Transactions.

All Exports all databases.

To export a report:

1. Select Export from the file menu (Figure 14.4).

2. Select an export format – either Tab Delimited or MS Access
(Figure 14.4).

3. Select a database (Figure 14.4).

4. The exported database has been copied to the “Export_Files”
folder located in the “SMS” directory.

Table 14.4 Exporting  Databases

Click here Select
format

Select file
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1 3 . 1 . 1 .  O ve r v i e w

The Utility Cards Manager creates and tracks service cards, time cards
and manual time cards.

13.1.1.1. Service Cards
Service Cards are used to initiate a service routine in all the machines of
the Greenwald Intellicard Smart Card System. Once the machine is
initiated into this mode, the functions and features of the service mode
differ between the machine types. Please refer to the machine-specific
instructions for more information on the service mode.

13.1.1.2. Time Cards
Since usage reports and time dependent functions are available for
different machines, it is necessary to have the correct time set in these
machines. The time card is set with a specified time, and sets the machine
to that time when inserted.

13.1.1.3. Manual Set Time Card
The Manual Set Time card will also set the time for those machines that
use time features. This card works by initiating a time setting mode in the
machine. Please refer to the machine-specific instructions for more
information about using the Manual Set Time Card.

13UTILITY CARDS MANAGER
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1 3 . 1 . 2 .  S e r v i c e  C a r ds

13.1.2.1. Creating a Service Card
1. Click the Create Service Card button in the Utility Cards Manager

(Figure 13.1).

Figure 13.1 Creating a Service Card

2. Select a user from the User List Window (Figure 13.2), and proceed
to Step 3. If the user is not in the system, proceed to Step 2a.

a) Click the Add New User button.

b) Enter an alphanumeric Account number. THIS IS A
REQUIRED FIELD.

c) Enter all other User Information.

d) Click the Update button.

Click
here
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Figure 13.2 Selecting/Adding User

3. If this card is to be issued with only a limited number of uses, select
the “Check Uses Remaining” option and enter the number of times
this card can be used (Figure 13.3).

4. Insert a Smart Card into the PC Reader (Section 2.4.2).

5. Click the Create Service Card button (Figure 13.3).

Figure 13.3 Creating a Service Card
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13.1.2.2. Reading a Service Card
1. Click the Create Service Card button in the Utility Cards Manager

(Figure 13.1).

2. Insert the Service Card into the PC Reader (Section 2.4.2)

3. Click the Read Card button (Figure 13.4)

4. The User and Service Card information will be displayed.

Figure 13.4 Reading a Service Card

Click here
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13.1.2.3. Resetting a Serial Number
If a User has lost or damaged their card and a new card needs to be
created, the serial number for that user’s card needs to be reset.

1. Click the Create Service Card button in the Utility Cards Manager
(Figure 13.1).

2. Select the user whose card is to be reset (Figure 13.5).

3. Click the Edit button.

4. Select Reset Card Serial Number from the Edit menu (Figure
13.5).

5. Click the Update button.

 

Figure 13.5 Resetting the Card Serial Number
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1 3 . 1 .3 .  C r ea t i n g  a  T i m e  Ca rd

1. Click the Create Time Card button in the Utility Cards Manager
(Figure 13.6).

Figure 13.6 To Create a Time Card

2. If this card is to be issued with only a limited number of uses, select
the “Check Uses Remaining” option and enter the number of times
this card can be used (Figure 13.7).

3. Enable the “Create Card with Current Date/Time” option to create the
Time Card with your PC’s Date and Time, or disable this option and
enter the desired date and time (Figure 13.7).

4. Insert a Smart Card into the PC Reader (Section 2.4.2).

5. Click the Create Time Card button (Figure 13.7).
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Figure 13.7 Creating a Time Card
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1 3 . 1 .4 .  C r ea t i n g  a  Ma nu a l  Se t  T i m e  Ca r d

1. Click the Create Manual Set Time Card button in the Utility Cards
Manager (Figure 13.8).

Figure 13.8 Creating a Manual Set Time Card

2. If this card is to be issued with only a limited number of uses, select
the “Check Uses Remaining” option and enter the number of times
this card can be used (Figure 13.9).

3. Insert a Smart Card into the PC Reader (Section 2.4.2).

4. Click the Create Manual Time Card button (Figure 13.9).

Figure 13.9 Creating the Manual Set Time Card
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1 3 . 1 . 5 .  S e r v i c e  C a r d  R ep o r t

The Utility Card Manager has the ability to generate a report providing
the following information for each Service Card that was created:

! Account –account number of the user assigned to the Service
Card.

! First Name –first name of the user.

! Last Name –last name of the user.

! Serial Number –internal serial number of the Service Card for
the user.

! Creation Date/Time –date and time that the Service Card was
created.
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13.1.5.1. Viewing and Printing a Service Card Report
1. To open the report do one of the following (Figure 13.10):

! Click on the Service Card List button in the Utility Cards
Manager.

! Select the Service Card List report from the Utility submenu
of the Reports menu in the main window.

Figure 13.10 Opening the Service Card Report

2. The report will be generated and appear on your screen. At this
time either view it on the screen, or click the printer icon to print
the report (Figure 13.12).

Figure 13.12 Utility Card Report Window

Two methods
to initiate a
report

Click here to
print report
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1 2 . 1 . 1 .  O ve r v i e w

The Cash Card manager has been implemented for creating cash cards for
users when a transaction machine is not being used. Additionally, this
manager can be used to add or subtract value from existing cards.

12.1.1.1. How Does it Work
The Cash Card Manager has a balance, which is set by a system user who
is granted the privilege to do so (see Login Controls Manager). Using the
balance, system users can create new Cash Cards, and add or deduct
value from existing cards. Maximum value permitted on a Cash Card can
also be set.

A record of each transaction is kept and can be viewed or printed.
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The PC Balance can be used to account for all the money that is
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collected when issuing Cash Cards to users, or it can be used as virtual
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12Cash Card Manager
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1 2 . 1 . 2 .  U s i ng  t he  Cas h  Ca rd  M an ag e r

12.1.2.1. Setting/Changing the PC Balance
1. Click the Create New Cash Card button in the Cash Cards tab

(Figure 12.1).

Figure 12.1 Opening the Cash Cards Manager Window

2. Enter a value in the Balance field (Figure 12.2).

3. Click the update button to save value (Figure 12.2).

Figure 12.2 Changing the PC Balance
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12.1.2.2. Setting/Changing the Maximum Card Value
1. Click the Create New Cash Card button in the Cash Cards tab

(Figure 12.1).

2. Enter a value in the Max Value field (Figure 12.3).

3. Click the update button to save value (Figure 12.3).

Figure 12.3 Changing the PC Balance
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12.2.1.3. Creating a Cash Card
1. Click the Create New Cash Card button in the Cash Cards tab

(Figure 12.1).

2. Select a Location ID from the Location pull-down menu (Figure
12.4).

3. Enter value if desired (Figure 12.4).

4. Insert a user Smart Card into the PC Reader (Section 2.4.2).

5. Click the Create Card button (Figure 12.4).

Figure 12.4 Creating a Cash Card

Warning!
If cards are created with the User Manager, they MUST NOT be
recreated here. Doing so will delete any user data previously written to
the card.  Only use this manager to modify the card value.
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12.1.2.4. Reading an Existing Cash Card
1. Click the Create New Cash Card button in the Cash Cards tab

(Figure 12.1).

2. Insert the Cash Card into the PC Reader (Section 2.4.2).

3. Click the Read Card button (Figure 12.5).

4. The card’s location and value will be displayed.

Figure 12.5 Reading a Cash Card

Click here to
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12.2.1.5. Setting Value to a Cash Card
Once a card is created, a value can be assigned to it.

1. Click the Create New Cash Card button in the Cash Cards tab
(Figure 12.1).

2. Insert an existing cash card into the PC Reader (Section 2.4.2).

3. Enter a value to set to the card (Figure 12.6).

4. Click the Set button (Figure 12.6). PC Balance will be updated
accordingly.

Figure 12.6 Setting Value to a Cash Card
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12.2.1.6. Adding Value to a Cash Card
1. Click the Create New Cash Card button in the Cash Cards tab

(Figure 12.1).

2. Insert an existing cash card into the PC Reader (Section 2.4.2).

3. Enter a value to add to the card (Figure 12.7).

4. Click the Add button (Figure 12.7).

Figure 12.7 Adding Value to a Cash Card
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�������������������������������������������������������������������������������������������������������������������������������������������������������������������������the PC Balance.

Click here to
add value to
card

Enter
value to
add to
card
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12.2.1.7. Subtracting Value from a Cash Card
1. Click the Create New Cash Card button in the Cash Cards tab

(Figure 12.1).

2. Insert an existing cash card into the PC Reader (Section 2.4.2).

3. Enter a value to subtract from the card (Figure 12.8).

4. Click the Subtract button (Figure 12.8).

Figure 12.8 Subtracting Value from a Cash Card

�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������Note:�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������The value entered will be Subtracted from the Cash Card and added to�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������the PC Balance.

Click here to
subtract value
from the card

Enter
value to
subtract
from the
card
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1 2 . 1 . 3 .  R e po r t s

A report showing each transaction conducted in the Cash Card Manager
can be generated.

The report shows the following information:

! Account – user account for Cash Card (if applicable).

! Login – system user logged into SMS2 when this occurred.

! Location –location for which the Cash Card was created.

! First Name – system user’s first name.

! Last Name –system user’s last name.

! Action –description of the transaction (for example, Create).

! Serial –serial number of the card that was created or adjusted.

! PC Balance –balance after the value for the transaction has been
deducted or added to the PC balance.

! Amount –total value of the transaction.

! Creation Date –date and time the transaction took place.
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12.1.3.1. Viewing and Printing a Cash Card Report
1. To open a report, do one of the following (Figure 12.9):

! Click on the Cash Card List button in the Cash Cards
Manager.

! Select the Cash Cards List report from the Cash submenu of
the Reports menu in the main window.

 

Figure 12.9 Opening the Cash Cards Report

2. A window specifying a date range will appear (Figure 12.10).
Enter the beginning and ending collection dates for the desired
report. Select the “No upper Bound” option to view a report
containing all transactions since the “Start range” field value or
select the “No lower Bound” option to view a report containing all
transactions leading up to the “End of range” value.

Figure 12.10 Date Range Window

Two methods
to initiate a
report
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3. The report will be generated and appear on your screen. At this
time either view it on the screen, or click the printer icon to print
the report (Figure 12.11).

 

Figure 12.11 Cash Card Report Window

Click here to
print report
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